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■ はじめに
本製品をお使いになる前に、[MENU] →Version にて、ファームウェアのバージョンをご確認
ください。V1.00の場合は、V1.10へのアップデートをおすすめします。
ただし、本書はV1.00 を説明対象としていますので、V1.10への変更点については、以下をご
確認ください。

■ EAD50  V1.00からV1.10への主な変更点
• マイクのドライ音を出力するプリセットシーンP071 Dryを追加しました。
• プリセットシーンの設定値を一部変更しました。
• ユーザーシーンの初期値をプリセットシーンP071 Dryと同じ値に変更しました。ただし、

アップデート後に、ファクトリーリセット([MENU] →Factory Reset) またはクリア([SCENE]
→[F2] Job →Clear) を実行する必要があります。

• マイクへの入力ゲインにつき、設定範囲を拡張しました。 
[MIC/TRIG] →[F3] Setting →Mic →Mic In →Gain

• マイクゲイン自動調整の動作を改善しました。 
[MIC/TRIG] →[F3] Setting →Mic →Mic In →Gain Auto Setup

• ノイズゲートの動作を改善し、スレッショルドとリリースが設定できるようになりました。 
[MIC/TRIG] →[F3] Setting →Mic →Mic In →Noise Gate

• ボイスのレイヤーを活用した様々な設定が簡単にできるようになりました。 
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice →Layer Mix

• 以下の画面でユーザーボイス選択中に試聴ができるようになりました。 
[MIC/TRIG] →[F3] Setting →Kit →User Voice →Sort Wave

• ルーパーとサンプリングの動作と画面表示を改善しました。
• オーディオ入力の音量と他チャンネルの音量とのバランスを改善しました。
• マイクレベルメーターとチャンネルインジケーターの動作を改善しました。
• そのほか各機能おける動作の改善や不具合の修正を行いました。
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本製品は、付属のセンサーユニット経由でアコースティックドラムやパーカッション演奏を集音し、エフェクトや音質処理
を施した上でスピーカーやヘッドフォンに出力する製品です。センサーユニットはマイク音に加えてトリガー信号も検出
し、電子ドラム音(ボイス)を自在に鳴らすことができます。これにより、アコースティックの自然な響きと電子ドラムの力
強いサウンドを融合させた、幅広い演奏表現を創り出すことができます。

取扱説明書について
本製品には、以下の取扱説明書が用意されています。

●クイックガイド(製品同梱/紙シート)
本製品をすぐに使えることを主目的に、情報を絞って説明したガイドです。冒頭にある「安全上のご注意」「使用上のご注意」「お知ら
せ」については、本製品ご使用前に必ずお読みください。

●ユーザーガイド(本ファイル/ウェブ公開のみ)
クイックガイドに記載していない、その他の本製品に関するすべての情報を説明しています。

●データリスト(ウェブ公開のみ)
本製品に搭載されているコンテンツのリストや、MIDIに関する仕様を掲載した資料です。

上記3点は、クイックガイド含め、ヤマハ ダウンロードのウェブサイトからご覧いただけます。以下のウェブサイトを開き、「モデル名か
ら検索」テキストボックスにモデル名「EAD」などと入力して検索してください。

ヤマハ ダウンロード	 https://download.yamaha.com/jp/

付属品
クイックガイド(製品同梱/紙シート)をご参照ください。

設定項目(パラメーター) の探しかた (60ページ以降)
本書をコンピューターなどの画面上で閲覧している場合、読みたい項目をクリックすることで該当箇所にジャン
プするリンク機能や、用語の検索機能を活用できます。また、各ページ右側にあるタブをクリックすると、各章
の最初のページにジャンプできるので、ご活用ください。

はじめに
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トップパネル
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各部の名称と機能

1	スタンバイ/オンボタン
2	画面(ディスプレイ)
3	画面操作ボタン群
4	モード選択ボタン群
5	ノブおよび[+][−]ボタン(値設定の操作子)
6	Modifierノブ
7	[MUTE ALL]ボタン
8	LEDロータリーフェーダーおよび関連操作子
9	ボリュームスライダー
j	[PHONES]端子
k	[AUX IN]端子
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各部の名称と機能
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4	モード選択ボタン群
本製品の様々な機能を網羅したボタン群で、使いたい機能
を押した上で各モードに入ります。現在選択されているモー
ドのボタンは点灯します。
•	 SCENE	 ⇒73ページ
•	MIC/TRIG	 ⇒85ページ
•	CLICK	 ⇒128ページ
•	 RECORDER	 ⇒135ページ
•	 LIVE SET	 ⇒156ページ
•	MENU	 ⇒158ページ

5	ノブおよび[+][−]ボタン(値設定の操作子)
両者は同じ機能で、主に画面上の様々な項目において、値を
設定するために使います。

6	Modifierノブ............................ 60ページ
これらのノブを操作することで、演奏しながら様々な音色変
化や機能切替などができます。本製品における各種設定は
画面の階層深くに配置されているケースが多いですが、そ
の中からよく使うものについてはこれらのノブに割り当てて
おくことができます。

1	スタンバイ/オンボタン
本製品をオン/オフします。

2	画面(ディスプレイ).................... 45ページ
ディスプレイは、本製品の現在の状態や各パラメーターの
設定状況などを表示するものです。[MENU] →Utility 
→LCD Contrast (158ページ)において、画面表示のコン
トラストを調整できます。

3	画面操作ボタン群
1列めは画面表示に連動して機能が切り替わるボタン群で
す。パネルにボタン名称が印字されていませんが、説明の
都合上、F1, F2, F3, Alt…を呼称としています。詳細は
45ページをご参照ください。
2列めについては、以下の通りです。
•	 [STORE]ボタン

シーン(73ページ)やライブセット(156ページ)を保
存するためのボタンです。詳細は78ページをご参
照ください。

•	 [EXIT]ボタン
現在の画面から抜けたり、1つ上の階層に切り替えるボ
タンです。シーンのトップ画面(シーン選択画面)では、
発音中のトリガー音すべてを消音(オールサウンドオフ)
する機能もあります。

•	 [ENTER]ボタン
現在の画面から1つ下の階層に切り替えたり、機能を実
行したりするボタンです。
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各部の名称と機能
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7	[MUTE ALL]ボタン
本製品で鳴っている全チャンネルを消音します。点灯して
いるときに消音しています。

8	LEDロータリーフェーダーおよび関連操作子﻿
.................................................. 70ページ
8-1	 LEDロータリーフェーダー
このフェーダーを回すことで、該当チャンネル音に様々な効
果をかけます。

8-2	 チャンネルインジケーター
各チャンネルのペアリング状態を示すインジケーターです。
[MIC]ボタンが点灯の場合、ピークインジケーターとしても
動作します。ドラム演奏時は、ドラムセット全体を叩いて時々
ピークインジケーターが点滅する状態が最適です。

8-3	 チャンネルオン/オフボタン
各チャンネルを鳴らす(点灯)/鳴らさない(消灯)を切り替え
るボタンです。

8-4	 フェーダーモード選択ボタン
LEDロータリーフェーダーがコントロールするチャンネルを
選択するボタンです。
•	 [MIC]が点灯の場合：マイク入力音(Mic1 ～ Mic5)を

コントロールします。
•	 [TRIG]が点灯の場合：トリガー音(Kick, Snare, Trig3

～ 10)をコントロールします。
•	 [CUSTOM]が点灯の場合：その他のチャンネルをコン

トロールします。

8-5	 フェーダー機能選択ノブ
このノブを回すことでフェーダーの機能を選択します。選
択された機能については、右横LED(MIXER ～ OTHERS)
の点灯により確認します。

チャンネル
本製品で鳴る音を構成するもので、[MIC/LINE INPUT]
端子からの各入力音(画面表示ではMic1 ～ Mic5)、
[TRIGGER INPUT]端子からの各トリガー音(画面表示で
はＫick, Snare, Trig1 ～ 22)を指します。

9	ボリュームスライダー
5つのスライダー操作により、本製品で鳴っているオーディオ
の音量を以下の通り個別に調節します。

スライダー 音量の調整対象
[AUDIO] •	 [AUX IN]端子への入力音

•	 [USB TO HOST]端子への入力音
•	 Bluetooth経由で入力される音
•	 レコーダー機能の再生音

[CLICK] クリックの再生音
[MIC/TRIG] •	 マイク音：[MIC/LINE INPUT]端子

からの入力音
•	 トリガー音：[TRIGER INPUT]端子

からの入力信号にもとづく電子音
(ボイス)

•	 外部メモリーのオーディオファイル
試聴音
[MIC/TRIG] →[F3] Setting →Kit 
→Inst →Inst →Import Wave 
→[F3]

[MIC/TRIG] →[F3] Setting →Kit 
→User Voice →Import Wave 
→File to Bank →[F1]

[CLICK] →[F3] Setting →Click 
→Import Wave →[F3]

[RECORDER] →(Sampling).
 →[F4] Load →[F1]

[MENU] →File →File Wave 
→Rename, Delete →[F3]

•	 ユーザーボイス試聴音
[RECORDER] →(Sampling) .
→[F7] LoadWM →[F1]

[OUTPUT] •	 [OUTPUT]端子からの出力音(画面
上では「Main Out」の表記に該当)

•	 USB Audio Out 1/2
•	 レコーダー /ルーパー /サンプリン

グの録音ボリューム
[PHONES] ヘッドホンの音量
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各部の名称と機能

j	[PHONES]端子
ヘッドホンを接続して、本製品上の演奏音や本製品に入力さ
れたオーディオを出力します。本製品では、ステレオミニプ
ラグ対応およびステレオ標準プラグ対応の両方の端子を装
備しています。

NOTE

2つの端子を同時に使うと、ヘッドホンへの出力が小さくなるこ
とがあります。

k	[AUX IN]端子
ステレオミニプラグに対応した端子です。電子鍵盤楽器や
携帯用音楽プレーヤーなどを接続して、本製品にオーディオ
を入力します。

jk

3	[TRIGGER INPUT]端子............ 18ページ
ステレオ標準フォーンプラグに対応した端子で、電子ドラム
のパッドやアコースティックドラムに取り付けたトリガーセン
サーからのケーブルを接続します。[q KICK/y]について
は、付属のセンサーユニットDSU50からのケーブルの接続
を想定しています。

4	[FOOT SW]端子...................... 35ページ
別売のペダルやフットスイッチ/フットコントローラーを接続
します。

5	[MIDI OUT]端子...................... 38ページ
MIDIケーブルを接続します。本製品におけるMIDI通信は、
[USB TO HOST]端子を経由して行われますが、MIDI出
力だけは MIDIケーブルで行うことができます。USB端子
がないドラム音源を鳴らしたい場合にご活用ください。

MIDIは、一般社団法人音楽電子事業協会(AMEI)の登録商
標です。

リアパネル

1 2

5 4 3

1	DC IN端子
付属のACアダプターを接続します。

2	[MIC/LINE INPUT]端子........... 34ページ
XLRタイプおよびTRS フォーンタイプの両プラグに対応した
端子で、いずれもバランス接続となります。XLRプラグには
アコースティックドラム演奏などを集音するマイク(ゲインの
増幅が必要な機器)を、TRSフォーンプラグには電子楽器な
ど(出力レベルが大きな機器)をオーディオ接続します。1と2
については、付属のセンサーユニットDSU50からのケーブル
の接続を想定しています。

ファンタム電源
本製品では、XLRタイプのコンデンサーマイクなど必要
な機器に対して、この端子から電源を供給できます。こ
れを「ファンタム電源」といいます。詳細は87ページ
をご参照ください。



EAD50　ユーザーガイド 9

各部の名称と機能

6	[OUTPUT]端子
本製品で鳴る全ての音を出力する端子です。画面上の設
定項目では「Main Out」と表記されるチャンネルに該当しま
す。XLRタイプの端子(バランス)、およびTSフォーンタイプ
の端子(アンバランス)をそれぞれ装備しています。両者は
同じ音信号が出力されます。接続される機器に応じて適切
な端子を選択してください。

NOTE

•	 モノラル出力したい場合は、[L/MONO]端子だけに接続し
ます。

•	 止むを得ず、バランス出力をアンバランス機器に接続する場
合は、両機器間のグラウンド電位を合わせてください。合っ
ていないと、故障の原因になります。アンバランス(不平衡)
機器に接続するケーブルの配線は、ピン1：グラウンドとピン3：
コールドを接続してご使用ください。

7	[INDIVIDUAL OUTPUT]端子﻿
.................................................. 37ページ
それぞれのチャンネルごとに個別にオーディオを取り出す
ための出力端子です。オーディオをチャンネルごとに取り
出すことにより、特定の人に必要な音だけを送ったり、個別
にエフェクト処理をかけたり、などの活用ができます。

8	USB端子................................... 10ページ
本製品は、2種類のUSB端子(Type-AとType-C)を装備し
ています。
Type-Cの[USB TO HOST] 端子には、コンピューターなど
ホスト機器を接続し、MIDIやオーディオ通信を行います。
Type-Aの[USB TO DEVICE]端子には、USBフラッシュメ
モリーや他の電子楽器などを接続し、本製品がホスト機器と
なります。USBフラッシュメモリーには、本製品で制作した
様々なデータを保存します。電子楽器を接続した場合は、本
製品および接続機器のUSBトリガーリンク機能により、その
電子楽器からのMIDI入力が可能になります。

USB Type-C™ および USB-C™ は USB Implementers 
Forumの商標です。

リアパネル (つづき)

98

6 7

9	SDメモリーカードスロット.......... 11ページ
本製品で制作データの保存メディアとして、USBフラッシュ
メモリーだけでなくSDカードも使えます。

各端子の極性 2 6 7

端子 端子の極性 バランス/﻿
アンバランス

MIC/LINE INPUT

TRSフォーンプラグ *

T (チップ)：ホット(+)
R (リング)：コールド(−)
S (スリーブ)：グラウンド バランス型
XLRコネクター

ピン1：グラウンド
ピン2：ホット
ピン3：コールド

INDIVIDUAL 
OUTPUT 
-BALANCED-

TRSフォーンプラグ *

T (チップ)：ホット(+)
R (リング)：コールド(−)
S (スリーブ)：グラウンド バランス型

OUTPUT 
-BALANCED-

XLRコネクター

ピン1：グラウンド
ピン2：ホット
ピン3：コールド

OUTPUT 
-UNBALANCED-

TRSフォーンプラグ *
S T

T (チップ)：シグナル
S (スリーブ)：グラウンド

アンバランス型

*	 TRSフォーンプラグの代わりに、TSフォーンプラグで接続することもできます。
その場合はアンバランス接続になります。

S T

R

S T

R
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USB端子ご使用上の注意
本製品にはType-AおよびType-Cの2種類のUSB端子が搭載されています。

	■ USB TO HOST端子ご使用上の注意
コンピューターやスマートデバイスなどのホスト機器に接続す
るためのUSB端子(Type-C)です。 ホスト機器のアプリケーショ
ンとの間でMIDIまたはオーディオ通信することで、楽曲制作な
どに活用します。詳細は38ページ、40ページをご参照く
ださい。
•	USBケーブルは接続機器の端子形状に応じて準備してくだ
さい。ただし、接続の仕方によっては接続先がホスト機器と
して機能しない場合もありますのでご注意ください。

•	スマートデバイスやコンピューターに接続した場合、異常や
停止(ハングアップ)によるデータ損失を防ぐため、以下の点
をおすすめします。

	- 本製品のオン/オフやUSBケーブルの抜き差しをするときは、
本製品での演奏を止め、すべてのアプリケーションを終了さ
せてからにする。

	- 本製品の電源オン/オフやUSBケーブルの抜き差しは、6秒
以上間隔を空ける。

•	スマートデバイスやコンピューター、本製品が停止したとき
は、アプリケーションやスマートデバイス、コンピューターを
再起動するか、本製品の電源を入れ直してください。

	■ USB TO DEVICE端子ご使用上の注意
Type-AのUSB端子で、以下の機器が接続できます。
•	USB-MIDI機能搭載のMIDI機器
•	USBフラッシュメモリー (USBハブ、マウス、コンピューターの
キーボードなどは接続しても使えません。)

MIDI機器の接続
38ページをご参照ください。

USBフラッシュメモリーの接続

•	 [USB TO DEVICE]端子の形状に合うプラグを上下の向き
に注意して差し込んでください。

•	USBフラッシュメモリーの抜き差しは、再生や録音中、ファイ
ル操作中（セーブ/ロード/フォーマットなど）、およびUSBフ
ラッシュメモリーへのアクセス中には行わないでください。
本製品の機能が停止したり、USBフラッシュメモリーやデー
タが壊れたりするおそれがあります。

•	USBフラッシュメモリーの抜き差しは、数秒間隔を空けて
行ってください。

•	USBフラッシュメモリーの接続は、ハブや延長ケーブルを使
わず直接行ってください。

•	動作確認済みUSB機器については、下記ウェブサイトの「資
料/データ」から確認できます。ご購入の前に確認ください。

　　サポート・お問い合わせ：
	 https://jp.yamaha.com/support/ 

•	USBフラッシュメモリーへの保存やUSBフラッシュメモリー
からの読み込みにかかる時間は、データの種類や本機の状
態により異なりますのでご了承ください。

USBフラッシュメモリーのフォーマット 
USBフラッシュメモリーは本製品でフォーマットすることをおす
すめします。他の機器でフォーマットしたUSBフラッシュメモ
リーは、本機で正しく動作しない場合があります。フォーマット
については177ページをご参照ください。

ご注意
フォーマットを実行すると、そのUSBフラッシュメモリーの中身は
消去されます。必要なデータが入っていないことを確認してから
フォーマットしてください。

USBフラッシュメモリーの誤消去防止 
USBフラッシュメモリーには、誤ってデータを消してしまわない
ようライトプロテクト機能のついたものがあります。大切なデー
タが入っている場合は、ライトプロテクトで書き込みができない
ようにしてください。逆にデータを保存する場合などは、ご使
用の前にお使いのUSBフラッシュメモリーのライトプロテクトが
解除されていることをご参照ください。

USBフラッシュメモリー接続時に電源を切るには 
電源を切る場合は、再生/録音やファイル操作（セーブ/ロード/
フォーマットなど）によるUSBフラッシュメモリーへのアクセス中
でないことを確認してください。USBフラッシュメモリーやデー
タが壊れたりするおそれがあります。



EAD50　ユーザーガイド 11

各部の名称と機能

SDカードのフォーマット
SDカードは本製品でフォーマットすることをおすすめします。
他の機器でフォーマットしたSDカードは、本機で正しく動作しな
い場合があります。フォーマットについては177ページをご
参照ください。

ご注意
フォーマットを実行すると、そのSDカードの中身は消去されます。
必要なデータが入っていないことを確認してからフォーマットしてく
ださい。

誤消去防止
SDメモリーカードには、誤ってデータを消してしまわないように
するため、ロックスイッチがついている場合があります。大切な
データが入っている場合は、ロックを設定して書き込みができ
ないようにしてください。逆にデータを保存する場合などは、
ご使用の前にロックが解除されていることをご確認ください。

SDカード挿入時に電源を切るには
電源を切る場合は、再生/録音やファイル操作（セーブ/ロード/
フォーマットなど）によるSDカードへのアクセス中でないことを
確認してください。SDカードやデータが壊れたりするおそれが
あります。

SDカードご使用上の注意
本製品には、SDカード/SDHCカードを挿入するためのスロットがあり、本製品で制作したデータを保存することができます。

対応カード
本製品では、SDカードおよびSDHCカードに対応しています。
必要な容量に応じてお使いください。

SDカードの挿入

•	 SDカードは、金属端子面を上側にし、イラストの向きに合わ
せて差し込んでください。

•	 SDカードの抜き差しは、再生や録音中、ファイル操作中（セー
ブ/ロード/フォーマットなど）、およびSDカードへのアクセス
中には行わないでください。本製品の機能が停止したり、
SDカードやデータが壊れたりするおそれがあります。

•	 SDカードの抜き差しは、数秒間隔を空けて行ってください。
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ここでは、アコースティックドラム/電子ドラム特有の用語や、本マニュアルを読み進めていく上でポイントとなる用語を簡単に説明
します。

用語 説明 参照先

インスト(Inst) 電子ドラムのパッドを叩くことで鳴る楽器音のことで、1つのパッドに1つのインスト
が割り当てられています。過去のDTXシリーズにおいては「ボイスセット」と呼んでい
たこともあります。

17ページ

エッジ ドラムやシンバルの縁(ふち)の部分のことです。 17ページ

オーディション(試聴) Trigger Input Select画面(48ページ)で[F3]ボタンを押したときに鳴る試聴音
(オーディション)のベロシティーを設定します。

158ページ

オープンエッジ(OpEg) フットペダルを全く踏んでいない状態でハイハットシンバルのエッジ部を叩くことで
す。

18ページ

オープンボウ(OpBw) フットペダルを全く踏んでいない状態でハイハットシンバルのボウ部を叩くことです。 18ページ

オープンリムショット スネアドラムなど太鼓の打面(ヘッド)とリムを、スティックで同時に叩く奏法です。 96ページ

カップ シンバルの中心の小さく盛り上がった部分のことです。 17ページ

キット 電子ドラムの各パッドに様々な打楽器の音色(インスト)が配置されたものをひとま
とめにして「キット」と呼びます。通常の電子ドラムでは演奏シーンに応じてお好みの

「キット」を選びます。本製品において「キット」は「シーン」の中に組み込まれている
ので、シーンを選択することによりキットを選択することになります。

17ページ

クローズエッジ(ClEg) フットペダルを踏み込んだ状態でハイハットシンバルのエッジ部を叩くことです。 18ページ

クローズド リムショット アコースティックドラムでは、打面(ヘッド)の中心に手を置き、ヘッドをミュートしながら
手首のコントロールでリムを叩く奏法です。電子ドラムパッドでは、クローズドリム部
だけを叩き、ヘッドには触らないようにします。

96ページ

クローズボウ(ClBw) フットペダルを踏み込んだ状態でハイハットシンバルのボウ部を叩くことです。 18ページ

クロス スティック(Xstick) 「クローズドリムショット」と同義です。 63, 96, 
115ページ

クロストーク(Crosstalk) 電子ドラムのパッド(ドラムトリガーを取り付けたアコースティックドラムを含む) を叩
いたとき、共振やパッド間の干渉により他のパッドからトリガー信号が発生してしまう
ことをクロストークといいます。EADやDTXシリーズでは、設定した値より低いトリ
ガー信号音を出さないことで、クロストークの発生を防止します。

98ページ

シーン ドラム演奏における様々な場面に応じた設定群を、ワンタッチで呼び出せるようひとま
とめにしたものを「シーン」と呼びます。

73ページ

ゾーン 電子ドラムパッドにおいて、異なるトリガー信号が発生するエリアのことです。 
1ゾーンパッド、2ゾーンパッド、3ゾーンパッドがあります。

19ページ

チャンネル 本製品で鳴る様々な音を構成する単位です。本製品では、マイク音(Mic1 ～ 5)、トリ
ガー音(Kick, Snare, Trig3 ～ 22)、オーディオ、のチャンネルで構成されています。

37ページ

トーク 本製品では、接続したマイクをドラム演奏の収音用から、演奏者の声などを集音する
設定に切り替えることができます。その場合の設定項目を「トーク」と呼んでいます。

89ページ

ドラムキット 「キット」と同義です。 17ページ

トリガー音 トリガー信号を元に鳴らされている電子音(ボイス)のことを便宜的に「トリガー音」と
呼びます。

17ページ

トリガー信号 電子ドラムのパッドを叩くことにより発生する信号です。叩いた強さや場所を、電子
楽器の音源モジュール(トリガーモジュール)に伝えます。音源モジュールでは、受け
取ったトリガー信号を元に、電子音(ボイス)を鳴らします。

48ページ

用語集
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用語集

用語 説明 参照先

トリガーセンサー トリガー信号を取得するためのセンサーのことで、電子ドラムパッドや本製品において
はピエゾ(圧電素子)がその役割を担っています。

ー

トリガー入力 トリガー信号が音源モジュールに入力される際の枠の単位で、複数のトリガー入力
ソースにより構成されます。1つのトリガー入力に、1つのインストが割り当てられま
す。

16ページ

トリガー入力ソース トリガー信号が音源モジュールに入力される際の枠の最小単位で、4つのレイヤーで
構成されています。各レイヤーにはボイスを1つずつ割当できるので、1つのトリガー
入力ソースに最大4つまでボイスを割当できます。

18ページ

ハイハットシンバル シンバル2枚を重ねて専用のスタンドにセットし、ペダルで開閉操作をする打楽器で
す。

ー

パッド 電子ドラムにおいて叩く対象となる部品です。これを叩くことにより発生したトリガー
信号を元に、電子ドラムの音源にある電子音(ボイス)を鳴らします。

17ページ

パッドタイプ 電子ドラムのパッドを叩いたときに常に最適な音が鳴るように、トリガー入力信号など
に関する設定をあらかじめ調整したものです。音源モジュールにはキック・スネア・
タム・シンバルなど様々な種類のパッドを接続するため、各パッドの持つ特性に合った
パッドタイプを選択しておきます。

95ページ

パッドロック 本製品では、トリガー入力に関する設定を行う際に、パッドを叩くことで設定対象とな
るトリガー入力を選択できます。パッドロックは、パッドを叩いても対象となるトリガー
入力が変わらないようにする機能です。

48ページ

ピエゾ(電圧素子) 電子ドラムのパッド内部に装備されているセンサー部品です。これを通じて、叩いた
強さや場所に応じて検知された波形を基に、音量/音質/音色を決定します。装着さ
れているピエゾの数により、シングルピエゾパッドやマルチピエゾパッドがあります。

19ページ

フィルムスイッチ 電子ドラムのパッドによっては装備されていることがある部品です。例えば、複数ゾー
ンを持つシングルピエゾパッドの内部に装着されている場合、パッドを叩いたことによ
り検知される電圧に応じて、ゾーンを識別する役割を果たします。

19ページ

フットクローズ ハイハットペダルを踏むことでハイハットシンバルが閉じることをいいます。 100ページ

フットスプラッシュ ハイハットのペダルを踏んですぐ離すことで、オーケストラのシンバルのようにハイハッ
トを揺らして音を鳴らす奏法です。

100ページ

ヘッド アコースティックドラムでは、ドラムの打面及び裏面に張られた皮や膜のことをヘッド
と呼び、スティックで叩くことで音を発生させます。電子ドラムパッドにおいても、同
様な打面部をヘッドと呼びます。

ー

ボイス 電子ドラムのパッドに割り当てられたインストを構成する個々の電子音(トリガー音)を
指します。

17ページ

ボウ シンバルのカップとエッジの間にある広い部分です。 17ページ

ライブセット 本製品において「ライブセット」とは、「シーン」を順番に並べておき、演奏時に順に切り
替えていけるようにした機能のことです。

156ページ

リアルアンビエンス 電子ドラムの一部のインスト(ボイス)では、オンマイクで録音した波形(楽器音そのも
の)とオフマイクで録音した波形(残響音)の2種類で構成されています。本製品では
パラメーターで両者のバランスを調整することでボイスを形成できるよう、「リアルア
ンビエンス」というパラメーターがあります。

22ページ

リム スネアドラムなど太鼓の打面(ヘッド)を固定している枠(部品)のことです。 17ページ

レイヤー ボイスを割り当てる枠のことです。EADにおいては、電子ドラムの各トリガー入力ソー
スに、ボイスを割り当てるために4つのレイヤーが準備されています。

108ページ



EAD50　ユーザーガイド 14

EADとは？

本製品は、アコースティックドラムに装着したセンサーから取り込まれた2種類の信号、マイク端子からの入力音とトリ
ガー端子からの入力信号を元に、サウンドを作り上げていく製品です。
•	マイク端子からの入力音とは、アコースティックドラムを叩いた音そのものでオーディオ信号のことです。
•	トリガー端子からの入力信号とは、 トリガーセンサー装着のアコースティックドラムや電子ドラムパッドを叩いたとき
に発生するトリガー信号のことで、この信号を元に本製品に搭載されている電子音(ボイス)を鳴らします。

これらアコースティック音と電子音の両方に、エフェクト設定や音量調節などミキシングを行うことで、自分のドラム演奏
を好みのサウンドに仕上げていくことができます。

本製品

従来：EADが無い場合
ドラムセット各楽器にマイクを設置し、各マイク
から収音したサウンドを、ミキシングエンジニア
がライブ会場のミキサーでバランス調整する。

EADがあると...
マイクを各楽器に設置しなくても、センサーユニット1台
だけで演奏音を収音できる。また、エンジニアだけでな
く演奏者自身がバランス調整することも可能。

本製品付属の
センサーユニット

PAミキサーへ
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EADとは？

アコースティックドラム部（マイク入力）
アコースティックドラムの演奏打音をマイクで拾い、音量バランスやエフェクト設定などミキシングをすることでサウンドを仕上げます。

入力

出力 (37ページ)

[MIC/TRIG] →Mic
で設定編集

アコースティックドラムセット

付属センサーユニット
DSU50

MIC端子

マイクロフォン用.
ステレオ5ピン.
XLRケーブル
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EADとは？

電子ドラム部（トリガー入力）
センサーユニット装着のアコースティックドラムや電子ドラムパッドを叩いたときに発生するトリガー信号を元に、電子音(ボイス)に変
換した上で、音量バランスやエフェクト設定などミキシングをすることでサウンドを仕上げます。

出力 (37ページ)

付属センサー
ユニット

DSU50

TRIGGER端子

DT50S

KU100

PCY100

HH65

ハイハット.
コントローラー

[MIC/TRIG] →[F3] Setting 
→Trigger
で設定編集

XP80
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トリガー入力方式 (Integrated Trigger Input) 

トリガー音(キット/インスト/ボイス)の生成
ドラムパッドなどを叩くことによって本製品に入力されたトリガー信号を元に、以下のとおりトリガー音(キット/インスト/ボイス)が生成
されます。

キット
電子ドラムの各パッドに様々な打楽器の音色(インスト)が配置されたものをひとまとめにして「キット」と呼びます。本製品では、「キット」
は「シーン」の中に組み込まれているので、通常は、「シーン」を選択することで「キット」を選びます。

インスト
電子ドラムのパッドを叩くことで鳴る楽器音のことで、1つのパッドに1つのインストが割り当てられています。あらかじめ搭載されたキッ
トから音を変えたい場合は、トリガー入力端子ごと(パッドごと)に「インスト」を変更します。

ボイス
電子ドラムのパッドに割り当てられたインストを構成する個々の電子音を指します。インストを選択した後にさらに細かく音を変えたい
場合は、トリガー入力ソースごと(パッドのゾーンごと)に「ボイス」を変更します。本製品以外のサウンドを取り込みたい場合は、サンプ
リングしたりオーディオファイルをUSBメモリーから読み込んだりすることで「ユーザーボイス」を作り、パッドに割り当てます。

•	 1パッド(複数ゾーン)=1ケーブル=1トリガー入力=1インスト=レイヤーされたボイス群(最大4つまで)×ゾーン数=電子ドラム部の音源1チャンネル
•	 1ゾーン=1トリガー入力ソース=レイヤーされたボイス群1セット分

パッド部

ボウ部

Bリム部

カップ部

[MIC/TRIG]
 →[F3] Setting
 →Kit →Inst

[MIC/TRIG]
 →[F3] Setting
 →Kit →Voice

キット

インスト 最大4ボイス *

最大4ボイス *

最大4ボイス *

最大4ボイス *

最大4ボイス *

最大4ボイス *

最大4ボイス *

最大4ボイス *

最大4ボイス *

インスト

インスト

インスト

トリガー
信号

パッド

1ゾーンパッド﻿
(モノラルパッド)

3ゾーンパッド(XP80など)

3ゾーンパッド(PCY135など)

マルチピエゾパッド 
(XP125SD-Xなど)

2ゾーンパッド 
(RHH135など)

Aリム部

エッジ部

XP70など

DT50Kなど

リム部
ヘッド部 エッジ部

ボウ部

トリガー入力 トリガー入力ソース
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トリガー入力方式 (Integrated Trigger Input) 

トリガー信号の入力方式
本製品の電子音源部では、以下のとおり、全部で24個のトリガー入力を扱えます。

	■ トリガー入力端子から入力されるトリガー信号
本製品に接続した電子ドラムパッドなどからトリガー信号を
取得します。トリガー入力の全端子はステレオ入力のため、
1つのケーブル(1つの端子)で最大2種類のトリガー入力を
扱えます。各端子の名称がr/oのように2つの数字併記に
なっているのはそのためです。
以下画面にて、接続するパッドの種類やパッドからどのように
トリガー信号を取り込むかの方式(入力モード)の設定などを
行います。

[MIC/TRIG] →[F3] Setting →Trigger →Trig Pairing 
[MIC/TRIG] →[F3] Setting →Trigger →Trig In → Pad

	■ フットスイッチ端子から入力されるトリガー信号
本製品に接続したフットスイッチまたはフットコントローラか
ら入力される信号を元に、トリガー信号を発生します。以下
画面にて、これらのコントロール対象となるパッド(トリガー信
号)を選択するなど、必要な設定を行います。

[MIC/TRIG] →[F3] Setting →Trigger 
 →Trig In →Foot Sw1, Foot Sw2 →HH Trig In

HH Trig In = Off の場合 HH Trig In = Off 以外の場合
Foot1、Foot2のボイスを鳴らしま
す。

HH1、HH2のボイスをハイハットシンバルとみ
なして、その奏法をコントロールします。

トリガー入力 Foot1 Foot2 トリガー入力 HH1 HH2

トリガー入力
ソース Foot1Src Foot2Src

トリガー入力
ソース

•	HH1OpBw
•	HH1OpEg
•	HH1ClBw
•	HH1ClEg
•	HH1FtCl
•	HH1FtSp

•	HH2OpBw
•	HH2OpEg
•	HH2ClBw
•	HH2ClEg
•	HH2FtCl
•	HH2FtSp

	■ MIDI入力を元に発生するトリガー信号(全トリガー入力) 
全てのトリガー信号はMIDIによりコントロールできます。以下画面の
各トリガー入力ソースのレイヤー Aで設定したノートナンバー (Num)
と一致したノートナンバーがMIDI入力された場合に、トリガー信号が
発生し音が鳴ります。

[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice MIDI →Note1

Trig11～ Trig22はMIDI
入力でのみ対応可能

端子番号 q w e t y !0 FOOT SW 1 FOOT SW 2

トリガー入力 Kick Snare Trig3 .... Trig5 Trig6 .... Trig10 Foot1 Foot2 Trig11 .... Trig22

トリガー入力
ソース

KickSrc1 SnareSrc1 Trig3Src1 Trig5Src1 Trig6Src1 Trig10Src1 Foot1Src Foot2Src Trig11Src1 Trig22Src1
KickSrc2 SnareSrc2 Trig3Src2 Trig5Src2 Trig11Src2 Trig22Src2
KickSrc3 SnareSrc3 Trig3Src3 Trig5Src3 Trig11Src3 Trig22Src3

Bluetooth

DAW
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トリガー入力方式 (Integrated Trigger Input) 

	■ トリガー入力端子の仕様

他社パッド対応
トリガー入力端子e/i、r/o、t/!0については、以下の設定により、ヤマハ製品以外のパッドも接続可能です。
•	パッドタイプ選択

[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Type=Kick Trigger Pedal (Category=Kick)
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Type=Bar Trigger Pad1, 2 (Category=Others)

•	上記選択による自動設定
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Attenuator=On

	■ トリガー入力端子に接続可能な電子ドラムパッド
●1ゾーンパッド
電子ドラムのパッド中、最もシンプルな仕様のパッドで、ピエゾによりトリガー信号が1種類だけ発生します。したがって、パッドのど
こを叩いても、同一のボイスが鳴ります。

●2ゾーンパッド/3ゾーンパッド
パッドに装備されたフィルムスイッチにより、叩いた場所(ゾーン)により違うトリガー信号が発生します。したがって、2種類または3
種類の違うボイスが鳴ります。なお、q KICK/y 端子とw SNARE/u 端子では対応できません。

●マルチピエゾパッド
複数のピエゾ(圧電素子)を装備したパッドです。

	■ 電子ドラムパッドにおけるトリガー信号の発生仕様
•	圧電素子(ピエゾ)による発生
圧電素子(ピエゾ)は、電子ドラムパッドには必ず1つ以上装備されている電子部品です。パッドを叩くことによりこのピエゾがセンサー
として反応し、トリガー信号を発生します。2種類以上のピエゾが装備されているパッドには、「マルチピエゾ」や「2ピエゾ」といった呼び
方をします。
•	フィルムスイッチの切替による発生
フィルムスイッチは2ゾーンパッド、3ゾーンパッドに装備されている電子部品です。叩いた場所(ゾーン)に応じてスイッチが切り替わり、
該当箇所のトリガー信号が発生します。
•	位置検出機能による発生
同一ゾーンの中で、叩く位置により異なる信号を発生させることができるパッドです。同一ゾーンなので、どこを叩いても同一ボイス
ですが、叩く位置の違いにより、音が自然に変化します。

NOTE

様々な仕様の電子ドラムパッドが存在しますが、接続後は以下画面で適切なパッドタイプを選択してください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Type

マルチピエゾ(複数の圧電素子)搭載のパッドや1ゾーン
パッド/2ゾーンパッド/3ゾーンパッドのいずれにも対応
可能です。ほか、位置検出機能を搭載したパッドや他社
パッドにも対応可能です。

マルチピエゾ(複数の圧電素子)搭載のパッドや1ゾーンパッド
のみ対応可能です。2ゾーン/3ゾーンパッドは対応不可で、接
続した場合は1ゾーンパッド(スネアならヘッドだけ、シンバルな
らボウショットだけ、など)として動作します。
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トリガー入力方式 (Integrated Trigger Input) 

トリガー入力モード
端子名称がr/oのように2つの数字の併記になっているトリガー入力端子は、ステレオ信号が入力される仕様のため、1つのケーブ
ル(1つの端子)で2種類のトリガー信号が本製品に入力されます。その2種類のトリガー信号につき、いずれも1つのインスト(パッド)か
ら取り込むか、別々のインスト(パッド)から取り込むか、入力モードを変更することができます。

[MIC/TRIG] →[F3] Setting →Trigger →Trig Pairing=Separate に設定した場合の例

3ゾーンパッドからのトリガー信号は、r系統に
入力されたあと、3種類のうち主たる打面1つ(シ
ンバルならボウ部、スネア/タムならヘッド部)だけ
が音源(トリガー入力ソース)に送られボイスが鳴
ります。
1ゾーンパッドからのトリガー信号は、o系統に
入力されたあと、そのまま音源(トリガー入力ソー
ス)に送られボイスが鳴ります。

パッドからのトリガー信号は、r系統に入力され
たあと、3種類全てが音源(トリガー入力ソース)
に送られ、ボイスが鳴ります。o系統は使用され
ません。

3ゾーンパッド

3ゾーンパッド

1ゾーンパッド

Y字ケーブル(市販)を使用

r

Trig4Src1

Trig4Src2

Trig4Src3

o Trig9Src1

r

Trig4Src1

Trig4Src2

Trig4Src3

o Trig9Src1

モノラルフォーンジャック

ステレオフォーン
ジャック

ステレオフォーン
ジャック

ステレオフォーン
ジャック

モノラルフォーンジャック

トリガー入力ソース

トリガー入力ソース

[MIC/TRIG] →[F3] Setting →Trigger →Trig Pairing=Paired に設定した場合の例
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エフェクト構成

エフェクト結線概略図

トリガー入力チャンネル
（電子ドラム部）

マイク入力チャンネル
(アコースティックドラム部)

オーディオ﻿
チャンネル

Kick
Snare
Trig3
：
：

Trig22

Mic1
Mic2
Mic3
Mic4
Mic5

USB Audio 1/2
USB Audio 3/4
USB Audio 5/6
USB Audio 7/8

レコーダー再生1
レコーダー再生2
ルーパー再生
サンプリング再生

Bluetooth Audio

AUX IN

クリック

波形 Real Ambi

EQ

トランジェント
コンプレッサー

インサーション
エフェクト*

トリガー入力ごとのエフェクト

マイク入力ごとのエフェクト

オーディオ入力ごとのEQ

* Trig18～ 22はインサーションエフェクトがありません。

EQ

EQ

トランジェント
コンプレッサー

インサーション
エフェクト1

インサーション
エフェクト2

[MIC/TRIG] →[F3] Setting 
→Kit →Inst →Inst EQ

[MIC/TRIG] →[F3] Setting .
→Kit →Inst →Inst TranComp

[MIC/TRIG] →[F3] Setting 
→Effect →Ins Trig

[MIC/TRIG] →[F3] Setting 
→Mic →Mic EQ

[MIC/TRIG] →[F3] Setting .
→Mic →Mic TranComp

[MIC/TRIG] →[F3] Setting 
→Effect →Ins1 Mic

[MIC/TRIG] →[F3] Setting 
→Effect →Ins2 Mic

[MENU] →Aux In →Aux In EQ

[MENU] →USB Audio →USB Audio EQ
[RECORDER] →[F3] Setting →Recorder EQ

[MENU] →Bluetooth →Bluetooth EQ

システムエフェクト

マスターエフェクト

[MIC/TRIG] →[F3] Setting →Effect

[MIC/TRIG] →[F3] Setting →Effect [MENU] →Output 
→Phones EQ

マスター
FX

マスター
EQ

マスター.
コンプレッサー

Phones.
EQ

リバーブ

FX1

FX2
FX2 →Send to Reverb

FX1 →Send to Reverb

Reverb →Send All

Reverb →Send Mic, Send Trig

FX1 →Send Mic, Send Trig
FX2 →Send Mic, Send Trig

FX1 →Send All
FX2 →Send All

マイクとトリガー入力は個別に
センド量を設定可能。

FX1 →Return

FX2 →Return

Reverb →Return
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エフェクト構成

エフェクト構成
本製品のサウンドに対してかかるエフェクトの構成を説明します。

エフェクトブロック 設定画面 説明

リアルアンビエンス [MIC/TRIG] →[F3] Setting →Effect 
→Real Ambi

電子ドラムの一部のインスト(ボイス)では、オンマイ
クで録音した波形(楽器音そのもの)とオフマイクで
録音した波形(残響音)の2種類で構成されています。
リアルアンビエンスは、両者のバランスを調整するも
のです。

NOTE：
オンマイク録音とオフマイク録音の2種類の波形構成
になっていないインスト(ボイス)は、リアルアンビエン
スに対応していません。詳細はデータリストでご確認
ください。

チャンネルごとのエフェクト マイク音/トリガー音の全チャンネルのうち、特定の
チャンネルに対してだけかけるエフェクトです。

マイクごとのEQ [MIC/TRIG] →[F3] Setting →Mic 
→Mic EQ

マイク端子ごとの入力音にかけるEQです。

インストごとのEQ [MIC/TRIG] →[F3] Setting →Kit 
→Inst →Inst EQ

電子ドラムパッドのインストごとにかけるEQです。

マイクごとのトランジェント 
コンプレッサー

[MIC/TRIG] →[F3] Setting →Mic 
→Mic TranComp

マイク入力端子ごとに、入力音に対してトランジェン
トエフェクト(アタック感やリリース感)やコンプレッ
サーをかけます。

インストごとのトランジェント 
コンプレッサー

[MIC/TRIG] →[F3] Setting →Kit 
→Inst →InstTranComp

現在選択されているドラムキットの各インストに、トラ
ンジェントエフェクト(アタック感やリリース感)やコン
プレッサーを一緒にかけるものです。

マイクごとのインサーション
エフェクト1

[MIC/TRIG] →[F3] Setting →Effect 
→Ins1 Mic

各マイク入力端子からの入力音に対して、2系統のイ
ンサーションエフェクトを個別にかけるものです。

マイクごとのインサーション
エフェクト2

[MIC/TRIG] →[F3] Setting →Effect 
→Ins2 Mic

トリガーごとのインサーショ
ンエフェクト

[MIC/TRIG] →[F3] Setting →Effect 
→Ins Trig

トリガー入力にもとづき鳴っているドラムキットの各
インストに、1系統のインサーションエフェクトを個
別にかけるものです。

NOTE：
Trig18–22にはありません。
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エフェクト構成

エフェクトブロック 設定画面 説明

システムエフェクト マイク音/トリガー音の全チャンネルに対して共通に
かかるエフェクトです。選択できるエフェクトタイプ
は全パート共通ですが、センドレベルを設定すること
でパート別にかかり具合を違えることはできます。

各パートからセンドレベルに従ってエフェクト部に送
られた音が、ウェット音に加工されたあと、全パート
共通のリターンレベルで元ルートに戻り、ドライ音(エ
フェクトがかかっていない音)とミックスされて音が仕
上がります。

システムエフェクトとして、以下3つのブロックが平行
に配置されており、ブロック別にタイプ選択/センドレ
ベル設定を行います。

NOTE：
•	 各ブロックで加工されたウェット音だけを、単独で外

部に出力することもできます。(120、121ページ)
•	 システムエフェクトに送る音だけでなく、送らない音

(ドライ)の設定も行います。(122ページ)

リバーブ [MIC/TRIG] →[F3] Setting →Effect 
→Reverb

コンサートホールやライブハウスで演奏しているよう
な残響(リバーブ)効果のことです。

FX1 [MIC/TRIG] →[F3] Setting →Effect 
→FX1

ディレイ系、コーラス系などのタイプを持つエフェク
トです。

FX2 [MIC/TRIG] →[F3] Setting →Effect 
→FX2

マスターエフェクト マイク音/トリガー音の全チャンネルに対して共通に
かかるエフェクトです。

マスター FX [MIC/TRIG] →[F3] Setting →Effect 
→Master FX

オーディオ入力を除く本体サウンド全体にかかるエ
フェクトです。

マスターコンプレッサー [MIC/TRIG] →[F3] Setting →Effect 
→Master Comp

オーディオ入力を除く本体サウンド全体にかかるコン
プレッサーです。

マスター EQ [MIC/TRIG] →[F3] Setting →Effect 
→Master EQ

EQ(イコライザー )は、サウンドをいくつかの周波数
帯域(バンド)に分けて、各帯域のレベル(ゲイン)を上
げ下げする装置です。マスター EQは、オーディオ
入力を除く本製品のサウンド全体にかかるイコライ
ザーです。



EAD50　ユーザーガイド 24

エフェクト構成

エフェクトブロック 設定画面 説明

チャンネルごとのEQ オーディオ入力を除くサウンド全体にかかる「マス
ター EQ」に対して、インストやマイクなど、チャンネル
ごとにかけるEQも装備されています。

インストごとのEQ [MIC/TRIG] →[F3] Setting →Kit 
→Inst →Inst EQ

22ページをご参照ください。

マイクごとのEQ [MIC/TRIG] →[F3] Setting →Mic 
→Mic EQ

22ページをご参照ください。

AUX IN 端子からの入力 [MENU] →Aux In →Aux In EQ [AUX IN]端子からの入力音にかけるEQです。

USB TO HOST端子からの
入力

[MENU] →USB Audio  
→USB Audio EQ

[USB TO HOST]端子からの入力音につき、ステレ
オ4系統(1/2, 3/4, 5/6, 7/8)それぞれ個別にEQ
設定ができます。

レコーダーでのオーディオ再
生音

[RECORDER] →[F3] Setting 
→Recorder EQ

レコーダーでのオーディオ再生音につき、2系統
(Playback1, Playback2)それぞれ個別にEQ設定
ができます。

Bluetoothからの入力 [MENU] →Bluetooth  
→Bluetooth EQ

Bluetooth経由での入力音にかけるEQです。

ヘッドホンサウンドのEQ

Phones EQ [MENU] →Output →Phones EQ [PHONES]端子に接続したヘッドホンで聞くサウンド
につき、EQ設定ができます。
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エフェクト構成

イコライザーの形状

	■ イコライザー(EQ)とは？
いくつかの周波数帯域(バンド) をそれぞれブースト/カットしたり、各周波数域のQ(周波数特性) を調整したりすることで、サウンドを
作りあげる装置です。本製品では、マスター EQは5バンド、チャンネルごとのEQ(24ページ)は4バンドで構成されています。

5バンド構成のEQ(マスター EQ)
ゲイン
(Gain)

5バンドの帯域→

Q(周波数特性)

周波数
(Freq)

Low
MidLow

Mid
MidHigh

High

4バンド構成のEQ(チャンネルごとのEQ) 
ゲイン
(Gain)

5バンドの帯域→

Q(周波数特性)

周波数
(Freq)

Low
MidLow

MidHigh
High

Q(周波数特性)とは？
イコライジングの効果範囲となる周波数の幅を、帯域ごとに設定します。設定値が大きくなると周波数の範囲が狭くなり、急な
音色変化になります。値が小さくなると周波数の範囲が広くなり、なだらかな音色変化になります。

	■ シェルビング(Shelving)とピークディップ(PeakDip)
上図のように、各周波数域を盛り上げるか削るかで調整する形状を「ピークディップ(PeakDip)」と呼びます。一方、特定の周波数以
下、または特定の周波数以上の音を盛り上げたり削ったりする形状を「シェルビング(Shelving)」と呼びます。低域側または高域側で
この形状を選ぶことで、ローパスフィルターまたはハイパスフィルターと同等の効果が得られます。

低域側の形状(Low Shape)
すべてのEQ(23 ～ 24ページ)の画面で、以下のいずれか
の形状をを選択します。

PeakDipLowShelving

Gain(ゲイン)
Freq(フリケンシー )

周波数(Freq)

周波数(Freq)

Gain(ゲイン)
Freq(フリケンシー )

高域側の形状(High Shape)
すべてのEQ(23 ～ 24ページ)の画面で、以下のいずれか
の形状をを選択します。

PeakDip

周波数(Freq)

Gain(ゲイン)
Freq(フリケンシー )

HighShelving

Gain(ゲイン)
Freq(フリケンシー )

周波数(Freq)

	■ フィルター機能
本製品のHPF(ハイパスフィルター )とLPF(ローパスフィルター )は、以下の方法で実現しています。
•	 HPFは独立したフィルターを装備しており、Phones EQを除く4バンドEQの設定画面で関連設定を行います。
•	 LPFはEQ高域を転用する方式で実現しており、Phones EQを除く全てのEQ設定画面の「High Shape」で関連設定を行います。

いずれも、各チャンネルのEQ設定画面で設定できます。
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内部メモリー構造

U200

U001U001U001U001U001

U01–U50

U001–U500

U001–U200

シーン編集
(73ページ)

ライブセット編集
(156ページ)

サンプリング機能
(151ページ)

サンプリング録音
(151ページ)

ルーパー録音
(145ページ)

レコーダー録音
(135ページ)

サンプル

ライブセット

シーン

内部メモリー
(IntMem)

ウェーブメモリー

ユーザーボイス

[MIC/TRIG] →[F3] Setting 
 →Kit →User Voice 
 →Import Wave

Scene.bin
(初期ファイル名)

All.bin

外部メモリー
(メディア)

XXXX.wav

XXXX.wav

[MENU] →File 
 →File Scene →Save

[MENU] →File 
 →File All →Load

[MENU] →File 
 →File All →Save

[MENU] →File 
 →File Scene →Load

本製品内部

シーンの中で使われているユー
ザーボイスのデータも、併せて保
存(セーブ)/読み込み(ロード)さ
れます。
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内部メモリー構造

ユーザーボイス部の詳細
•	 本製品には「ウェーブメモリー」と呼ばれるメモリー領域があり、ここに録音やインポートで取り込んだサンプルを「ユーザーボイス」

として保存します。
•	「ユーザーボイス」は全部で500個まで保存可能で、各ユーザーボイスは10個の「バンク」から構成されています。ただし、１つの

ユーザーボイスで一度に複数のバンクを鳴らすことはできません。ベロシティー範囲を調整して叩く強さによって鳴らし分けてく
ださい。ベロシティー範囲が重なったバンクがある場合は、番号が小さいバンクが鳴ります。

•	 サンプリングにより制作されたサンプルは、ユーザーボイスのいずれかのバンクに割り当てることになります。

ご注意
内部メモリーには、同時に1つのサンプルのみ存在できます。録音
やオーディオファイルを読み込んだ場合、元から存在していたデー
タは上書き消去されます。残しておきたいデータは、忘れないうち
に外部メモリーに保存してください。

編集したいサンプルを
いずれかのユーザーボ
イス/バンクから読み込
みます。

ウェーブメモリー 内部メモリー
外部﻿
メモリー

本製品内部

ユーザーボイス U001
・バンク 01 (B01)
・バンク 01 (B02)
・バンク 01 (B03)
・バンク 01 (B04)
・バンク 01 (B05)
・バンク 01 (B06)
・バンク 01 (B07)
・バンク 01 (B08)
・バンク 01 (B09)
・バンク 01 (B10)

ユーザーボイス U002

ユーザーボイス U003

ユーザーボイス U500
・バンク 01 (B01)
・バンク 01 (B02)

制作したサンプルを
いずれかのユーザー
ボイス/バンクに保存
します。

オーディオファイルを
読み込んでサンプル
として仕上げます。

制作したサンプルを
オーディオファイル
として保存します。

[MIC/TRIG] → Kit → User Voice → Import Wave

既存のオーディオファイルを、ユーザーボイス/バンクに
インポートできます。
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内部メモリー構造

シーンの構成

シーン 1 (P001)

シーン 2 (P002)

シーン 70 (P070)

ユーザーシーン 200 (U200)

ユーザーシーン 001 (U001)

Modifier(モディファイヤ)
・[SCENE] →[F1] ModSel →[+][−]ボタン/ノブ
・[SCENE] →[F3] Setting →Modifier

Effect(エフェクト)
[MENU] →Effect

Mic/Kit Vol(マイク/キットボリューム)
[MIC/TRIG] →[F3] Setting →Mic 

Trigger(トリガー )
[MIC/TRIG] →[F3] Setting →Trigger

Kit(キット)
[MIC/TRIG] →[F3] Setting →Kit

Function(機能)
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice Func

外部からのオーディオ入力﻿
に関する設定

Utility(ユーティリティ)
[MENU] →Utility 

その他の設定﻿
(MIDIなど)

録音/ルーパー /サンプリングに関する設定 オーディオ外部出力に関する設定

マイク入力音(アコースティックドラム打音)
に関する設定

トリガー信号を元に鳴る電子ドラム音に関する設定

Aux In
[MENU] →Aux In

Output(アウトプット)
[MENU] →Output

Recorder(レコーダー )
・[RECORDER] →Recorder →オーディオファイル選択、[F3] Setting
・[RECORDER] →Looper →[F3] Setting
・[RECORDER] →Sampling →[F3] Setting

Mic(マイク)
[MIC/TRIG] →[F3] Setting →Mic 

USB Audio
[MENU] →USB Audio

Bluetooth
[MENU] →Bluetooth

Click(クリック)
[CLICK] →[F3] Setting

クリックに関する設定

Tempo(テンポ)
[CLICK]で表示される画面にて設定。
製品本体のシーケンサー再生時のテンポ値。
クリック再生やエフェクトも同期の対象。

Fader(フェーダー )
・フェーダーモードの選択状態
・フェーダー機能の選択状態
・[SCENE] →[F3] Setting →Fader

[SCENE] →[F3] Setting →Scene Load (75ページ)
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内部メモリー構造

ライブセットの構成

ステップ 01 (S01) ステップ 02 (S02) ステップ 03 (S03) ステップ 50 (S50)

ライブセット 01 (U01)

ライブセット 02 (U02)

ライブセット 03 (U03)

ライブセット 50 (U50)

Scene xxScene xxScene xxScene xx

[LIVE SET] →[F3] Setting (157ページ)
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基本的なセッティング
本製品は、付属のセンサーユニットDSU50をバスドラムに装着するだけでドラム演奏を十分お楽しみいただけますが、追加でマイク、
ドラムトリガー、電子ドラムパッドを購入し設置いただくことで、さらに充実したドラム演奏を展開できます。
ここでは、本製品搭載のプリセットシーン(79ページ)が想定しているセッティングをご紹介します。

NOTE

•	 本製品だけによる設置方法(センサーユニットDSU50のバスドラムへの設置方法など)については、クイックガイドをご参照ください。

	■ セッティングA
アコースティックドラム以外に電子ドラムパッド(別売)やトリガーセンサー (別売)を追加で接続したセッティングです。アコースティッ
クドラムと電子ドラムをバランスよく演奏できる、「ハイブリッドドラム」の基本形ともいえます。B以降の他のセッティングの基本形に
もなっています。

	■ セッティングB
セッティングAのタム(アコースティック)にトリガーセンサー (別売)を設置したものです。

Foot1
(HH65)

Trig5
(XP80)

Trig3
(KU100)

Snare
(DT50S)

Trig4
(PCY100)

Mic1-Mic2, Kick
(DSU50)

Foot1
(HH65)

Trig5
(DT50S)

Snare
(DT50S)

Mic1-Mic2, Kick
(DSU50)

Trig3
(DT50S)

Trig4
(DT50S)

準備
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準備

	■ セッティングC
セッティングAに対して、プレーヤーの頭上前方に付属品とは別にDSU50を追加で設置したものです。追加のDSU50は、以下を目
安に、打面に向かって角度をつけて設置します。

【俯瞰図】

【側面図】

Foot1
(HH65)

Trig5
(XP80)

Trig3
(KU100)

Snare
(DT50S)

Trig4
(PCY100)

Mic1-Mic2, Kick
(DSU50)

Mic4-Mic3*
(DSU50)

12
0

18
0

Mic4-Mic3*
(DSU50)

単位： cm

*	 頭上前方にセッティングしたDSU50で
は、L側コネクター (白)を[MIC4]端子
に、R側コネクター (赤) を[MIC3]端
子に接続してください。プレーヤーに
対してマイクのステレオ左右が反対に
なるからです。

NOTE

演奏会場の環境や音の好みに応じて、角度
や高さは適宜調整してください。なお、角度
をつけたり高さを確保するのが難しい場合
は、マイクスタンドのネジとマイク（DSU50）
のネジ穴の間に接続可能な、ボールジョイン
ト式アダプターのご使用をおすすめします。
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準備

	■ セッティングD
セッティングAに対して、プレーヤーの背後に付属とは別にDSU50を追加で設置するものです。追加のDSU50は、以下を目安に、打
面に向かって角度をつけて設置します。

【俯瞰図】

Foot1
(HH65)

Trig5
(XP80)

Trig3
(KU100)

Snare
(DT50S)

Trig4
(PCY100)

DSU50
<Mic3-Mic4>

Mic1-Mic2, Kick
(DSU50)

【側面図】

単位： cm

170
180

DSU50
<Mic3-Mic4>
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準備

	■ セッティングE
セッティングAに対して、プレイヤーの頭上前方にマイク2台を追加で設置するものです。

	■ セッティングF
セッティングAの各楽器に対して、マイクを個々に配置するものです。

Foot1
(HH65)

Trig5
(XP80)

Trig3
(KU100)

Snare
(DT50S)

Trig4
(PCY100)

Mic L
<Mic3>

Mic R
<Mic4>

Mic1-Mic2, Kick
(DSU50)

Foot1
(HH65)

Trig5
(XP80)

Trig3
(KU100)

Snare
(DT50S)

HH
<Mic5>

Kick
(DSU50)

OH L
<Mic1>

OH R
<Mic2>

Trig4
(PCY100)

Kick
<Mic3>

Snare
<Mic4>
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準備

外部機器との接続—入力

	■ マイク入力およびライン入力
本製品には、リアパネルにある5つの[MIC/LINE INPUT]端子を通じて、アコースティックドラムの演奏音やプレイヤーのトーク音声
が入力されます。また、この端子はライン入力にも対応しているので、電子楽器やギターアンプなど、他の楽器からのオーディオも入
力されます。

5つの[MIC/LINE INPUT]端子を利用して、
演奏音を本製品に入力 入力されたオーディオの

音量はここで調整

1と2、3と4はそれぞれステレオとしてのペアリングが、以下の
画面で設定できます。

[MIC/TRIG] →[F3] Setting →Mic →Mic Pairing

NOTE

DSU50使用の場合は、必ず付属のケーブル
をご使用ください。同じような端子形状の照
明制御用のケーブル(DMXケーブル)を使う
と、ノイズの原因になります。

[MIC/LINE INPUT]端子使用上のご注意
[MIC/LINE]端子は、XLRタイプおよびTRS フォーンタイプの両プラグに対応した端子で、いずれもバランス接続となります。
これら2つのタイプは、接続したい外部機器の出力レベルによって使い分けます。
XLRプラグ
出力レベルの低い機器(本製品側でゲインの増幅が必要な機器)を接続します。アコースティックドラム演奏などを収音するマイ
クの接続が想定されます。
TRSフォーンプラグ
出力レベルの高い機器を接続します。オーディオ機器や電子楽器などの接続が想定されます。

NOTE

•	 適切なプラグの使い分けをした上で、さらに入力元の機器(接続した機器)側での出力レベルも必ず適切に調節してください。

	■ トリガー入力
本製品には、リアパネルにある[TRIGGER INPUT]端子を通じて、電子ドラムパッドやトリガーセンサーからのトリガー信号が入力され
ます。

トリガー信号を本製品に入力
トリガー音(入力されたトリガー信号にもとづき
鳴っているボイス)の音量はここで調節
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準備

	■ フットスイッチ/フットコントローラーによる入力
ペダルを[FOOT SW]端子に接続することで、トリガー音を鳴らすことを含め以下3種類の機能を活用できます。

フットスイッチ/フットコントローラーに割り当てられる機能
● トリガー音を鳴らす機能

[MIC/TRIG] →[F3] Setting →Kit →Inst →Inst →Category, Number
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice →Category, Number

● 切替機能
シーン切替、ライブセット切替、テンポ変更、トーク設定、クロススティックのオン/
オフなど

[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice Func

● 分量の調節機能
テンポ、音量、モディファイヤーなどのコントロール

[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice Func

フットスイッチ/フットコントローラー接続に関連した設定
● 端子に接続する機種を設定

[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Foot Sw1, Foot Sw2 →Type

● ハイハットコントローラーとして使用する設定
以下の画面でHH Trig In = Off以外に設定すると、指定したトリガー入力をハイハットシンバルとみ
なします。6種類のシンバル音を、ペダルを含めた奏法でコントロールできるようになります。

[MIC/TRIG] →[F3] Setting →Trigger →Foot Sw1, Foot Sw2 →HH Trig In

	- HH1OpBw：ペダルを踏まないまたは軽く踏んだ状態でシンバルパッドのボウ部を叩くと鳴る音
	- HH1OpEg：ペダルを踏まないまたは軽く踏んだ状態でシンバルパッドのエッジ部を叩くと鳴る音
	- HH1ClBw：ペダルを踏み込んだ状態でシンバルパッドのボウ部を叩くと鳴る音
	- HH1ClEg：ペダルを踏み込んだ状態でシンバルパッドのエッジ部を叩くと鳴る音
	- HH1FtCl：ペダルを踏み込むことで鳴るフットクローズ音
	- HH1FtSp：ペダルを踏んですぐに離すことで鳴るフットスプラッシュ音

● トリガー音を鳴らす以外の機能をトリガー入力ソースに割り当て
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice Func

トリガー音は、ここで音量を調整
[FOOT SW1, 2]端子

FC3A
ペダルを放すと
元に戻る

FC7
ペダルを放しても
そのまま保持

FC4AFC5

HH65
RHH135
(+Hi-Hat Stand))

HH40

エッジ部 ボウ部
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	■ AUX IN
外部オーディオ機器の再生音を本製品で鳴らすことができます。

	■ USBケーブルによるMIDI入力(USB TO DEVICE)
本製品にはUSBトリガーリンク機能が搭載されています。これにより、他のMIDI機器の演奏により送信されたMIDIメッセージを、
USBケーブル経由で受信し、本製品の電子音源で鳴らせます。

1

2
ここで入力音量を調節

EAD本体

MIDI機器

ここで、入力されたMIDIメッセージ
により鳴っている本体音源の音量を
調節
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準備

外部機器との接続—出力

	■ オーディオ出力
本製品に入力された各サウンドは、以下のようにいくつかの出力方法があり、チャンネルごとに設定できます。

本製品への入力音 .
(オーディオチャンネル) 本製品からの出力先を設定する画面 出力する/しないの設定対象となる出力先

各マイク端子からの入力音 [MIC/TRIG] →[F3] Setting →Mic →Mic Out Main Out*, Phones Out*, USB Audio Out 1/2*, IndivOut
トリガー端子からの入力信号に基づい
て鳴っている各インスト

[MIC/TRIG] →[F3] Setting →Kit →Inst →Inst Out Main Out**, Phones Out**, USB Audio Out 1/2**, IndivOut

システムエフェクト/マスターエフェクト
の処理を終えた演奏音

[MIC/TRIG] →[F3] Setting →Effect →Effect Out Main Out, Phones Out, USB Audio Out 1/2

クリック音 [CLICK] →[F3] Setting →Click Out Main Out, Phones Out, USB Audio Out 1/2, IndivOut
レコーダー再生音 [RECORDER] (Recorder) →[F3] Setting →Recorder Out Main Out, Phones Out, USB Audio Out 1/2, IndivOut
ルーパー再生音 [RECORDER] (Looper) →[F3] Setting →Looper Out Main Out, Phones Out, USB Audio Out 1/2, IndivOut
[AUX IN]端子からの入力音 [MENU] →Aux In →Aux In Out Main Out, Phones Out, USB Audio Out 1/2, IndivOut
[USB TO HOST]端子からの入力音 [MENU] →USB Audio →USB AudioOut Main Out, Phones Out, USB Audio Out 1/2, IndivOut
Bluetooth経由で入力された音 [MENU] →Bluetooth →BluetoothOut Main Out, Phones Out, USB Audio Out 1/2, IndivOut
* [MIC/TRIG] →[F3] Setting →Mic →Mic Out →Effect Thru=On の場合にのみ有効
** [MIC/TRIG] →[F3] Setting →Kit →Inst →Inst Out →Effect Thru=On  の場合にのみ有効

本製品からのオーディオ出力.
(画面上の表記) 該当する端子 音量調整の

スライダー 接続先の機器

Main Out
OUTPUT -BALLANCED- OUTPUT アンプ/スピーカーなど

のPA機器

OUTPUT -UNBALLANCED- OUTPUT アンプ/スピーカーなど
のPA機器

Phones Out PHONES PHONES ヘッドホン

USB Audio Out USB TO HOST OUTPUT コンピューター、スマート
デバイスなど

IndivOut INDIVIDUAL -BALLANCED- - ミキサーなどのPA機器

NOTE

[MENU] →Output →Output Gain にて出力ゲイン
を端子ごとに調節できます。

Phones Out USB Audio Out Main Out IndivOut

NOTE

2つの端子を同時に使うと、ヘッド
ホンへの出力が小さくなることが
あります。

バランス(BALLANCED)と﻿
アンバランス(UNBALLANCED)
本製品の入出力端子には、バランス対
応のものとアンバランス対応のものが
あります。特に[OUTPUT]端子は両
方を装備しており、以下のポイントを参
考に使い分けをしてください。
•	 バランス方式はノイズに強いので、入

出力のレベルが低いマイクやケーブ
ルが長くなる場合に適しています。

•	 アンバランス方式は、主にラインレベ
ルの機器(シンセサイザーなどの電子
楽器)や小規模な音響機器との接続に
使用します。
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	■ MIDIケーブルによる出力(MIDI OUT)
トリガー信号にもとづいた演奏している場合、本製品で割り当てられたボイスを鳴らすだけでなく、MIDIメッセージを送信することで
外部MIDI機器を鳴らすこともできます。

[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice MIDI

	■ USBによる外部MIDI機器へのMIDI出力(USB TO HOST)
USBトリガーリンク機能を搭載したMIDI機器を本製品の[USB TO HOST]端子に接続すると、本製品での演奏で発生したMIDIメッ
セージによって、接続先のMIDI機器を鳴らせます。

ヤマハRX11、RX21など、
USB端子が無かった時代のリ
ズムマシンのビンテージモデ
ルを接続するとよいでしょう。

EAD本体

NOTE

[MIDI OUT]端子の扱うMIDI
メッセージはポート1のみです。
ポート2のMIDIメッセージは出
力されないのでご注意ください。

EAD本体

USBトリガーリンク機能
搭載のMIDI機器

接続したMIDI機器を最適なサウンドで鳴らすために
以下の画面で、トリガー入力ソースのレイヤーごとにノート
ナンバーとチャンネルを設定することにより、接続したMIDI
機器を最適なボイスで鳴らすことができます。

[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice MIDI

MIDI機器のノートマップを参照しながら設定してください。
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本製品のMIDI仕様
本製品では、全部で32チャンネル(16チャンネル x 2ポート)のMIDIメッセージを、以下の方法で送受信できます。
•	 [USB TO HOST]端子

コンピューターやスマートデバイスと接続することで、アプリとの通信(送受信)ができます。また、本製品と同じくUSBトリ
ガーリンク機能を搭載した機器へのMIDI送信もできます。

•	 [USB TO DEVICE]端子
本製品のUSBトリガーリンク機能により、USB-MIDI機能のある他のドラムトリガーモジュール(電子楽器)からのMIDI受
信ができます。

•	 [MIDI OUT]端子
USB-MIDI機能が搭載されていない他のMIDI機器(ドラムトリガーモジュール)に、ポート1に限りMIDI送信できます。(38ページ)

•	Bluetooth
外部のBluetooth機器とMIDI通信(送受信)できます。

ポート1

1ｃｈ
2ｃｈ
3ch
4ch
5ch
：
：
：
16ch

ポート2

1ｃｈ
2ｃｈ
3ch
4ch
5ch
：
：
：
16ch

コンピューターや﻿
スマートデバイスなど

USBトリガーリンク機能搭載のMIDI機器
(トリガーモジュールなど)

MIDI機器
(トリガーモジュールなど)

MIDI機器
(トリガーモジュールなど)

スマートデバイスなど
Bluetooth機器

チャンネル設定 ポート設定 / チャンネル設定

ポート設定 / チャンネル設定

EAD
本体

関連設定
・ポート

[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice MIDI →Note Port
・送信チャンネル

[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice MIDI →Ch (Note1 ～ 4)
・受信チャンネル

[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice MIDI →Note1 Ch

NOTE

詳細仕様は、別ファイル「データリスト」にあるMIDI資料をご参照ください。
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外部機器との接続—入出力

	■ コンピューターとのMIDI/オーディオ通信(USB TO HOST)

コンピューターからのMIDI
メッセージで鳴っている本製
品の音源の音量を調整

EAD本体

コンピューターからのオーディオ
の音量を調整

DAW

コンピューターとの接続(Mac)
1.	 コンピューターの端子のタイプに合わせて、USBケーブルを準備します。
2.	 USBケーブルを本製品に接続したあと、コンピューターに接続します。ドライバーのインストールは不要です。

コンピューターとの接続(Windows)
1.	 ヤマハウェブサイト(https://download.yamaha.com/jp/)からYamaha Steinberg USB Driverをダウンロードします。
2.	 コンピューターにYamaha Steinberg USB Driver をインストールします。
3.	 コンピューターの端子のタイプに合わせて、USBケーブルを準備します。
4.	 USBケーブルを本製品に接続したあと、コンピューターに接続します。

	■ スマートデバイスとのMIDI/オーディオ通信(USB TO HOST)
本製品での演奏音(オーディオ)をスマートデバイスのアプリに録音できます。スマートデバイスの端子形状に応じてUSBケーブルを
準備した上で、接続してください。

USBオーディオ通信仕様の切替
本製品のUSBオーディオ通信は、
2in/2out (24-bit、44.1/48/96 kHz 
シンクロナス)と8in/10out (16-bit、
44.1 kHz アシンクロナス)のどちらかで
使用します。どちらの仕様で使うかは、以
下画面で選択し、電源を入れなおします。
[MENU] →USB Audio →USB Audio →Mode

EAD本体

Rec'n'Share

NOTE

本製品とスマートデバイスの接続に関する詳細は、 
ヤマハウェブサイト上にある以下のマニュアルをご参
照ください。
•	スマートデバイス接続マニュアル Android用
•	スマートデバイス接続マニュアル iPhone/iPad用
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	■ 無線でのMIDIおよびオーディオ通信(Bluetooth)
本製品にはBluetooth機能が搭載されています。以下の操作でスマートデバイスなどの対応機器と無線接続することにより、MIDI
およびオーディオの両方が通信できます。

EAD本体

Bluetooth = オン

長押し

NOTE

Bluetooth に関する詳細設定については、170ページを
ご参照ください。

専用アプリからMIDI通信でEAD本体の設定を編集

スマートデバイス上のオーディオ再生音をEAD本体で鳴らす

EAD本体EAD Touch

EAD本体

オーディオ再生音の音量を調整
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Bluetooth について
Bluetoothとは、2.4 GHz帯の電波を利用して、対応する機器と無線で通信を行うことができる技術です。

	■ Bluetooth 通信の取り扱いについて
	• Bluetooth 対応機器が使用する2.4 GHz帯は、さまざまな機器が共有する周波数帯です。Bluetooth 対応機器は、同じ周波数帯

を使用する機器からの影響を最小限に抑えるための技術を採用していますが、他の機器の影響によって通信速度や通信距離が低
下することや、通信が切断されることがあります。

•	 通信機器間の距離や障害物、電波状況、機器の種類により、通信速度や通信距離は異なります。
•	 本機はすべてのBluetooth機能対応機器とのワイヤレス接続を保証するものではありません。

	■ 製品の取り扱いに関する注意
•	 本製品は、日本国内でのみ使用できます。
•	 本製品は、日本電波法に基づく認証を受けた無線機器を内蔵しています。従って、本製品を使用するときに無線局の免許は不要で

す。ただし、本製品に以下を行うと法律で罰せられることがあります。
	- 本製品を分解/改造する。
	- 本体底面の銘板をはがしたり、消したりする。

無線に関するご注意
本製品の使用周波数帯では、電子レンジなどの産業・科学・医療用機器のほか、工場の製造ライン等で使用されている移動体識
別用の構内無線局(免許を要する無線局)および特定小電力無線局(免許を要しない無線局)並びにアマチュア無線局(免許を要す
る無線局)が運用されています。
1.	 本製品を使用する前に、近くで移動体識別用の構内無線局および特定小電力無線局並びにアマチュア無線局が運用されて
いないことを確認してください。

2.	 万一、本製品から移動体識別用の構内無線局に対して有害な電波干渉の事例が発生した場合には、速やかに使用場所を変
えるか、または機器の運用を停止(電波の発射を停止)してください。
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電源を入れる/切る
電源アダプターの接続を含め、詳細の手順については、クイックガイドをご参照ください。

バージョンを確認する
[MENU] →Version →[ENTER] の操作で、本製品のバージョンを確認できます。
本製品の最新バージョンは、以下のウェブサイトの「ソフトウェア」からダウンロードできます。 
	 https://download.yamaha.com/jp/

常に最新バージョンにアップデートされることを推奨します。
なお、本説明書は、制作時のバージョンに沿って説明しています。

オートパワーオフ(自動電源オフ)
オートパワーオフとは、本製品を一定時間操作しなかった場合、自動的に電源がオフになる機能です。工場出荷時は「15分」に設定さ
れています。

ご注意
•	 本製品の状態によっては、一定時間操作せずにオートパワーオフの設定時間が経過しても電源が切れない場合があります。製品の使用後は、

手動で本体の電源を切ってください。
•	 外部オーディオ機器やPA機器などを本体に接続した状態で、一定時間本体を操作しない場合は、外部オーディオ機器の音量をゼロにしておくこ

とをおすすめします。
•	 オートパワーオフで製品がオフになった場合、レコーダー /ルーパー /サンプリング機能により録音された内部メモリー (26ページ)のデータ

は失われます。大切なデータは、早めに保存しておくことをおすすめします。

NOTE

オートパワーオフで本製品がオフになっても、それまでの設定/編集は消えずに維持されます。次回の電源オン時に続きの設定/編集を行い、必
要に応じて保存してください。

	■ オートパワーオフの設定変更
ライブや録音などの状況によっては初期設定の「15分」は短く感じられるかもしれません。その場合は、以下の画面でオートパワーオ
フするまでの時間を変更します。

[MENU] →Utility →Auto Power Off

	■ オートパワーオフの解除
以下のいずれかの方法で解除します。いずれの方法でも、次回の電源オン時にもオートパワーオフは解除されたままです。
•	 [MENU] →Utility →Auto Power Off = Off に設定する。
•	 電源オフの状態で、[MENU]ボタンを押しながらスタンバイ/オンボタンを押すと、オートパワーオフが解除された状態で本製品が起

動します。
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本体の設定を初期の状態に戻す(ファクトリーリセット)
ファクトリーリセットを実行すれば、本体の設定を誤って書き換えてしまった場合でも、初期の状態に戻すことができます。
以下2通りの方法があります。
•	 [MENU] →Factory Reset →[ENTER] の操作で実行する。
•	電源オフの状態で、[+]ボタンと[−]ボタンを同時押ししながらスタンバイ/オンスイッチを押して本製品を起動する。

ご注意
ファクトリーリセットを行うと、設定したすべてのデータが消え、初期の状態に戻ります。大切なデータは、ファクトリーリセットを行う前にUSBフラッ
シュメモリーまたはSDカードに保存してください。
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画面の基本操作

	■ 画面下部の機能と画面直下の[F]ボタン
画面直下にある3つのボタンは画面下部に表示される機能と連携しており、各ボタンを押すことで該当機能を実行したり関連画面に
移動したりします。これら3つのボタンには名称印字がありませんが、説明の便宜上、[F1]・[F2]・[F3]ボタンと記すことにします。「F」
はFunction の略です。

	■ [F]ボタン群の機能を切り替える[Alt]ボタン
表示中の画面の機能を実行するのに[F1] ～ [F3]ボタンだけでは足りない場合、下図のように[F]ボタンの右横にあるボタンを押すこ
とで、[F]ボタンの機能を切り替えます。この切替用ボタンにも名称印字がないので、説明の便宜上[Alt]ボタンと記すことにします。
また、切り替えた場合の[F]ボタンの名称については、説明の便宜上、以下の通りとします。
•	機能名に該当するボタン名(1番め)：[F1]・[F2]・[F3]
•	機能名に該当するボタン名(2番め)：[F4]・[F5]・[F6]
•	機能名に該当するボタン名(3番め)：[F7]・[F8]・[F9] 
•	 [F]ボタンの番号切替用のボタン名：[Alt]

1番め 2番め

[F1]～[F6]の場合

[F1]～[F9]の場合

1番め 2番め 3番め

[F] (Function)ボタン

機能名

基本操作
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	■ カーソル移動およびページ切替
設定項目が列挙されている画面では、画面下部に[F2] /[F3] が表示されるので、[F2]ボタンと[F3]ボタンでカーソルを移動
させます。機能によっては同一画面の中で設定項目が列挙しきれず、複数ページで構成されることを示すため、画面右端にスクロー
ルバーが表示されます。その場合は[F2] ボタンと [F3] ボタンで、カーソルを移動させながら前後のページを行き来します。

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味で、操作説明のために便宜的につけたボタン名称です。製品本体には印字されていません。

1ページめ最初の設定項目に
カーソルがある場合

2ページめ最初の設定項目に
カーソルがある場合

最後の項目にカーソルがある場合
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入力ソースの選択および基本設定—マイク音
以下に列挙したマイク入力音に関する設定画面では、[F1] MicSel ボタンを押すことにより、1 ～ 5のどの[MIC/LINE]端子を設定
対象とするかの選択が必要です。また、マイクの用途(演奏用かトーク用か)やステレオペアリングなど、基本的な設定も必要です。
•	 [MIC/TRIG] →[F3] Setting →Mic →Mic In, Mic EQ, Mic TransComp, Mic Out
•	 [MIC/TRIG] →[F3] Setting →Effect →Reverb, FX1, FX2 →Send Mic, Send Mic Curve
•	 [MIC/TRIG] →[F3] Setting →Effect →Dry →Level Mic, Level Mic Curve
•	 [MIC/TRIG] →[F3] Setting →Effect →Ins1 Mic, Ins2 Mic

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の
意味で、操作説明のために便宜的につけたボタン
名称です。製品本体には印字されていません。

[MIC/TRIG] →「F3] Setting 
→Mic →Mic Pairing 
=Separate と同等

[MIC/TRIG] →「F3] Setting 
→Mic →Mic Pairing =Paired 
と同等

[MIC/TRIG] →「F3] Setting 
→Mic →Mic Pairing =Paired 
Excep Gain と同等

■ マイクのステレオペアリングを設定/解除

■ マイクを選択する

設定対象=Mic1 設定対象=Mic2 設定対象=Mic3

■ トーク設定のオン/オフ

ここの例であるマイク
3だけでなく、全ての
マイクにつきトーク設
定のオン/オフが個別
にできます。
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入力ソースの選択および基本設定—トリガー信号
トリガー入力に関する設定画面では、[F1] TrigSel ボタンを押すことにより、どのトリガー入力(パッド/インスト/ボイス) を設定対象
とするかの選択が必要です。

	■ パッドに関する設定(本製品のトリガー入力端子に該当する1～10から選択)
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad, Vel Curve, Crossｔalk

	■ インストに関する設定(本製品で扱える全てのトリガー入力から選択)
[MIC/TRIG] →[F3] Setting →Kit →Inst →Inst, Inst EQ, InstTranComp, Inst Out
[MIC/TRIG] →[F3] Setting →Effect →Reverb, FX1, FX2 →Send Trig, Send Trig Curve
[MIC/TRIG] →[F3] Setting →Effect →Real Ambi →Depth Trig, Depth Trig Curve
[MIC/TRIG] →[F3] Setting →Effect →Dry →Level Trig, Level Trig Curve
[MIC/TRIG] →[F3] Setting →Effect →Ins Trig 

1と6、2と7、3と8、4と9、5と10 のペアリングを
する/しないを設定します。

パッドロック：パッドを叩いてもパッド選択が
変わらないようにします。

オーディション：現在選択されているトリガー入力に割り当てられている
インストが鳴ります。音量は以下画面(158ページ)で設定できます。
[MENU] →Utility →Audition Velocity

トリガー入力ソース： ([+][−]ボタン/ノブで選択)

以下の2つをリアルタイムに表示します。
L (棒グラフ)：トリガー入力レベル
V (横線の高さ)：パッドを叩いた強さ(ベロシティー )

NOTE
図におけるF1～F3の「F」は「Function(機能)」
の意味で、操作説明のために便宜的につけたボ
タン名称です。製品本体には印字されていま
せん。

NOTE
[F2]ボタンに割り当てられたパッドロック機能、
[F3]ボタンに割り当てられたオーディション機
能については、「パッドに関する設定」と同様で
す。ただし、HH Trig In=Off の場合にカーソ
ルが「H1」「H2」にある場合、 オーディションは
機能せず、[F3]ボタンに該当する機能表示は
消えます。

本製品に接続したフットスイッチから入力された信号
を元に発生したトリガー信号。以下画面の設定により、
表示が「F1」「F2」または「H1」「H2」になります。
[MIC/TRIG] →[F3] Settings →Trigger.
 →Trig In →Foot Sw1, Foot Sw2 →HH Trig In

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意
味で、操作説明のために便宜的につけたボタン名称
です。製品本体には印字されていません。 

本製品に接続したパッドに
該当するトリガー入力

外部機器からのMIDIによる
トリガー入力
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	■ ボイスに関する設定		
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice, Voice MIDI, Voice Func

NOTE
図におけるF1 ～ F3の「F」は

「Function(機能)」の意味で、
操作説明のために便宜的につけ
たボタン名称です。製品本体に
は印字されていません。

[+][−]ボタン/ノブで
トリガー入力ソースを
順に選択

[F1] Layerボタンで、
各トリガー入力ソース
のレイヤーをA～Dの
中から選択

NOTE
[F2]ボタンに割り当てられたパッドロック機能、[F3]ボタンに割り当てられた
オーディション機能については、「パッドに関する設定」と同様です。ただし、
HH Trig In=Off の場合にカーソルが「H1」「H2」にある場合、 オーディション
は機能せず、[F3]ボタンに該当する機能表示は消えます。
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データに名前をつける
以下画面において、本製品で制作したデータに対して名前をつけることができます。操作方法は全て同じです。

	 画面	 機能
• [SCENE] ほか →[STORE] ......................................................... シーンの名称設定(Name と SubName)
• [RECORDER] (Sampling) →[F6] Save  →[F1] Name ........ USBフラッシュメモリー /SDカードにサンプリングデータを保存するときのファイル名設定
• [RECORDER] (Sampling) →[F9] Save WM →[F1] Name ..... 録音したサンプリングデータをユーザーボイスに割り当てるときの、ユーザーボイス名/ユーザーボイ

スバンク名の設定
• [RECORDER] (Looper) →[F6] Save  →[F1] Name ............ USBフラッシュメモリー /SDカードにルーパーデータを保存するときのファイル名設定
• [LIVE SET] →[STORE] ............................................................. ライブセットの名称設定(Name と SubName)
• [LIVE SET] →[F3] Setting →[F1] Name ................................. ライブセットのステップ名設定
• [MENU] →File →File All →Save →[F1] Name ..................... 本製品で作った全データをUSBフラッシュメモリー /SDカードに保存するときのファイル名設定
• [MENU] →File →File All →Rename →[F1] Name ............... USBフラッシュメモリー /SDカード上にある本製品上で作れる全データファイルの名称変更
• [MENU] →File →File Scene →Save →[F1] Name ............... 本製品で作ったシーンデータをUSBフラッシュメモリー /SDカードに保存するときのファイル名設定
• [MENU] →File →File Scene →Rename →[F1] Name ......... USBフラッシュメモリー /SDカード上にあるシーンデータのファイル名称変更
• [MENU] →File →File Wave → Rename →[F1] Name ......... USBフラッシュメモリー /SDカード上にあるオーディオファイルの名称変更

1.	 名称(最上列)のカーソルを移動する

2.	 必要に応じて大文字/小文字を切り替える

3.	 名称(最上列)のカーソル位置にある文字を変更する

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の
意味で、操作説明のために便宜的につけたボタン
名称です。製品本体には印字されていません。
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データの順序を並び替える
以下画面においてはデータの並べ替えや順序の変更ができます。操作方法は全て同じです。

	 画面	 機能
• [MIC/TRIG] →[F3]Setting →Kit →User Voice →Sort Wave .......本製品に取り込んだ(インポートした)波形データを並び替え
• [SCENE] →[F2] Job →Sort ..............................................................シーンの順序変更
• [LIVE SET] →[F2] Job →Sort ..........................................................ライブセットの順序変更
• [LIVE SET] →[F3] Setting →[F4] Sort ............................................各ライブセット内におけるステップの順序変更

これで、従来の02と03が入れ替わりました。

1.
移動させたい項目にカーソルを
置いた状態で、[ENTER]ボタン
を押します。カーソルを置いた
項目が右にインデントされます。

2.
手順1で選択した項目を、[F2]/
[F3]ボタンを使って移動します。

3.
手順2で移動させたい場所まで
来たら、[ENTER]ボタンを押し
ます。順序の並び替えが確定し
ます。
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Modifierノブ操作
[F1] TrigSelまたはMicSel
[F2] Effect, Type, Inst, ...など
[F3] Setting

	Function
	 	Off
	 	Tempo
	 	Talk On/Off
	 	Mic EQ Color
	 	Mic Tran Comp Depth
	 	Mic Tran Attack
	 	Mic Tran Release
	 	Xstick On/Off
	 	Inst Number
	 	Inst Volume
	 	Inst Pan
	 	Inst Tuning/Size
	 	Inst Attack
	 	Inst Muffling/Sustain/Decay
	 	Inst EQ Color
	 	Inst Tran Comp Depth
	 	Inst Tran Attack
	 	Inst Tran Release
	 	Voice Volume
	 	Effect Depth
	 	Reverb Param A
	 	Reverb Param B
	 	Reverb Param C
	 	FX1 Param A
	 	FX1 Param B
	 	FX1 Param C
	 	FX2 Param A
	 	FX2 Param B
	 	FX2 Param C
	 	Ins1 Mic Depth
	 	Ins1 Mic Param A
	 	Ins1 Mic Param B
	 	Ins1 Mic Param C
	 	Ins2 Mic Depth
	 	Ins2 Mic Param A
	 	Ins2 Mic Param B
	 	Ins2 Mic Param C
	 	Ins Trig Depth
	 	Ins Trig Param A
	 	Ins Trig Param B
	 	Ins Trig Param C

機能ツリー図

[SCENE]
[F1] ModSel
[F2] Job

	Sort
	Clear

[F3] Setting
	Scene Load

	 	 	Mic/Kit Volume
	 	 	Mic
	 	 	Trigger
	 	 	
	 	 	Function
	 	 	Effect
	 	 	Tempo
	 	 	Modifier
	 	 	Fader
	 	 	Click
	 	 	Recorder
	 	 	Utility
	 	 	Output
	 	 	Aux In
	 	 	USB Audio
	 	 	Bluetooth

	Modifier
	 	 	Modifier Pop-up
	 	 	CC Number
	 	 	CC Channel
	 	 	CC Port
	 	 	CC Min Value
	 	 	CC Max Value

	Fader
		  	Fader Pop-up

[STORE]
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[MIC/TRIG]
[F1] Volume

		  	Mic/Kit
		  	Mic
		  	Mic In
		  	Kit
		  	Inst
		  	Voice A
		  	Voice B
		  	Voice C
		  	Voice D

[F3] Setting
	Mic/Kit Vol

	 	 	Volume
	Mic

	 	 	Ｍｉｃ Volume
	 	 	 Volume
	 	 	Ｍｉｃ Pairing
	 	 	 	 Mic1/2
	 	 	 	 Mic3/4
	 	 	Ｍｉｃ In
	 	 	 	 On/Off
	 	 	 	 Phantom
	 	 	 	 Gain
	 	 	 	 Gain Auto Setup
	 	 	 	 Volume
	 	 	 	 Pan
	 	 	 	 Phase
	 	 	 	 Delay
	 	 	 	 Gate
	 	 	 	 Gate Threshold
	 	 	 	 Gate Hold
	 	 	 	 Gate Attack
	 	 	 	 Gate Release
	 	 	 	 Noise Gate
	 	 	 	 Talk
	 	 	Ｍｉｃ EQ
	 	 	 	 On/Off
	 	 	 	 Type
	 	 	 	 Color
	 	 	 	 Low Freq
	 	 	 	 Low Gain
	 	 	 	 Low Q
	 	 	 	 Low Shape
	 	 	 	 MidLow Freq
	 	 	 	 MidLow Gain
	 	 	 	 MidLow Q
	 	 	 	 MidHigh Freq
	 	 	 	 MidHigh Gain
	 	 	 	 MidHigh Q
	 	 	 	 High Freq
	 	 	 	 High Gain
	 	 	 	 High Q
	 	 	 	 High Shape
	 	 	 	 HPF Freq
	 	 	 	 HPF Q

	Mic (つづき)
	 	 	Ｍｉｃ TranComp
	 	 	 	 On/Off
	 	 	 	 Type
	 	 	 	 Depth
	 	 	 	 Tran Attack
	 	 	 	 Tran Release
	 	 	 	 Tran Sensitivity
	 	 	 	 Comp Threshold
	 	 	 	 Comp Ratio
	 	 	 	 Comp Attack
	 	 	 	 Comp Release
	 	 	 	 Comp Out Level
	 	 	Ｍｉｃ Out
	 		 	 EQ Tran Thru
	 		 	 Effect Thru
	 		 	 Main Out
	 		 	 Phones Out
	 		 	 USB Audio Out 1/2
	 		 	 IndivOut
	 		 	 IndivOut Vol

	Trigger
	 	 	Trig Pairing
	 	 	 	 Kick/Trig6
	 	 	 	 Snare/Trig7
	 	 	 	 Trig3/Trig8
	 	 	 	 Trig4/Trig9
	 	 	 	 Trig5/Trig10
	 	 	Trig In
	 		 	 Pad
	 		 	 	 Category
	 		 	 	 Type
	 		 	 	 Gain
	 		 	 	 Rim Gain
	 		 	 	 H/R Balance
	 		 	 	 Gain Auto Setup
	 		 	 	 Wait Time
	 		 	 	 Reject Time
	 		 	 	 Sensitivity
	 		 	 	 Min Level
	 		 	 	 Max Level
	 		 	 	 Min Velocity
	 		 	 	 Max Velocity
	 		 	 	 Xstick On/Off
	 		 	 	 Xstick Adjust
	 		 	 	 Position
	 		 	 	 Attenuator
	 		 	 Vel Curve
	 		 	 	 Curve
	 		 	 	 X1, Y1, X2, Y2
	 		 	 Crosstalk
	 		 	 	 Auto Setup
	 		 	 	 Reject Level
	 		 	 Foot Sw1
	 		 	 	 Type
	 		 	 	 HH Trig In
	 		 	 	 HH Pitch Up
	 		 	 	 HH Clutch Pos
	 		 	 	 Foot Close Pos
	 		 	 	 Foot Close Vel
	 		 	 	 Foot Splash Sens
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機能ツリー図

	Kit (つづき)
	 	 	 	 InstTranComp
	 	 	 	 	 On/Off
	 	 	 	 	 Type
	 	 	 	 	 Depth
	 	 	 	 	 Tran Attack
	 	 	 	 	 Tran Release
	 	 	 	 	 Tran Sensitivity
	 	 	 	 	 Comp Threshold
	 	 	 	 	 Comp Ratio
	 	 	 	 	 Comp Attack
	 	 	 	 	 Comp Release
	 	 	 	 	 Comp Out Level
	 	 	 	 Inst Out
	 	 		 	 EQ Tran Thru
	 	 		 	 Effect Thru
	 	 		 	 Main Out
	 	 		 	 Phones Out
	 	 		 	 USB Audio Out 1/2
	 	 		 	 IndivOut
	 	 		 	 IndivOut Vol
	 	 	Voice
	 	 	 	 Voice
	 	 	 	 	 Category
	 	 	 	 	 Number
	 	 	 	 	 Volume
	 	 	 	 	 Pan
	 	 	 	 	 Tuning
	 	 	 	 	 Attack
	 	 	 	 	 Decay
	 	 	 	 	 Cutoff
	 	 	 	 	 Resonance
	 	 	 	 	 Mono/Poly
	 	 	 	 	 Choke Send
	 	 	 	 	 Choke Receive
	 	 	 	 	 Humanize
	 	 	 	 	 Fixed Velocity
	 	 	 	 	 Hold Mode
	 	 	 	 	 Layer Mode
	 	 	 	 	 Velocity Limit Low
	 	 	 	 	 Velocity Limit High
	 	 	 	 	 Velocity Fade Low
	 	 	 	 	 Velocity Fade High
	 	 	 	 Voice MIDI
	 	 	 	 	 Note Num 1～ 4
	 	 	 	 	 Note Ch 1 ～ 4
	 	 	 	 	 Note Port
	 	 	 	 	 Note Gate Time
	 	 	 	 	 CC Number Note
	 	 	 	 	 CC Number Position
	 	 	 	 	 CC Channel
	 	 	 	 	 CC Port
	 	 	 	 	 CC Min Value
	 	 	 	 	 CC Max Value

	Trigger (つづき)
	 		 	 Foot Sw2
	 			  	 Type
	 			  	 HH Trig In
	 			  	 HH Pitch Up
	 			  	 HH Clutch Pos
	 			  	 Foot Close Pos
	 			  	 Foot Close Vel
	 			  	 Foot Splash Sens

	Kit
	 	 	Kit Volume
	 	 	 	 Volume
	 	 	Inst
	 	 	 	 Inst
	 	 	 	 	 On/Off
	 	 	 	 	 Category
	 	 	 	 	 Number
	 	 	 	 	 Import Wave
	 	 	 	 	 Volume
	 	 	 	 	 Pan
	 	 	 	 	 Phase
	 	 	 	 	 Delay
	 	 	 	 	 Tuning
	 	 	 	 	 Size
	 	 	 	 	 Attack
	 	 	 	 	 Muffling
	 	 	 	 	 Sustain
	 	 	 	 	 Decay
	 	 	 	 	 Gate
	 	 	 	 	 Gate Threshold
	 	 	 	 	 Gate Hold
	 	 	 	 	 Gate Attack
	 	 	 	 	 Gate Release
	 	 	 	 Inst EQ
	 	 	 	 	 On/Off
	 	 	 	 	 Type
	 	 	 	 	 Color
	 	 	 	 	 Low Freq
	 	 	 	 	 Low Gain
	 	 	 	 	 Low Q
	 	 	 	 	 Low Shape
	 	 	 	 	 MidLow Freq
	 	 	 	 	 MidLow Gain
	 	 	 	 	 MidLow Q
	 	 	 	 	 MidHigh Freq
	 	 	 	 	 MidHigh Gain
	 	 	 	 	 MidHigh Q
	 	 	 	 	 High Freq
	 	 	 	 	 High Gain
	 	 	 	 	 High Q
	 	 	 	 	 High Shape
	 	 	 	 	 HPF Freq
	 	 	 	 	 HPF Q
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機能ツリー図

	Kit (つづき)
	 	 	 	 Voice Func
	 	 		 	 Off
	 	 		 	 Scene Select
	 	 		 	 	Scene Number
	 	 		 	 Scene Inc
	 	 		 	 Scene Dec
	 	 		 	 Scene Toggle
	 	 		 	 	Scene Number A
	 	 		 	 	Scene Number B
	 	 		 	 Tempo Inc
	 	 		 	 	Value
	 	 		 	 Tempo Dec
	 	 		 	 	Value
	 	 		 	 Tempo Tap
	 	 		 	 Tempo Control
	 	 		 	 	Control Type
	 	 		 	 	Min Value
	 	 		 	 	Max Value
	 	 		 	 Modifier Control
	 	 		 	 	Control Type
	 	 		 	 	Min Value
	 	 		 	 	Max Value
	 	 		 	 	Modifier1 ～ 6
	 	 		 	 Mic/Trig Control
	 	 		 	 	Control Type
	 	 		 	 	Reverb ～Master EQ
	 	 		 	 	Mic1 ～Mic5
	 	 		 	 	Kick ～ Trig22
	 	 		 	 Talk Control
	 	 		 	 	Control Type
	 	 		 	 	Mic Input
	 	 		 	 Xstick Control
	 	 		 	 	Control Type
	 	 		 	 	Kick, Snare, Trig3 ～ 5
	 	 		 	 Sound Off
	 	 		 	 Click Start/Stop
	 	 		 	 Recorder Control A
	 	 		 	 Recorder Control B
	 	 		 	 Live Set Select
	 	 		 	 	Live Set Number
	 	 		 	 Live Set Inc
	 	 		 	 Live Set Dec
	 	 		 	 Live Set Step Select
	 	 		 	 	Live Set Step Number
	 	 		 	 Live Set Step Inc
	 	 		 	 Live Set Step Dec
	 	 	User Voice
	 		 	 Import Wave
	 		 	 	 File to Bank
	 		 	 	 Files to Voices
	 		 	 	 Files by Name
	 		 	 Edit Velocity Limit L/H
	 		 	 Sort Wave
	 		 	 Delete Wave
	 		 	 WaveMem Info

	Effect
		  	Reverb
		  	 	 On/Off
		  	 	 Category
		  	 	 Type
		  	 	 Send All
		  	 	 Send Mic
		  	 	 Send Mic Curve
		  	 	 Send Trig
		  	 	 Send Trig Curve
		  	 	 Return
		  	 	 IndivOut
		  	 	 Return IndivOut 
		  	Real Ambi
		  	 	 On/Off
		  	 	 Depth All
		  	 	 Depth Trig
		  	 	 Depth Trig Curve
		  	FX1, FX2
		  	 	 On/Off
		  	 	 Category
		  	 	 Type
		  	 	 Send All
		  	 	 Send Mic
		  	 	 Send Mic Curve
		  	 	 Send Tirg
		  	 	 Send Tirg Curve
		  	 	 Send to Reverb
		  	 	 Return
		  	 	 IndivOut
		  	 	 Return IndivOut
		  	Dry
		  	 	 On/Off
		  	 	 Level All
		  	 	 Level Mic
		  	 	 Level Mic Curve
		  	 	 Level Trig
		  	 	 Level Trig Curve
		  	Ins1 Mic, Ins2 Mic
		  	 	 On/Off
		  	 	 Category
		  	 	 Type
		  	 	 Depth
		  	Ins Trig
		  	 	 On/Off
		  	 	 Category
		  	 	 Type
		  	 	 Depth
		  	Master FX
		  	 	 On/Off
		  	 	 Category
		  	 	 Type
		  	 	 Depth
		  	 	 Depth Curve
		  	Master Comp
		  	 	 On/Off
		  	 	 Category
		  	 	 Type
		  	 	 Depth
		  	 	 Depth Curve
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機能ツリー図

	Effect (つづき)
		  	Master EQ
		  	 	 On/Off
		  	 	 Low Freq
		  	 	 Low Gain
		  	 	 Low Q
		  	 	 Low Shape
		  	 	 MidLow Freq
		  	 	 MidLow Gain
		  	 	 MidLow Q
		  	 	 Mid Freq
		  	 	 Mid Gain
		  	 	 Mid Q
		  	 	 MidHigh Freq
		  	 	 MidHigh Gain
		  	 	 MidHigh Q
		  	 	 High Freq
		  	 	 High Gain
		  	 	 High Q
		  	 	 High Shape
		  	Effect Out
			   	 Main Out
			   	 Phones Out
			   	 USB Audio Out1/2

[CLICK]
[+] [−] ボタンおよびノブ
[F4] [F6] −0.1 +0.1
[F1] Tap
[F2] [F5]  
[F3] Setting

	Click
	 	 	Volume
	 	 	Voice Set
	 	 	Beat
	 	 	Human Voice
	 	 	Human Volume
	 	 	Timer
	 	 	Count Off
	 	 	Recorder Sync
	 	 	Pre Count
	 	 	Offset Time
	 	 	Category
	 	 	Number
	 	 	Import Wave
	 	 	Note Volume
	 	 	Note Pan
	 	 	Note Tuning

	Click EQ
	 	 	On/Off
	 	 	Low Freq
	 	 	Low Gain
	 	 	Low Q
	 	 	Low Shape
	 	 	MidLow Freq
	 	 	MidLow Gain
	 	 	MidLow Q
	 	 	MidHigh Freq
	 	 	MidHigh Gain
	 	 	MidHigh Q
	 	 	High Freq
	 	 	High Gain
	 	 	High Q
	 	 	High Shape
	 	 	HPF Freq
	 	 	HPF Q

	Click Out
		  	Main Out
		  	Phones Out
		  	USB Audio Out1/2
		  	IndivOut
		  	IndivOut Vol
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[RECORDER]-Recorder
[F1]  / [F1] 
[F9] Save 
[+] [−] File Select
[F2]  [F2] 
[F4] 
[F5] /[F5]
[F6] 
[F7] PlaySel
[F8] MemSel
[F3] Setting

	Recorder
	 	 	Volume
	 	 	Repeat
	 	 	Speed

	Recorder Rec
	 	 	Rec Gain
	 	 	Rec Click
	 	 	Rec Aux In
	 	 	Rec USB Audio In1/2
	 	 	Rec USB Audio In3/4
	 	 	Rec USB Audio In5/6
	 	 	Rec USB Audio In7/8
	 	 	Rec Recorder Play
	 	 	Rec Bluetooth

	Recorder EQ
	 	 	On/Off
	 	 	Low Freq
	 	 	Low Gain
	 	 	Low Q
	 	 	Low Shape
	 	 	MidLow Freq
	 	 	MidLow Gain
	 	 	MidLow Q
	 	 	MidHigh Freq
	 	 	MidHigh Gain
	 	 	MidHigh Q
	 	 	High Freq
	 	 	High Gain
	 	 	High Q
	 	 	High Shape
	 	 	HPF Freq
	 	 	HPF Q

	Recorder Out
		  	Mode
		  	Main Out
		  	Phones Out
		  	USB Audio Out 1/2
		  	Backing Out Level
		  	Indiv Out
		  	IndivOut Vol

[RECORDER]-Looper
[F1]  / [F1]  
[F2]  / [F2] Clear
[F3] Undo / [F3] Redo
[F6] Save 
[F3] Setting

	Looper Vol
	 	 	Volume

	Looper Rec
	 	 	Rec Gain
	 	 	Rec Mode
	 	 	Rec Beat Length
	 	 	Rec Click
	 	 	Rec Aux In
	 	 	Rec USB Audio In 1/2
	 	 	Rec USB Audio In 3/4
	 	 	Rec USB Audio In 5/6
	 	 	Rec USB Audio In 7/8
	 	 	Rec Bluetooth

	Looper EQ
	 	 	On/Off
	 	 	Low Freq
	 	 	Low Gain
	 	 	Low Q
	 	 	Low Shape
	 	 	MidLow Freq
	 	 	MidLow Gain
	 	 	MidLow Q
	 	 	MidHigh Freq
	 	 	MidHigh Gain
	 	 	MidHigh Q
	 	 	High Freq
	 	 	High Gain
	 	 	High Q
	 	 	High Shape
	 	 	HPF Freq
	 	 	HPF Q

	Looper Out
		  	Main Out
		  	Phones Out
		  	USB Audio Out 1/2
		  	IndivOut
		  	IndivOut Vol
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[RECORDER]-Sampling
[F1]  / [F1] 
[F2] Edit

	[F1] Play / [F1] Stop
		  	Start Point
		  	Loop Point
		  	End Point
		  	Normalize
		  	Reverse

[F3] Setting
	Sampling Vol

	 	 	Volume
	Sampling Rec

		  	Rec Gain
		  	Rec Click
		  	Rec Aux In
		  	Rec USB Audio In1/2
		  	Rec USB Audio In3/4
		  	Rec USB Audio In5/6
		  	Rec USB Audio In7/8
		  	Rec Bluetooth

[F4] Load 
[F6] Save 
[F7] LoadWM
[F9] SaveWM

[LIVE SET]
[−] [+] Live Set
[F1] Live Set Start
[F2] Job

	Sort
	Clear

[F3] Setting

[MENU]

Utility
	 	Auto Power Off
	 	Pop-up Time
	 	LCD Contrast
	 	Audition Velocity
	 	MIDI Local Control
	 	MIDI Global Channel
	 	MIDI Global Port
	 	MIDI PC Tx
	 	MIDI PC Rx
	 	MIDI Clock Tx
	 	MIDI Clock Rx
	 	MIDI Start/Stop Tx
	 	MIDI Start/Stop Rx
	 	USB MIDI Thru MIDI
Output

	 	Output Gain
	 	 	Main Out
	 	 	Phones Out
	 	 	IndivOut1/2
	 	 	IndivOut3/4
	 	 	IndivOut5/6
	 	 	IndivOut7/8
	 	Phones EQ
		  	On/Off
		  	Type
		  	Low Freq
		  	Low Gain
		  	Low Q
		  	Low Shape
		  	MidLow Freq
		  	MidLow Gain
		  	MidLow Q
		  	MidHigh Freq
		  	MidHigh Gain
		  	MidHigh Q
		  	High Freq
		  	High Gain
		  	High Q
		  	High Shape
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Aux In
	 	Aux In Vol
	 	 	Volume
	 	Aux In EQ
	 	 	On/Off
	 	 	Low Freq
	 	 	Low Gain
	 	 	Low Q
	 	 	Low Shape
	 	 	MidLow Freq
	 	 	MidLow Gain
	 	 	MidLow Q
	 	 	MidHigh Freq
	 	 	MidHigh Gain
	 	 	MidHigh Q
	 	 	High Freq
	 	 	High Gain
	 	 	High Q
	 	 	High Shape
	 	 	HPF Freq
	 	 	HPF Q
	 	Aux In Out
		  	Mode
		  	Main Out
		  	Phones Out
		  	USB Audio Out1/2
		  	Backing Out Level
		  	IndivOut
		  	IndivOut Vol 
USB Audio

	 	USB Audio
	 	 	Mode
	 	 	In Volume
	 	 	Out Gain
	 	USB Audio EQ
	 	 	On/Off
	 	 	Low Freq
	 	 	Low Gain
	 	 	Low Q
	 	 	Low Shape
	 	 	MidLow Freq
	 	 	MidLow Gain
	 	 	MidLow Q
	 	 	MidHigh Freq
	 	 	MidHigh Gain
	 	 	MidHigh Q
	 	 	High Freq
	 	 	High Gain
	 	 	High Q
	 	 	High Shape
	 	 	HPF Freq
	 	 	HPF Q
	 	USB AudioOut
		  	Mode
		  	Main Out
		  	Phones Out
		  	USB Audio Out1/2
		  	Backing Out Level
		  	IndivOut

		  	IndivOut Vol 
Bluetooth

	 	Bluetooth
	 	 	On/Off
	 	 	Volume
	 	 	Pairing
	 	Bluetooth EQ
	 	 	On/Off
	 	 	Low Freq
	 	 	Low Gain
	 	 	Low Q
	 	 	Low Shape
	 	 	MidLow Freq
	 	 	MidLow Gain
	 	 	MidLow Q
	 	 	MidHigh Freq
	 	 	MidHigh Gain
	 	 	MidHigh Q
	 	 	High Freq
	 	 	High Gain
	 	 	High Q
	 	 	High Shape
	 	 	HPF Freq
	 	 	HPF Q
	 	Bluetooth Out
		  	Mode
		  	Main Out
		  	Phones Out
		  	USB Audio Out1/2
		  	Backing Out Level
		  	IndivOut 
		  	IndivOut Vol 
File

	 	File All
	 	File Scene
	 	File Wave
	 	ExtMem Info
Factory Reset
Version
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Modifierノブ操作
本製品パネル左部にあるModifierノブを操作することで、演奏しながら様々な音色変化や機能切替などができます。ノブの周囲に
は9つのLEDが配置されており、点灯状況を見ることで値の大小を直感的に認識できます。また、調整中のパラメーターの設定範囲
によって以下2種類の点灯方式となります。

	■ 設定範囲が「0～+XXX」のパラメーターを調整している場合
ノブを左に回し切ったときに最小値(全てのLEDが消灯)、ノブを右に回し切ったときに最大値(全てのLEDが点灯)となります。

	■ 設定範囲が「−XXX～0～+XXX」のパラメーターを調整している場合
設定値がマイナス値のときは右半分のLEDは消灯し、左半分のLEDだけで増減を表示します。
設定値が「0」のときは中央上にあるLEDだけが点灯します。
設定値がプラス値のときは左半分のLEDは消灯し、右半分のLEDだけで増減を表示します。

NOTE
各LEDは、数値の大小により2段階の明るさで点灯します。

パネル左部にあるModofierノブを操作するか、シーン画面での[F1] ModSel ボタンを押すと、該当ノブ(最後に操作していたノブ)
が調整できる設定項目に応じたポップアップウィンドウが表示されます。また、画面下部の[F2]と[F3]に該当する表示も、これらのパ
ラメーターに関連する機能に切り替わります。

F1 F2 F3

F1 F2 F3 F1 F2 F3 F1 F2 F3F1 F2 F3

F1 F2 F3 F1 F2 F3 F1 F2 F3F1 F2 F3

NOTE
•	 図におけるF1 ～ F3の「F」は「Function(機能)」の意味で、操作説明のために便宜的につけたボタン名称です。

製品本体には印字されていません。
•	 以下画面において「Off」に設定した場合は、ノブ操作をしてもポップアップウィンドウは表示されません。

[SCENE] →Modifier →Modifier Pop-up

最小値 最大値

マイナス値 設定値「0」 プラス値

画面での設定項目(パラメーター )
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[F1] TrigSel または MicSel
該当するノブの機能がマイク関連であれば対象マイクを選択する画面が、該当するノブの機能がトリガー関連であれば対象トリガー
を選択する画面が、それぞれ表示されます。

[F2] Effect, Type, Inst, …など
該当するノブの機能に関連した設定画面が表示されます。

[F3] Setting

[F3] Setting→Function
現在選択されているModifierノブに割り当てる機能を選択します。

パラメーター 説明 設定 初期値
Off 現在選択されているノブを機能しない状態にします。 — —
Tempo テンポ変更の機能(130ページ)を割り当てます。 — —
Talk On/Off マイク端子をトーク用として使う(オン)/演奏用として使う(オフ) 

を切り替える機能(89ページ)を割り当てます。これが選択さ
れると、該当ノブを右に回すとトークオン、左に回すとトークオフ
になります。

「Mic Lock」を「Off」に設定すると、[F1] MicSel ボタンで選択
したマイクに対して本機能が適用されます。「Off」以外(Mic1-5)
を選択時は、選択したマイクに対して本機能が適用されます。
NOTE
[F1] MicSel ボタンで呼び出される画面上で、Mic Lock=Off 時に
ノブのコントロール対象となるマイク端子を変更できます。

Mic Lock=Off, 
Mic1 ～ 5

シーン(Modifier)での設
定値

Mic EQ Color マイク音のMic EQ Color の数値を編集する機能(89ページ)
を割り当てます。ノブを右に回すと数値が増えて音が明るくなり、
左に回すと数値が減って音が暗くなります。

「Mic Lock」を「Off」に設定すると、[F1] MicSel ボタンで選択
したマイクに対して本機能が適用されます。「Off」以外(Mic1-5)
を選択時は、選択したマイクに対して本機能が適用されます。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] MicSel ボタンで呼び出される画面上で、Mic Lock=Off 時

にノブのコントロール対象となるマイク端子を変更できます。
•	 [F2] Type ボタンにて、[MIC/TRIG] →[F3] Setting →Mic EQ 

→Type にジャンプします。

Mic Lock=Off, 
Mic1 ～ 5
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パラメーター 説明 設定 初期値
Mic Tran Comp 
Depth

「Mic Transient Compressor Depth」の略です。
マイク音のトランジェントエフェクト(アタック感やリリース感)とコ
ンプレッサーの深さをコントロールする機能(91ページ)を割
り当てます。両エフェクトは同時にコントロールされます。ノブ
を右に回すと深くなり、左に回すと浅くなります。

「Mic Lock」を「Off」に設定すると、[F1] MicSel ボタンで選択
したマイクに対して本機能が適用されます。「Off」以外(Mic1-5)
を選択時は、選択したマイクに対して本機能が適用されます。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] MicSel ボタンで呼び出される画面上で、Mic Lock=Off 時

にノブのコントロール対象となるマイク端子を変更できます。
•	 [F2] Type ボタンにて、[MIC/TRIG] →[F3] Setting →Mic 

TransComp →Type にジャンプします。

Mic Lock=Off, 
Mic1 ～ 5

シーン(Modifier)での設
定値

Mic Tran Attack「Mic Transient Attack」の略です。
マイク音のトランジェントエフェクトのアタックの強さをコント
ロールする機能(91ページ)を割り当てます。ノブを右に回す
と強くなり、左に回すと弱くなります。

「Mic Lock」を「Off」に設定すると、[F1] MicSel ボタンで選択
したマイクに対して本機能が適用されます。「Off」以外(Mic1-5)
を選択時は、選択したマイクに対して本機能が適用されます。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] MicSel ボタンで呼び出される画面上で、Mic Lock=Off 時

にノブのコントロール対象となるマイク端子を変更できます。
•	 [F2] Sens ボタンにて、[MIC/TRIG] →[F3] Setting →Mic 

TransComp →Tran Sensitivity にジャンプします。

Mic Lock=Off, 
Mic1 ～ 5

Mic Tran 
Release

「Mic Transient Release」の略です。
マイク音のトランジェントエフェクトのリリース感をコントロール
する機能(91ページ)を割り当てます。ノブを右に回すと余韻
が多くなり、左に回すと余韻が少なくなります。

「Mic Lock」を「Off」に設定すると、[F1] MicSel ボタンで選択
したマイクに対して本機能が適用されます。「Off」以外(Mic1-5)
を選択時は、選択したマイクに対して本機能が適用されます。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] MicSel ボタンで呼び出される画面上で、Mic Lock=Off 時

にノブのコントロール対象となるマイク端子を変更できます。
•	 [F2] Sens ボタンで、[MIC/TRIG] →[F3] Setting →Mic 

TransComp →Tran Sensitivity にジャンプします。

Mic Lock=Off, 
Mic1 ～ 5
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パラメーター 説明 設定 初期値
Xstick On/Off 特定のトリガー入力に対するクロススティック設定のオン/オフ機

能(96ページ)を割り当てます。マルチピエゾパッドを接続し
たトリガー入力に対してのみ、オンが有効です。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Adjust ボタンで、[MIC/TRIG] →[F3] Setting →Trigger 

→Trig In →Pad →Xstick Adjust にジャンプします。

NOTE
選択されているトリガー入力が Kick、Snare、Trig3 ～ 5の場合のみ
有効な設定項目です。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22

シーン(Modifier)での設
定値

Inst Number 現在選択されているトリガー入力のインストを選択する機能
(102ページ)を割り当てます。現在選択されているカテゴリー
内のインストを選択できます。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Inst ボタンで、[MIC/TRIG] →[F3] Setting →Kit →Inst 

→Inst →Category にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22

Inst Volume 現在選択されているトリガー入力のインストの音量を調節する機
能(103ページ)を割り当てます。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Inst ボタンで、[MIC/TRIG] →[F3] Setting →Kit →Inst 

→Inst →Category にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22
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パラメーター 説明 設定 初期値
Inst Pan 現在選択されているトリガー入力のインストのステレオ定位を調節す

る機能(103ページ)を割り当てます。
「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Inst ボタンで、[MIC/TRIG] →[F3] Setting →Kit →Inst 

→Inst →Category にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22

シーン(Modifier)での設
定値

Inst Tuning/Size 現在選択されているトリガー入力のインストのチューニングまた
はサイズ(シンバルの場合など)を設定する機能(103ページ)を
割り当てます。どの機能になるかはインストによります。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Inst ボタンで、[MIC/TRIG] →[F3] Setting →Kit →Inst 

→Inst →Category にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22

Inst Attack 現在選択されているトリガー入力のインストのアタック感を設定す
る機能(103ページ)を割り当てます。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Inst ボタンで、[MIC/TRIG] →[F3] Setting →Kit →Inst 

→Inst →Category にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22
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パラメーター 説明 設定 初期値
Inst Muffling/
Sustain/Decay

現在選択されているトリガー入力のインストのマフリングまたは
サステインまたはディケイを調節する機能(103ページ)を割り
当てます。どの機能になるかはインストによります。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Inst ボタンで、[MIC/TRIG] →[F3] Setting →Kit →Inst 

→Inst →Category にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22

シーン(Modifier)での設
定値

Inst EQ Color 現在選択されているトリガー入力のインストのEQカラー (音の明
るさ)を調節する機能(104ページ)を割り当てます。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] InstEQ ボタンで、[MIC/TRIG] →[F3] Setting →Kit 

→Inst →Inst EQ →Typeにジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22

Inst Tran Comp 
Depth

「Inst Transient Compressor Depth」の略です。
現在選択されているトリガー入力のインストのトランジェントコン
プレッサーのかかり具合を調節する機能(105ページ)を割り当
てます。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Typeボタンで、[MIC/TRIG] →[F3] Setting →Kit →Inst 

→Inst →InstTranComp →Type にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22
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パラメーター 説明 設定 初期値
Inst Tran Attack「Inst Transient Attack」の略です。

現在選択されているトリガー入力のインストのトランジェントエ
フェクトのアタック感を調節する機能(105ページ)を割り当てま
す。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Sensボタンで、[MIC/TRIG] →[F3] Setting →Kit →Inst 

→ InstTransComp →TranSensitivity にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22

シーン(Modifier)での設
定値

Inst Tran 
Release

「Inst Transient Release」の略です。
現在選択されているトリガー入力のインストのトランジェントエ
フェクトのリリース感を調節する機能(105ページ)を割り当て
ます。

「Trigger Lock」を「Off」に設定すると、[F1] TrigSel ボタンで
選択したトリガー入力に対して本機能が適用されます。「Off」以外
を選択時は、選択したトリガー入力に対して本機能が適用されま
す。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Sensボタンで、[MIC/TRIG] →[F3] Setting →Kit →Inst 

→InstTransComp →TranSensitivity にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22

Voice Volume 現在選択されているトリガー入力のインストを構成するボイスの
音量を調節する機能(108ページ)を割り当てます。画面下部に
て、ボイスを構成するレイヤー別に音量調節の対象にする(チェッ
クマークあり)/しない(チェックマークなし)を設定します。

NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、ノブのコントロール対象となるトリガー入

力を変更できます。
•	 [F2] Voice ボタンで、[MIC/TRIG] →[F3] Setting →Kit 

→Voice →Voice →Category にジャンプします。

各項目に対して、
・チェックマーク有
・チェックマーク無
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パラメーター 説明 設定 初期値
Effect Depth エフェクトの深さを調節する機能を割り当てます。画面下半分

にて、エフェクトを構成する以下のブロック別に調節の対象にす
る(チェックマークあり)/しない(チェックマークなし)を設定できま
す。
•	Reverb Send All (120ページ)
•	Real Ambi Depth All (121ページ)
•	FX1 Send All (121ページ)
•	FX2 Send All (122ページ)
•	Dry Level All (122ページ)
•	Master FX Depth (124ページ)
•	Master Comp Depth (125ページ)
NOTE
ポップアップウィンドウ表示中は、[F2] Effect ボタンで[MIC/TRIG] 
→[F3] Setting →Effect にジャンプします。

— シーン(Modifier)での設
定値

Reverb Param A 現在選択されているリバーブタイプのパラメーター A、B、Cの
値を調整します。パラメーター A、B、Cについては、データリス
トの「エフェクトタイプリスト」をご参照ください。

NOTE
ポップアップウィンドウ表示中は、[F2] Type ボタンで[MIC/TRIG] 
→[F3] Setting →Effect →Reverb →Type にジャンプします。

— —
Reverb Param B
Reverb Param C

FX1 Param A 現在選択されているFX1タイプのパラメーター A、B、Cの値を
調整します。パラメーター A、B、Cについては、データリストの「エ
フェクトタイプリスト」をご参照ください。
NOTE
ポップアップウィンドウ表示中は、[F2] Type ボタンで[MIC/TRIG] 
→[F3] Setting →Effect →FX1 →Type にジャンプします。

— —
FX1 Param B
FX1 Param C

FX2 Param A 現在選択されているFX2タイプのパラメーター A、B、Cの値を
調整します。パラメーター A、B、Cについては、データリストの「エ
フェクトタイプリスト」をご参照ください。
NOTE
ポップアップウィンドウ表示中は、[F2] Type ボタンで[MIC/TRIG] 
→[F3] Setting →Effect →FX2 →Type にジャンプします。

— —
FX2 Param B
FX2 Param C
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パラメーター 説明 設定 初期値
Ins1 Mic Depth 現在選択されているマイク音用インサーションエフェクト1の深さ

を調整する機能(123ページ)を割り当てます。
「Mic Lock」を「Off」に設定すると、[F1] MicSel ボタンで選択し
たマイクに対して本機能が適用されます。「Off」以外(Mic1-5)を
選択時は、選択したマイクに対して本機能が適用されます。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] MicSel ボタンで呼び出される画面上で、Mic Lock=Off 時

にノブのコントロール対象となるマイク端子を変更できます。
•	 [F2] Type ボタンで、[MIC/TRIG] →[F3] Setting →Effect 

→Ins1 Mic →Type にジャンプします。

Mic Lock=Off, 
Mic1 ～ 5

シーン(Modifier)での設
定値

Ins1 Mic Param A 現在選択されているマイク音用インサーションエフェクト1タイプ
のパラメーター A、B、Cの値を調整する機能(123ページ)を
割り当てます。パラメーター A、B、Cについては、データリスト
の「エフェクトタイプリスト」をご参照ください。

「Mic Lock」を「Off」に設定すると、[F1] MicSel ボタンで選択し
たマイクに対して本機能が適用されます。「Off」以外(Mic1-5)を
選択時は、選択したマイクに対して本機能が適用されます。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] MicSel ボタンで呼び出される画面上で、Mic Lock=Off 時

にノブのコントロール対象となるマイク端子を変更できます。
•	 [F2] Type ボタンで、[MIC/TRIG] →[F3] Setting →Effect 

→Ins1 Mic →Type にジャンプします。

Mic Lock=Off, 
Mic1 ～ 5Ins1 Mic Param B

Ins1 Mic Param C

Ins2 Mic Depth 現在選択されているマイク音用インサーションエフェクト2タイプ
の深さを調整する機能(123ページ)を割り当てます。

「Mic Lock」を「Off」に設定すると、[F1] MicSel ボタンで選択し
たマイクに対して本機能が適用されます。「Off」以外(Mic1-5)を
選択時は、選択したマイクに対して本機能が適用されます。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] MicSel ボタンで呼び出される画面上で、Mic Lock=Off 時

にノブのコントロール対象となるマイク端子を変更できます。
•	 [F2] Type ボタンで、[MIC/TRIG] →[F3] Setting →Effect 

→Ins2 Mic →Type にジャンプします。

Mic Lock=Off, 
Mic1 ～ 5
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パラメーター 説明 設定 初期値
Ins2 Mic Param A 現在選択されているマイク音用インサーションエフェクト2タイプ

のパラメーター A、B、Cの値を調整する機能(123ページ)を
割り当てます。パラメーター A、B、Cについては、データリスト
の「エフェクトタイプリスト」をご参照ください。

「Mic Lock」を「Off」に設定すると、[F1] MicSel ボタンで選択し
たマイクに対して本機能が適用されます。「Off」以外(Mic1-5)を
選択時は、選択したマイクに対して本機能が適用されます。
NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] MicSel ボタンで呼び出される画面上で、Mic Lock=Off 時

にノブのコントロール対象となるマイク端子を変更できます。
•	 [F2] Type ボタンで、[MIC/TRIG] →[F3] Setting →Effect 

→Ins2 Mic →Type にジャンプします。

Mic Lock=Off, 
Mic1 ～ 5

シーン(Modifier)での設
定値Ins2 Mic Param B

Ins2 Mic Param C

Ins Trig Depth 現在選択されているトリガー音用インサーションエフェクトタイプ
の深さを調整する機能(124ページ)を割り当てます。

「Trigger Lock」を「Off」に設定すると、現在選択中のトリガー入力
に対して本機能が適用されます。「Off」以外を選択時は、選択した
トリガー入力に対して本機能が適用されます。

NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Typeボタンで、[MIC/TRIG] →[F3] Setting →Effect 

→Ins Trig →Type にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22 (18 ～
22は効果なし)

Ins Trig Param A 現在選択されているトリガー音用インサーションエフェクトタイプ
のパラメーター A、B、Cの値を調整する機能(124ページ)を割
り当てます。パラメーター A、B、Cについては、データリストの「エ
フェクトタイプリスト」をご参照ください。

「Trigger Lock」を「Off」に設定すると、現在選択中のトリガー入力
に対して本機能が適用されます。「Off」以外を選択時は、選択した
トリガー入力に対して本機能が適用されます。

NOTE
ポップアップウィンドウ表示中は、以下2点ができます。
•	 [F1] TrigSel ボタンで、Trigger Lock=Off 時にノブのコントロー

ル対象となるトリガー入力を変更できます。
•	 [F2] Typeボタンで、[MIC/TRIG] →[F3] Setting →Effect 

→Ins Trig →Type にジャンプします。

Trigger Lock=Off, 
Kick, Snare, .
Trig3 ～ 10, .
Foot1 ～ 2, .
Trig11～ 22 (18 ～
22は効果なし)

Ins Trig Param B
Ins Trig Param C
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LEDロータリーフェーダー操作 
本製品パネルの中央下部にある5つのLEDロータリーフェーダーを操作することで、演奏しながら様々なサウンドコントロールができ
ます。フェーダーの横にはLEDが配置されており、その点灯位置を見ることで値の大小が直感的に認識できます。

NOTE
各LEDは、数値の大小により2段階の明るさで点灯します。

	■ マイク入力音をコントロールしたい場合
[MIC]ボタン点灯中は、パネル中央下部にある5つのフェーダー操作により、マイク入力端子からの入力音をコントロールします。 
マイクペアリング画面で1と2がペアリングされている場合は、1と2のどちらのフェーダーを操作しても両者の設定値は連動します。
3と4がペアリングされている場合も同様です。また、フェーダーを操作すると、ポップアップウィンドウが表示され、コントロール項目
と現状数値を確認できます。

ノブを回すことにより、
該当ランプの点灯が切
り替わります。

このノブで、コントロール対象
の機能を選択します。

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味で、操作説明のために
便宜的につけたボタン名称です。製品本体には印字されていません。

NOTE
以下画面において「Off」に設定した場合は、ノブ操作をしてもポップアップ
ウィンドウは表示されません。
[SCENE]→[F3] Setting →Fader→Fader Pop-up

●	チャンネルオン/オフ
ボタン

マイク音をそれぞれオン(点
灯)/オフ(消灯)します。
マイクペアリング画面*にお
いて、1と2がペアリングさ
れている場合は1と2のボタ
ンどちらを押してもオン/オ
フが連動します。3と4がペ
アリングされている場合も
同様です。

* マイクペアリング画面
[MIC/TRIG] →[F3] Setting 
→Mic →Mic Pairing

●チャンネルインジケーター
マイクのペアリング状態を表示するランプとして機能します。
マイクペアリング画面* において、1と2がペアリングされている場合は1と2
が濃いレッドに点灯、3と4がペアリングされている場合は3と4が薄いレッドに
点灯します。なお、5は常に消灯(実際にはわずかに点灯)しています。

●ピークインジケーター
[MIC]ボタンが点灯の場合は、ピークインジケーターとしても動作
します。マイク入力音がピークに達したときに該当するチャンネ
ルのランプが赤く点滅します。ドラム演奏時は、ドラムセット全体
を叩いて時々点滅する状態が最適です。

機能カテゴリー 機能
各フェーダーに対応する[MIC/LINE INPUT]端子

縦LED
画面下部のボタン

1 2 3 4 5 F1 F2 F3
MIXER Gain Mic1 Mic2 Mic3 Mic4 Mic5 - MicIn MicPair -

Volume Mic1 Mic2 Mic3 Mic4 Mic5 - MicIn MicPair -
PAN Pan Mic1 Mic2 Mic3 Mic4 Mic5 Center 0 MicIn MicPair -
EQ EQ Color Mic1 Mic2 Mic3 Mic4 Mic5 Center 0 Type - -
COMP Tran Comp Depth Mic1 Mic2 Mic3 Mic4 Mic5 - Type - -
EFFECT Reverb Send Mic1 Mic2 Mic3 Mic4 Mic5 - Type - -

FX1 Send Mic1 Mic2 Mic3 Mic4 Mic5 - Type - -
FX2 Send Mic1 Mic2 Mic3 Mic4 Mic5 - Type - -
Dry Level Mic1 Mic2 Mic3 Mic4 Mic5 - Dry - -
Ins1 Depth Mic1 Mic2 Mic3 Mic4 Mic5 - Type - -
Ins2 Depth Mic1 Mic2 Mic3 Mic4 Mic5 - Type - -
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	■ トリガー音をコントロールしたい場合
[TRIG]ランプ点灯中は、パネル中央下部にある5つのフェーダー操作により、トリガー入力端子からの入力音をコントロールします。
フェーダーを操作すると、ポップアップウィンドウが表示され、コントロール項目と現状数値を確認できます。

ノブを回すことにより、
該当ランプの点灯が切
り替わります。

このノブで、コントロール対象
の機能を選択します。

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味で、操作説明のために
便宜的につけたボタン名称です。製品本体には印字されていません。

●チャンネルオン/オフ
ボタン
フェーダーが扱うトリガー
音をそれぞれオン(点灯)/
オフ(消灯) します。

●チャンネルインジケーター
各フェーダーが扱うトリガー信号のペアリング状態(1と6、2と7、3と8、4と9、5と10)
を表示します。Separate の場合は暗めのブルー、Pairingの場合は1～ 5にかけて
明るいブルー～イエロー系のカラーバリエーションで点灯します。

機能﻿
カテゴリー 機能

各フェーダーに対応するトリガー入力
[TRIG]ボタンを押すことにより相互切替 縦LED

画面下部のボタン

1 2 3 4 5 6 7 8 9 10 F1 F2 F3
MIXER Volume Kick Snare Trig3 Trig4 Trig5 Trig6 Trig7 Trig8 Trig9 Trig10 - Inst - -
PAN Pan Kick Snare Trig3 Trig4 Trig5 Trig6 Trig7 Trig8 Trig9 Trig10 Center 0 Inst - -
EQ EQ Color Kick Snare Trig3 Trig4 Trig5 Trig6 Trig7 Trig8 Trig9 Trig10 Center 0 Type - -
COMP Tran Comp 

Depth Kick Snare Trig3 Trig4 Trig5 Trig6 Trig7 Trig8 Trig9 Trig10 - Type - -

EFFECT Reverb Real 
Ambi Send Kick Snare Trig3 Trig4 Trig5 Trig6 Trig7 Trig8 Trig9 Trig10 - Type - -

FX1 Send Kick Snare Trig3 Trig4 Trig5 Trig6 Trig7 Trig8 Trig9 Trig10 - Type - -
FX2 Send Kick Snare Trig3 Trig4 Trig5 Trig6 Trig7 Trig8 Trig9 Trig10 - Type - -
Dry Level Kick Snare Trig3 Trig4 Trig5 Trig6 Trig7 Trig8 Trig9 Trig10 - Dry - -
Ins Depth Kick Snare Trig3 Trig4 Trig5 Trig6 Trig7 Trig8 Trig9 Trig10 - Type - -

点灯中に押すことで、5つのフェーダーで扱うトリガー入力信号が
Kick・Snare・Tri3 ～ Trig5とTrig6～ Trig10とで相互に切り替わり
ます。
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	■ その他の場合
[CUSTOM]ランプ点灯中([OTHERS]ランプ点灯中)は、パネル下部にある5つのフェーダー操作により、EQやクリックなどをコント
ロールします。フェーダーを操作すると、ポップアップウィンドウが表示され、現在コントロール中の項目と現状数値を確認できます。

ノブを回すことにより、コン
トロール対象の機能は切り
替わりますが、ランプは常に
「OTHERS」が点灯します。

このノブで、コントロール対象の機能
を選択します。

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味で、操作説明のために便宜的につけたボタン名称です。
製品本体には印字されていません。

常に消灯です。

常に明るいブルーで
点灯します。ただし、
機能割当が無い場合
は消灯(実際はわずか
に点灯)します。

機能カテゴリー 機能
各フェーダーに対応する設定項目(パラメーター )

縦LED
画面下部のボタン

1 2 3 4 5 F1 F2 F3
OTHERS Master EQ Gain Low MidLow Mid MidHigh High Center 0 EQ - -

Phones EQ Gain Low MidLow --- MidHigh High Center 0 EQ - -
Playback1 EQ Gain Low MidLow --- MidHigh High Center 0 EQ* - -
Playback2 EQ Gain Low MidLow --- MidHigh High Center 0 EQ** - -
Looper EQ Gain Low MidLow --- MidHigh High Center 0 EQ*** - -
Aux In EQ Gain Low MidLow --- MidHigh High Center 0 EQ - -
USB Aud In1/2 EQ Gain Low MidLow --- MidHigh High Center 0 EQ - -
USB Aud In3/4 EQ Gain Low MidLow --- MidHigh High Center 0 EQ - -
USB Aud In5/6 EQ Gain Low MidLow --- MidHigh High Center 0 EQ - -
USB Aud In7/8 EQ Gain Low MidLow --- MidHigh High Center 0 EQ - -
Bluetooth EQ Gain Low MidLow --- MidHigh High Center 0 EQ

Click EQ Gain Low MidLow --- MidHigh High Center 0 EQ - -
Click Volume Accent 4th (Dotted4th) 8th 16th 8thTriplet - Click - -

*	 現在のモードにかかわらず、レコーダー画面で
の最後の状態がレコーダー (Recorder)かつ 
[F7] PlaySel=1の場合にのみ表示

**	 現在のモードにかかわらず、レコーダー画面で
の最後の状態がレコーダー (Recorder)かつ 
[F7] PlaySel=2の場合にのみ表示

***	 現在のモードにかかわらず、レコーダー画面で
の最後の状態がルーパー (Looper)の場合にの
み表示
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[SCENE] 
本製品では「シーン(SCENE)」を選択することで、マイク/トリガー音/エフェクトの設定などを含む様々な設定を、ワンタッチで呼び出
し、演奏します。この画面において、本製品に搭載された70個のプリセットシーンを、[+][−]ボタンまたはノブで選びます。また、オ
リジナルのユーザーシーンを200個まで作成できます。

NOTE
「シーン」は、様々な設定項目で構成されています。詳細は50ページをご参照ください。

	■ シーンを切り替える
[+][−]ボタンまたはノブを使う方法以外に、フットスイッチや電子ドラムのパッドを叩くことでシーンを切り替える方法もあります。 
以下画面にて設定してください。

[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice Func

	■ いろいろなシーンを使って演奏する
本製品には、いろいろな演奏ユースケースを想定した豊富なプリセットシーンが搭載されています。79ページの「プリセットシーン
リスト」でご確認ください。

	■ 自分だけのシーン(ユーザーシーン)を作る
[F1]ボタンから呼び出される画面上で Modifierノブに関する設定を行ったり、他モードでの様々な設定を変更したりしたあと、それ
らの設定を自分だけのシーン(ユーザーシーン)として保存することができます。保存の操作方法は78ページをご参照ください。

ご注意
パラメーターを調節後、保存(ストア)しないでシーンを切り替えると、調節した内容は失われます。調節したパラメーターをユーザーシーンとして
保存するには、[STORE]ボタンを押して[ENTER]ボタンで確定します。詳しくはユーザーガイドをご覧ください。

F1 F2 F3

シーン番号
P***：	 プリセットシーン（あらかじめ搭載されているシーン）
U***：	 ユーザーシーン（自分で作ったシーン）

シーン名
サブネーム*

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味で、
操作説明のために便宜的につけたボタン名称です。製品
本体には印字されていません。

*	 プリセットシーンの中にはサブネームがないものがあります。
そのような場合でも、ユーザシーンにストア(保存)するときに、
サブネームをつけることができます。
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[F1] ModSel
「Modifier Select」の略です。詳細は「Modifierノブ操作」をご参照ください。

[F2] Job

[F2] Job →Sort (ソート)
自分が作ったオリジナルのユーザーシーンの順番を変更します。

ENTERENTER

1.	 [F2][F3]ボタンで、順番を移動
させたいシーンの番号にカーソ
ルを置きます。

3.	 右にずれたシーン表示を、.
[F2][F3]ボタンで移動します。

2.	 [ENTER]ボタンを押すと、順番を移動さ
せたいシーンの表示が右にずれます。

4.	 シーンの移動先が決まったら、.
[ENTER]ボタンを押します。

実行中のメッセージが表示されたあと、
ユーザーシーンの新しい順番が確定し
ます。

[F2] Job →Clear (クリア)
自分が作ったオリジナルのユーザーシーンを個別に初期化します。

ENTER

1.	 [+][−]ボタンまたはノブで、
消去したいユーザーシーン
を選択します。

3.	 [F1]ボタンを押して
クリアを実行します。

2.	 [ENTER]ボタンを押すと、.
確認メッセージが表示されます。

実行中のメッセージが表示されたあと、
ユーザーシーンの初期化が完了します。



EAD50　ユーザーガイド 75

画面での設定項目(パラメーター)

M
od

ifi
er

 
ノ

ブ
[ M

IC
 / 

TR
IG

 ]
[ S

CE
NE

 ]
[ C

LIC
K 

]
[ R

EC
O

RD
ER

 ]
[ L

IV
E S

ET
 ]

[ M
EN

U 
]

M
ic

Tr
ig

ge
r

Ki
t

Ef
fe

ct
Re

co
rd

er
Lo

op
er

Sa
m

pl
in

g
Ut

ilit
y

O
ut

pu
t

Au
x 

In
US

B 
Au

dio
Bl

ue
to

ot
h

Fi
le

Ve
rs

io
n

LE
D 

ロ
ー

タ
リ

ー
フ

ェ
ー

ダ
ー

Fa
ct

or
y 

Re
se

t

[F3] Setting
シーン使用時に関連した設定を行います。

[F3] Setting →Scene Load
シーン選択時に呼び出される設定パラメーターは、50ページにあるとおり、様々なカテゴリーから構成されています。これら各カ
テゴリーにつき、シーン選択時に設定値を呼び出す(On)/呼び出さない(Off)を、個別に選択できます。

Page 1/4

パラメーター 説明 設定 初期値
Mic/Kit Volume [MIC/TRIG] →[F3] Setting →Mic/Kit Volの設定値が対象です。 Off, On On
Mic [MIC/TRIG] →[F3] Setting →Micで表示される全項目の設定

が対象です。リアパネルの[MIC/LINE INPUT]端子から入力さ
れるオーディオ(アコースティックドラムの演奏打音など)に関する
全設定です。

Off, On On

Trigger [MIC/TRIG] →[F3] Setting →Triggerで表示される全項目
の設定が対象です。リアパネルの[TRIGGER INPUT]端子や
[FOOT SW]端子からから入力されるトリガー信号に関する全設
定です。

Off, On On

Kit [MIC/TRIG] →[F3] Setting →Kit で表示されるほぼ全項目の
設定が対象です。[MIC/TRIG] →[F3] Setting →Kit →Voice 
→Voice Funcや[MIC/TRIG] →[F3] Setting →Kit →User 
Voiceは対象外です。トリガー信号を元に鳴る電子音(ドラムキッ
トを構成するインスト)に関する全設定です。

Off, On On

Function [MIC/TRIG] →[F3] Setting →Kit →Voice →Voice Funcで
表示される全項目の設定が対象です。パッドを叩いたときに、発
音とは別に様々な機能を割り当てる設定です。

Off, On On

Page 2/4

パラメーター 説明 設定 初期値
Effect [MIC/TRIG] →[F3] Setting →Effectで表示される全項目の設

定が対象です。入力されたオーディオ音やトリガー信号を元に発
音する電子音(ドラムキットを構成するインスト)にかけるエフェク
トに関する全設定です。

Off, On On

Tempo クリック再生時や一部のエフェクトタイプのテンポ値が対象です。 Off, On On
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パラメーター 説明 設定 初期値
Modifier パネル左上部にある6つのModifierノブに関する全設定です。

具体的には以下画面で表示される全項目です。
•	[SCENE] →[F3] Setting →Modifier
•	Modifierノブ操作によるポップアップウィンドウ表示中 →[F3] 
Setting

Off, On On

Fader パネル中央下部にある、5つのLEDロータリーフェーダーの操作
に関する全設定が対象です。
具体的には以下の事項が対象です。
•	[CUSTOM]、[MIC]、[TRIG]の選択状態およびフェーダー
機能の選択状態

•	[SCENE] →[F3] Setting →Faderの設定
なお、各フェーダーによる設定値は対象外です。

Off, On On

Page 3/4

パラメーター 説明 設定 初期値
Click [CLICK] →[F3] Setting で表示される全項目の設定が対象です。Off, On Off
Recorder [RECORDER] →[F3] Setting (Recorder/Looper/Sampling)

で表示される全項目の設定が対象です。
Off, On Off

Utility [MENU] →Utility で表示される全項目の設定が対象です。 Off, On Off
Output [MENU] →Output で表示される全項目の設定が対象です。 Off, On Off
Aux In [MENU] →Aux In で表示される全項目の設定が対象です。 Off, On Off

Page 4/4

パラメーター 説明 設定 初期値
USB Audio [MENU] →USB Audio で表示される全項目の設定が対象です。 Off, On Off
Bluetooth [MENU] →Bluetooth で表示される全項目の設定が対象です。

Bluetooth経由で入力されるオーディオに関する設定です。
Off, On Off
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[F3] Setting →Modifier
主に、Modifierノブ操作により出力されるMIDIメッセージに関する設定です。

Page 1/2

パラメーター 説明 設定 初期値
Modifier Pop-up 全てのModifierノブにつき、操作時にポップアップウィンドウを表示

するかどうかを設定します。
Off, On プリセットシーン

(Modifier)では一律
「On」

Page 2/2

パラメーター 説明 設定 初期値
CC Number 各Modifierノブの操作時に発生するMIDIメッセージのコントロー

ルチェンジ番号を割り当てます。[F1] ModSel でノブを選択して
から設定します。

Off, 0 ～ 127 プリセットシーン
(Modifier)では、ノブ
1～ 6の順に一律「18」、
「19」、「80」、「81」、
「82」、「83」

CC Channel 各Modifierノブの操作時に発生するMIDIメッセージをどのMIDI
チャンネルで送信するかを割り当てます。[F1] ModSel でノブを
選択してから設定します。
NOTE

「Global」を設定した場合は、[MENU] →Utility →MIDI Global 
Channel で設定した値がチャンネルとなります。

Global, 1 ～ 16 プリセットシーン
(Modifier)では一律
「Global」

CC Port 各Modifierノブの操作時に発生するMIDIメッセージをどのMIDI
ポートで送信するかを割り当てます。[F1] ModSel でノブを選択
してから設定します。

NOTE
•	「Global」を設定した場合は、[MENU] →Utility →MIDI Global 

Port で設定した値がポートとなります。
•	「2」を選択した場合、または「Global」を選択した場合でMIDI 

Global Port=2の場合は、ノブ操作によるMIDIメッセージは[MIDI 
OUT]端子から送信されません。

Global, 1, 2 プリセットシーン
(Modifier)では一律
「Global」

CC Min Value 各Modifierノブの操作時に発生するMIDIメッセージのデータ最小
値を設定します。ここで設定した値未満の値がノブ操作により発生
することはありません。[F1] ModSel でノブを選択してから設定
します。

0～ 127 プリセットシーン
(Modifier)では一律「0」

CC Max Value 各Modifierノブの操作時に発生するMIDIメッセージのデータ最大
値を設定します。ここで設定した値より大きい値がノブ操作により
発生することはありません。[F1] ModSel でノブを選択してから
設定します。

0～ 127 プリセットシーン
(Modifier)では一律
「127」

[F3] Setting →Fader

パラメーター 説明 設定 初期値
Fader Pop-up 全てのLEDロータリーフェーダーにつき、操作時にポップアップウィ

ンドウを表示するかどうかを設定します。
Off, On プリセットシーン(Fader)

では一律「On」
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[STORE]
[LIVE SET]モード以外であれば、画面表示の状態にかかわらず、[STORE]ボタンを押すことで現在の全設定をユーザーシーンとし
て保存できます。

[STORE]ボタン [ENTER]ボタン

保存先となるユーザーシーン番号
を選択します。

[ENTER]
ボタン

[ENTER]
ボタン

[F1].
ボタン

[F2].
ボタン

ユーザーシーンに
名前をつけます。

ユーザーシーンに.
サブネームをつけます。
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プリセットシーンリスト

No. シーン名称 サブネーム 解説 セッティ
ング**

Foot SW2 
Type

1 Venue ライブハウスやイベントスペースなどの広い空間で演奏
しているような響きを楽しめるシーンです。

A FC7

2 Hardcore Techno Heavy Distorted Kick 複数のボイスをレイヤーし、ディストーションをかけたパ
ンチのあるキックが特徴的なシーンです。

*1 A FC7

3 Analog Delay Mods 2/4/5 for Delay アナログディレイのエフェクトがかかったシーンです。
Modifier 2、4、5によってディレイ音をコントロールで
きます。

A FC7

4 Pitch Change Pitch Change - Mod 2 ピッチチェンジのエフェクトがかかったシーンです。
Modifier 2を回すことでピッチが大胆に変化します。

A FC7

5 Good And Bad Classic 1970s Rock 1970年代のクラシックロックを再現したシーンです。リ
バーブを効かせたビッグロック・サウンドが特徴的です。

*1 A HH40

6 Neo Flanger AmbienceFlanger - Mod 2 アンビエンスフランジャーのエフェクトがかかったシーン
です。高音域の変化が特徴的です。

*1 A FC7

7 Memories Retro Sound レトロな質感のサチュレーターやコンプレッサーがかかっ
たシーンです。古いレコーディングの雰囲気や懐かしさ
を想起させます。

*1 *2 A FC7

8 Crisp Reverb Modifiers 5/6 for EQ +/- 幅広いジャンルに対応できるシーンです。Modifier 5で
リバーブ（Modifier 1にアサインされている）のEQを調
整でき、Modifier 6でマイクのEQを調整できます。

A HH40

9 Old School Clap Timing - Mod 6 太いキックとクラップをトリガー音色として使用したシー
ンです。Modifier 6を回すことで、クラップの発音タイ
ミングをコントロールできます。

*1 A FC7

10 Funk Rock Sn.Trg - Metallic Crack シャープでハイピッチなスネアドラムのトリガー音色が割
り当てられたシーンです。ファンクロックの演奏に適して
います。

A FC7

11 Hard Drum'n'Bass Extra Pad - More Sounds 歪んだキック、スネアをトリガー音色として使用したシー
ンです。ハードなドラムンベースの演奏に適しています。
Trig3、4、5、Foot1を使用することで、さらにジャンル
に特化したサウンドを演奏することができます。

*1 A FC7

12 Basic EQ Comp Scene Starter ベーシックなEQとコンプレッサーがかかったシーンです。
マイク入力の音の粒がそろい、迫力が増します。このシー
ンはユーザーシーンを作る際の基礎として最適です。

*2 A FC7

13 Bright Gate Mods 2/5 for GatedReverb 明るいゲートエフェクトサウンドが特徴的なシーンです。
ドラムキットに鋭さと力強さを与えます。Modifier 2で
ゲートリバーブの量を調整し、Modifier 5でリバーブの
種類を変更できます。

A HH40

**	「セッティング」の欄にあるA ～ Fについては、
30 ～ 33ページをご参照ください。

(*1)	 ステージ演奏時など、モニタースピーカーの近くで本機をお使いの場合、ハウリング音が出やすいのでご注意ください。(増幅度の高いマイク
エフェクトや複数のマイクを使用しているため)

(*2)	 密閉度の高いヘッドフォンを使ったときや、録音した自分の演奏を再生したときに、マイクエフェクトやトリガー音色の効果がより分かりやすく聞
こえるシーンです。
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No. シーン名称 サブネーム 解説 セッティ
ング**

Foot SW2 
Type

14 Very Heavy Limit No Dynamics 強力なリミッターがかかったシーンです。音のダイナミ
クスが抑えられ、全体の音量が均一に感じられます。ま
た、シンバルの響きがとても長く残ります。

*1 A HH40

15 Electro Pop Snare Trigger - eSnare トリガー音色としてエレクトロニックサウンドが割り当て
られたシーンです。ポップかつエレクトロな演奏に適し
ています。

A FC7

16 Session  ミュートの効いたトリガー音色を割り当てたシーンです。
汎用性が高く、様々な場面で使用できます。

*2 A FC7

17 R&B Extra Pad - More Sounds シンプルなサイン波のキックやスナップサウンドをトリ
ガー音色として使用したシーンです。R&Bの演奏に適し
ています。

A FC7

18 Lo-Fi Chill Extra Pad - More Sounds ローファイなビットクラッシュとリバーブが特徴的なシー
ンです。リラックスした雰囲気のチルミュージック風の演
奏に適しています。Trig3、4、5、Foot1を使用するこ
とで、さらにチルミュージック向きのサウンドを演奏でき
ます。

*2 A FC7

19 Dubstep Extra Pad - More Sounds 重いキックとブライトなスネアをトリガー音色として使用
したシーンです。ダブステップの演奏に適しています。
Trig3、4、5、Foot1を使用することで、よりエレクトロニッ
クなサウンドを演奏できます。

A FC7

20 BigKik Room Classic 1970s Rock 1970年代のロックキットを再現したシーンです。パン
チの効いたバスドラムと広がりのあるルームアコース
ティックが特徴的です。

*1 A HH40

21 Bit Pop Bit Crush - Modifier 6 矩形波やホワイトノイズをトリガー音色として使用した
シーンです。8bitコンピュータのようなビットクラッシュ
感が特徴です。Modifier 6でマイクに効果するビットク
ラッシュの強さをコントロールできます。

A FC7

22 V-Shaped EQ Comp Scene Starter 高音域と低音域を強調した「ドンシャリ」サウンドが特徴
的なシーンです。コンプレッサーによりマイク入力の音
の粒が揃い、迫力が増します。このシーンはユーザー
シーンを作る際の基礎として最適です。

A FC7

23 Lo-Fi EQ Comp Scene Starter ローファイなEQ、コンプレッサーがかかったシーンです。
コンプレッサーによりマイク入力の音の粒が揃い、迫力
が増します。このシーンはユーザーシーンを作る際の基
礎として最適です。

*2 A FC7

24 EAD10 EQ Comp Scene Starter EAD10に搭載されていたコンプレッサーエフェクトを再
調整したシーンです。特徴的なあのサウンドがよみがえ
ります。このシーンはユーザーシーンを作る際の基礎と
して最適です。

*1 A FC7

(*1)	 ステージ演奏時など、モニタースピーカーの近くで本機をお使いの場合、ハウリング音が出やすいのでご注意ください。(増幅度の高いマイク
エフェクトや複数のマイクを使用しているため)

(*2)	 密閉度の高いヘッドフォンを使ったときや、録音した自分の演奏を再生したときに、マイクエフェクトやトリガー音色の効果がより分かりやすく聞
こえるシーンです。
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No. シーン名称 サブネーム 解説 セッティ
ング**

Foot SW2 
Type

25 Limiter Scene Starter リミッターのエフェクトがかかったシーンです。独特の
荒々しさによって音にパンチが出ます。このシーンは
ユーザーシーンを作る際の基礎として最適です。

A FC7

26 Pitch Drop Bigger drums and cymbals ドラムやシンバルのピッチが下降することで、重厚感と迫
力を感じられるシーンです。ドラムサウンドがより低く、
大きく響き、パワフルな印象を与えます。

*1 A HH40

27 Hall Reverb Mods 1/4/5 for Reverb 大きな空間を感じさせるリバーブがかかったシーンで
す。ホールで演奏しているような響きが楽しめます。
Modifier 1、4、5によってリバーブ音をコントロールで
きます。

A FC7

28 Dark Gate Transient Gating - Mod 2 高いスレッショルド値のゲートエフェクトがかかったシー
ンです。発した音がすぐにゲートによって遮断されるこ
とで、独創的な音の変化を楽しめます。

A FC7

29 Dance Pop Extra Pad - More Sounds アタック感のあるキックとクラップをトリガー音色として
使用したシーンです。ダンサブルでポップな演奏に適し
ています。Trig3、4、5、Foot1を使用することで、よ
りエレクトロニックなサウンドを演奏できます。

A FC7

30 Rock  乾いた重めのトリガー音色がキックとスネアドラムに割り
当てられたシーンです。ロックの演奏に適しています。

*1 A FC7

31 Crunch Drum Kit Distortion クランチ系のディストーションのエフェクトがかかった
シーンです。歪んだ攻撃的なサウンドが得られます。

*1 A FC7

32 Dub Mods 2/4/5 for Delay ディレイとフェーザーのエフェクトがかかったシーンで
す。Modifier 4を回すと、ディレイタイムが変化します。
外部パッドを取り付けることで、パーカッションの音を鳴
らすことができます。

*1 A FC7

33 Funk Pop Snare Trigger - Clap ルーズなクラップをトリガー音色として使用したシーンで
す。ファンクかつポップな演奏に適します。

A FC7

34 Mountain Swirl Classic 1970s Rock 1970年代のロックキットを再現したシーンです。クラシッ
クなビッグドラムサウンドに軽いフェーザーがかかってい
ます。

*1 A HH40

35 Shimmer Reverb Mods 1/4/5/6 for Reverb シマーリバーブがかかったシーンです。幻想的な響きに
よる個性的なサウンドを楽しめます。Modifier 1、4、5、
6によってリバーブ音をコントロールできます。

A FC7

36 Hard Rock  ルーズなキックと硬いスネアをトリガー音色として使用し
たシーンです。ハードロックの演奏に適しています。

A FC7

37 Crush Wave Folder - Mod 2 ユニークなディストーションが特徴的なシーンです。外
部パッドを取り付けることで、よりエフェクティブなサウン
ドを追加することができます。

*1 A FC7

(*1)	 ステージ演奏時など、モニタースピーカーの近くで本機をお使いの場合、ハウリング音が出やすいのでご注意ください。(増幅度の高いマイク
エフェクトや複数のマイクを使用しているため)

(*2)	 密閉度の高いヘッドフォンを使ったときや、録音した自分の演奏を再生したときに、マイクエフェクトやトリガー音色の効果がより分かりやすく聞
こえるシーンです。



EAD50　ユーザーガイド 82

画面での設定項目(パラメーター)
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No. シーン名称 サブネーム 解説 セッティ
ング**

Foot SW2 
Type

38 Very Heavy Comp No Dynamics 強いコンプレッションがかけられたシーンです。音のダ
イナミクスが抑えられ、すべての音が押しつぶされたよう
に均一な音量で鳴ります。シンバルは叩いた瞬間に“う
ねる”ような効果が生まれ、通常よりも大きく響きます。

*1 A HH40

39 8th Delay Click Tempo - Modifier 6 キット全体にクリーンな質感のモダンなディレイをかけた
シーンです。ディレイはクリックに8分音符で同期してお
り、Modifier 6でクリックとディレイのスピードを調整で
きます。

*1 A HH40

40 Dot8 Delay Click Tempo - Modifier 6 キット全体にクリーンな質感のモダンなディレイをかけた
シーンです。ディレイはクリックに付点8分音符（16分音
符3つ分）で同期しており、Modifier 6でクリックとディ
レイのスピードを調整できます。

A HH40

41 8T Delay Click Tempo - Modifier 6 キット全体にクリーンな質感のモダンなディレイをかけた
シーンです。ディレイはクリックに8分音符の3連符で同
期しており、Modifier 6でクリックとディレイのスピード
を調整できます。

*1 A HH40

42 Amb Distortion Trigger Distortion 歪ませたアンビエンス波形をトリガー音色として使用し
たシーンです。マイク入力には歪みエフェクトがかかっ
ていないため、ハウリングの影響を抑えることができま
す。Modifier 5でキック、スネアトリガーそれぞれの歪
みをコントロールできます。

A FC7

43 Hi/Lo PitchDelay Variation- Modifiers 5/6 ピッチに独特な変化を加えるシーンです。低音域の楽器
のピッチが段階的に上がり、高音域の楽器のピッチが段
階的に下がるように設定されています。

A FC7

44 Amp Simulator Drum Kit Distortion ギターアンプ風のディストーションがかかったシーンで
す。歪んだローファイサウンドが得られます。

*1 A FC7

45 Pop Rock Clap - Snare Trigger パワフルなキックとクラップをトリガー音色として使用し
たシーンです。幅広いジャンルの演奏に適しています。

A FC7

46 Timbale Break Extra Pad - More Sounds ナチュラルなアコースティックドラムのサウンドをベー
スに、外部パッドにティンバレスとカウベルを割り当てた
シーンです。

A HH40

47 Electro Rock Extra Pad - More Sounds 攻撃的なキック、スネアドラムをトリガー音色として使用
したシーンです。Trig3、4、5、Foot1を使用すること
で、よりエレクトロニックなサウンドを演奏できます。

*1 A FC7

48 Hiphop Clap Timing - Modifier 6 太いキックとクラップをトリガー音色として使用したシー
ンです。Modifier 6を回すことで、クラップの発音タイ
ミングをコントロールできます。

*1 A FC7

49 DigiBell Harmonics and delay モジュレーションと倍音を加えることで、ドラムをデジタ
ルベルのような音色に変化させるシーンです。

A HH40

(*1)	 ステージ演奏時など、モニタースピーカーの近くで本機をお使いの場合、ハウリング音が出やすいのでご注意ください。(増幅度の高いマイク
エフェクトや複数のマイクを使用しているため)

(*2)	 密閉度の高いヘッドフォンを使ったときや、録音した自分の演奏を再生したときに、マイクエフェクトやトリガー音色の効果がより分かりやすく聞
こえるシーンです。
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No. シーン名称 サブネーム 解説 セッティ
ング**

Foot SW2 
Type

50 Composite Kick Blend Modifiers 4/5/6 Modifier 4、5、6に割り当てられたサンプルを組み合
わせることで、あらゆるキャラクターのバスドラムサウン
ドを作り出せるシーンです。Modifier 4はアタック感の
強い短い電子クリック音、Modifier 5は芯のあるアコー
スティックな低音、Modifier 6は重厚なエレクトロニッ
クキックを担当し、それぞれのバランスを調整すること
で、幅広いシチュエーションに対応するバスドラムサウン
ドを構築できます。

*2 A HH40

51 BigKik Reflectn Classic 1970s Rock 1970年代のクラシックなロックサウンドを再現したシー
ンです。パンチの効いたバスドラムとアーリーリフレク
ションによるリバーブが特徴的です。

*1 A HH40

52 BigKik Phaser Classic 1970s Rock 1970年代のクラシックなロックサウンドを再現したシー
ンです。パンチの効いたバスドラムとフェーザーエフェク
トが特徴的です。

A HH40

53 EDM Extra Pad - More Sounds アタック感が強調されたキックとエレクトロスネアをト
リガー音色として使用したシーンです。Trig3、4、5、
Foot1を使用することで、よりエレクトロニックなサウン
ドを演奏できます。

A FC7

54 Funk  ルーズなキックと硬いスネアをトリガー音色として使用し
たシーンです。オールドスクール・ファンクの演奏に適し
ています。

*2 A FC7

55 Big Beat Extra Pad - More Sounds 歪んだ硬質なキック、スネアをトリガー音色として使用し
たシーンです。Trig3、4、5、Foot1を使用することで、
よりエレクトロニックなサウンドを演奏できます。

A FC7

56 Breakdown Extra Pad - More Sounds 歪んだアコースティックドラムのサウンドをベースに、
外部パッドに小さな電子パーカッションを組み合わせた
シーンです。

*1 A HH40

57 Metal For Triggers On Drums 鋭いアタックを持つ重厚なトリガー音色を割り当てた
シーンです。Modifier 6によってトリガー音色のEQを
調整し、クリッキーさを際立たせることができます。

B FC7

58 RotoRoom For Triggers On Drums ロータリーチューニングされたタムを思わせる音色が特
徴的なシーンです。鋭いアタックを持つ重厚なトリガー
サウンドが割り当てられています。

B HH40

59 Buzz Air For Triggers On Drums ルームマイクのような空気感とスネアバズのようなノイ
ズを組み合わせた、特徴的な質感のシーンです。

B FC7

60 VintageRoom For Triggers On Drums このシーンを使えば、アコースティックドラムキット全体に
ヴィンテージドラムサウンドを簡単に加えることができま
す。

*2 B HH40

61 Rock+GatedFX For Triggers On Drums このシーンを使えば、アコースティックドラム全体に
ロック向けのサウンドを簡単に加えることができます。
Modifier 2、4によってゲートエフェクトを調整できます。

B HH40

(*1)	 ステージ演奏時など、モニタースピーカーの近くで本機をお使いの場合、ハウリング音が出やすいのでご注意ください。(増幅度の高いマイク
エフェクトや複数のマイクを使用しているため)

(*2)	 密閉度の高いヘッドフォンを使ったときや、録音した自分の演奏を再生したときに、マイクエフェクトやトリガー音色の効果がより分かりやすく聞
こえるシーンです。
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画面での設定項目(パラメーター)
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No. シーン名称 サブネーム 解説 セッティ
ング**

Foot SW2 
Type

62 AnalogueRoom For Triggers On Drums このシーンを使えば、アコースティックドラム全体にアナ
ログシンセ風のドラムサウンドを簡単に加えることがで
きます。

B HH40

63 Gate Reverb For Triggers On Drums 短めのゲートリバーブのエフェクトがかかったシーンです。 B FC7

64 Drum&BassUK For Triggers On Drums アコースティックドラム全体にタイトな電子音を重ねて、
すぐにドラムンベース風のサウンドを作り出せます。

B HH40

65 [+OH DSU] BEQC Add DSU50 as OH Mic P012をベースにDSU50をもう一本使用して再調整した
シーンです。3-4Chはもう一本のDSU50をOHマイクと
して使用するためにEQやエフェクトを調整しており、シン
バルの高音域を際立たせます。ゲインは必要に応じて
調整してください。

*1 *2 C, D FC7

66 [+OH DSU] F-Rk Add DSU50 as OH Mic P010をベースにDSU50をもう一本使用して再調整した
シーンです。3-4Chはもう一本のDSU50をOHマイクと
して使用するためにEQやエフェクトを調整しており、シン
バルの高音域を際立たせます。ゲインは必要に応じて
調整してください。

*1 C, D FC7

67 [+Room DSU] BEQC Add DSU50 as Room Mic P012をベースにDSU50をもう一本使用して再調整した
シーンです。もう一本のDSU50はルームマイクとして
使用するため、CまたはDのセッティングを基準にドラム
セットから離して設置してください。3-4ChはEQやエフェ
クトを調整しており、部屋の響きや空気感を際立たせま
す。ゲインは必要に応じて調整してください。

*1 *2 C, D FC7

68 [+Room DSU] Rock Add DSU50 as Room Mic P030をベースにDSU50をもう一本使用して再調整した
シーンです。もう一本のDSU50はルームマイクとして
使用するため、CまたはDのセッティングを基準にドラム
セットから離して設置してください。3-4ChはEQやエフェ
クトを調整しており、部屋の響きや空気感を際立たせま
す。ゲインは必要に応じて調整してください。

*1 C, D FC7

69 [+OH ExMic] BEQC Add External Mics as OH P012:Basic EQ Compにお手持ちのマイクを2本追加
で使用したシーンです。3-4Chにマイクを追加で挿し、
オーバーヘッドの位置に置くことで、シンバルの高音域を
よりはっきりと収音できます。3-4Chのゲインは0、ファ
ンタム電源はオフに設定されているため、必要に応じて
調整してください。

*1 *2 E FC7

70 [Multi-Mic Tmpl] Multi-Mic Template マルチマイク使用時に便利なテンプレートシーンです。
Mic1 Chから順に、OH L、OH R、Kick、Snare、HH
の用途に対応しています。各チャンネルのゲインは0、
ファンタム電源はオフに設定されているため、必要に応じ
て調整してください。

F FC7

(*1)	 ステージ演奏時など、モニタースピーカーの近くで本機をお使いの場合、ハウリング音が出やすいのでご注意ください。(増幅度の高いマイク
エフェクトや複数のマイクを使用しているため)

(*2)	 密閉度の高いヘッドフォンを使ったときや、録音した自分の演奏を再生したときに、マイクエフェクトやトリガー音色の効果がより分かりやすく聞
こえるシーンです。
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[MIC/TRIG] 
[MIC/TRIG]ボタン点灯時においては、マイク音およびトリガー音に関する設定を行います。トップ画面では、[MIC/LINE]端子およ
び[TRIGGER INPUT]端子からの信号の入力状態がメーターでリアルタイム表示されます。

[F１] Volume
[MIC/INPUT]端子から入力されるオーディオおよび[TRIGGER INPUT]端子からの入力信号を元に鳴っている電子音(ボイス)につ
き、それらの音量バランスをとります。

パラメーター 説明 設定 初期値
Mic/Kit [F3] Setting →Mic/Kit Vol と同じです。 0～ 127 シーン(Mic/Kit 

Volume)での設定値
Mic [MIC/LINE]端子からの入力音のボリュームを、全端子一括で調

節します。
0～ 127 シーン(Mic)での設定値

Mic In [MIC/LINE]端子からの入力音のボリュームを、端子ごとに個別
に調節します。[F1] MicSelボタンで端子番号を選択してから調
節します。

0～ 127

Kit 現在選択されているシーンに登録されているドラムキット(全て
の電子ドラムパッド一括)のボリュームを調節します。

0～ 127

Inst 電子ドラムパッドのインストごと(トリガー入力ごと)に、ボリューム
を調節します。[F1] TrigSelボタンでトリガー入力を選択してか
ら調節します。

0～ 127

Voice A トリガー入力ソースに割り当てられているボイスのボリュームにつ
き、レイヤー (A ～ D)ごとに調節します。[F1] TrigSelボタンでト
リガー入力ソースを選択してから調節します。

0～ 127
Voice B 0～ 127
Voice C 0～ 127
Voice D 0～ 127

F1 F2 F3

●マイクレベルメーター
[MIC/LINE]端子からの
入力状況

●	トリガー信号レベル
メーター

[TRIGGER INPUT]端
子からの入力状況

[EXIT]ボタン

[EXIT]ボタン

[F1]ボタン

[F3]ボタン

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味
で、操作説明のために便宜的につけたボタン名称です。
製品本体には印字されていません。

[EXIT]ボタン

[ENTER]ボタン
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[F3] Setting
トップ画面において[F3] Settingボタンを押すと、マイク端子・トリガー端子からの入力に関する設定項目群が表示されます。いくつ
かの階層があるので、[ENTER]ボタンで下階層に進み、[EXIT]ボタンで上階層に戻ることで、設定したい項目を探します。

[F3] Setting →Mic/Kit Vol

パラメーター 説明 設定 初期値
Volume 本製品で鳴るサウンドのうち、主に自分の演奏音(マイク端子から

のアコースティックドラム音とトリガー入力信号を元に鳴っている
ドラムキット音)のボリュームを設定します。ここではシーン間の
音量バランスをとるために調整し、パネル右下の[MIC/TRIG]ス
ライダーはその他のオーディオやクリックとの音量バランスをと
るために調整します。

0～ 127 シーン(Mic/Kit Volume)
での設定値

[F3] Setting →Mic
マイク端子からの入力音をどのように処理して鳴らすか(出力するか)、を設定します。全設定につき、「Mic」としてシーンに登録され
ます。

[F3] Setting →Mic →Mic Volume

パラメーター 説明 設定 初期値
Volume 全マイク端子からの入力音に対する音量を設定します。これによ

り、キット演奏の音量([MIC/TRIG] →[F3] Setting →Kit →Kit 
Volume)とバランスをとります。

0～ 127 シーン「Mic」への登録値

[F3] Setting →Mic →Mic Pairing

パラメーター 説明 設定 初期値
Mic1/2 2つのマイク端子について入力オーディオをステレオとしてペア

リングする(Paired)/しない(Separate)を設定します。1と3がL、
2と4がRです。「Paired except Gain」は「Paired」と同じ設定で
すが、ゲインだけはそれぞれ独立した設定になります。
NOTE

「Paired」に設定した場合、Mic2はMic1の設定で、Mic4はMic3の
設定で、それぞれ動作します。

Separate, Paired, 
Paired Excep Gain

プリセットシーン(Mic)で
は一律「Paired」

Mic3/4 Separate, Paired, 
Paired Excep Gain

プリセットシーン(Mic)で
は一律「Separate」
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[F3] Setting →Mic →Mic In
各マイク端子につき、入力音に関する設定を行います。[F1] MicSelボタンで表示される別画面でマイク端子を選んでから、各項目
を設定します。

NOTE
設定対象となるマイク端子は画面右上に表示されます。

Page 1/4

パラメーター 説明 設定 初期値
On/Off 各マイク端子につき、外部から音を入力する(On)/入力しない

(Off)を設定します。
NOTE
この設定は、[MIC]ボタン点灯時のチャンネルオン/オフボタン1 ～ 5
ボタンの点灯/消灯と連動します。

Off, On プリセットシーン(Mic)で
は一律、以下のとおり。
・Mic1：On
・Mic2：Off
・Mic3：Off
・Mic4：Off
・Mic5：Off

Phantom 各マイク端子につき、ファンタム電源のオン/オフを設定します。
該当マイク端子にコンデンサーマイクなどファンタム電源が必要
な機器を接続した場合に「On」に設定します。
NOTE
ファンタム電源のオン/オフ切替時、ノイズを防ぐために数秒間はマイ
ク入力がミュートされます。

ファンタム電源に関するご注意
本体/外部機器の故障やノイズを防ぐために、次の注意事項をお
守りください。
•	ファンタム電源のオン/オフ切替は、[MIC/TRIG]スライダー
を最小にした状態で行う。

•	ファンタム電源をオンにしたまま、マイク端子でケーブルの抜
き差しをしない。

•	ファンタム電源が不要な場合はオフにする。
•	マイク端子に、ファンタム電源非対応の機器を接続するときは、
オフにする。

Off, On プリセットシーン(Mic)で
は一律、以下のとおり。
・Mic1：On
・Mic2：Off
・Mic3：Off
・Mic4：Off
・Mic5：Off

Gain 各マイク端子につき、入力音のゲインを設定します。
NOTE
ゲイン設定を変更時、ノイズを防ぐために数秒間マイク入力がミュート
されます。

0～ 50 シーン(Mic)での設定値

Gain Auto Setup 本製品の[MIC1]端子、[MIC2]端子、および[q KICK/y]端子に付属のセンサーユニットDSU50を接続した
場合にのみ有効なパラメーターです。センサーユニットから入力されるマイク音(Mic1とMic2)およびトリガー
音(Kick)のゲインを自動調整します。

ドラム演奏を続けている間、本製品内部では
ゲインの自動調整が行われます。自動調整
が終わると、画面は次の表示に変わります。 NOTE

•	 DSU50以外を接続しても本機能は使えますが、適切なゲイン
値は得られません。また、手順2の画面に到達できないことも
あります。本機能はDSU50接続時にのみお使いください。

•	 他のマイク端子(MIC3, MIC4, MIC5)の調整は本機能では行
いません。

1.	 [ENTER]ボタンを押してゲインオー
トセットアップ画面を表示させ、ドラ
ムを演奏します。

2.	 [ENTER]ボタンを押すことで、調整値を確定させます。.
画面は元の表示に戻ります。
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Page 2/4

パラメーター 説明 設定 初期値
Volume 各マイク端子につき、入力音の音量を設定します。 0～ 127 シーン(Mic)での設定値
Pan 各マイク端子につき、入力音のステレオ定位を設定します。 L63～ C～ R63 プリセットシーン(Mic)で

は一律「C」
Phase 各マイク端子につき、入力音の位相を反転させる(On)/させな

い(Off)を設定します。
Off, On プリセットシーン(Mic)で

は一律「Off」

Delay 各マイク端子につき、入力音のディレイ(遅延)を設定します。
各マイクとその音源との距離が異なる場合、この設定をすること
によって、マイク同士での音が聞こえてくるタイミングのズレを
補正します。

0.0 ms ～ 0.1 ms 
～ 10.0 ms .
(0.000 m ～ 0.034 m 
～ 3.400 m)

プリセットシーン(Mic)で
は一律「0 ms」

Page 3/4

パラメーター 説明 設定 初期値
Gate 各マイク端子につき、ゲート機能をオン/オフします。

「ゲート」は、指定値を下回る音量のサウンドをカットする機能で
す。通常はゲートが開いた状態で、カットする際にゲートが閉ま
ることになります。楽器間のマイクの被り(ターゲットにしたい楽
器以外の音が入ってくること)を防いだり、タムやスネアの余韻を
カットして音の長さを調整したりすることに活用します。

Off, On プリセットシーン(Mic)で
は一律「Off」

Gate Threshold 各マイク端子につき、入力音をカットする(ゲートが閉まる)境とな
るしきい値(スレッショルド)を設定します。音量がここで設定した
値を下回ったときに、ゲートが閉まり始めます。不必要な音がカッ
トされるよう調整してください。

−73 dB ～ −30 dB シーン(Mic)での設定値

Gate Hold 一度ゲートを開いたあとに、ゲートが閉まり始めるまでの最低時
間を指定します。音量がスレッショルドを下回っても、ここで設定
した時間以内はゲートは閉じず、設定時間を超えてから閉まり始
めます。

0 ms～ 500 ms

Gate Attack ゲートが開き始めてから(音量が徐々に上がり始めてから)音が通
常ボリュームで鳴るようになるまでの時間を設定します。

0.02 ms ～ 40 ms

Gate Release ゲートが閉まり始めてから(サウンドカットが始まってから)無音に
なるまでの時間を設定します。

10 ms ～ 680 ms
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Page 4/4

パラメーター 説明 設定 初期値
Noise Gate 各マイク端子につき、ノイズゲート機能をオン/オフします。マイ

クゲインを上げたときなどに無音時のノイズが気になる場合に
オンします。

Off, On プリセットシーン(Mic)で
は一律「Off」

Talk 本製品では、接続したマイクをドラム演奏の収音用だけでなく、
演奏者の声などを集音するトーク用の設定に切り替えることがで
きます。ここでは、接続したマイクをトーク用の設定に切り替え
る(On)か、ドラム演奏の収音用に使う(Off)かを、端子ごとに選択
します。なお、設定が切り替わるのは以下画面の全項目で、トー
ク用マイク全てに共通の設定となります。

[MIC/TRIG] →[F3] Setting 
 →Mic In, Mic EQ, Mic TranComp, Mic Out

設定が「Off」の場合は画面右上は「Mic1」のような表示になりま
すが、「On」に設定すると 「Mic1Talk」のようにトーク用の端子と
して設定されていることが認識できるようになります。

	注意
トークを「On」にすると、マイクに関する様々な設定がトーク用の値に切
り替わります。特にゲイン値は上がりますので、トークを「On」にしたま
まドラム演奏をすると予想外の大音量になるおそれがあります。トー
クを「On」にしたまま演奏することがないよう十分ご注意ください。

Off, On

[F3] Setting →Mic →Mic EQ
本製品では、各マイク端子からの入力音に対して4バンドのEQ(イコライザー )やハイパスフィルターをかけられます。ここでは、EQ
関連設定を端子ごとに行います。[F1] MicSelボタンでマイク端子を選んでから、各項目を設定します。1ページめでタイプ選択や
カラー設定をすることで、2ページめ以降の詳細項目は連動して設定されます。タイプ選択やカラー設定をしたあと、さらに細かく
調整したい場合は、2ページめ以降の詳細項目を設定します。

NOTE
•	 設定対象となるマイク端子は画面右上に表示されます。
•	 イコライザーについては、25ページの図解をご参照ください。

Page 1/6

パラメーター 説明 設定 初期値
On/Off 各マイク端子につき、入力音に対してEQをかける(On)か、かけ

ない(Off)かを選択します。
Off, On プリセットシーン(Mic)で

は一律「On」

Type 各マイク端子につき、EQタイプを選択します。 (EQタイプリスト参照) シーン(Mic)での設定値
Color 各マイク端子につき、EQカラー (音の明るさ)を設定します。数

値が大きいほど明るくなります。
−64～ 0～+63

Page 2/6

パラメーター 説明 設定 初期値
Low Freq 各マイク端子につき、EQ低域の中心周波数を設定します。 32 Hz ～ 2.0 kHz シーン(Mic)での設定値
Low Gain 各マイク端子につき、EQ低域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
Low Q 各マイク端子につき、EQ低域のQ(周波数特性)を設定します。

Low Shapeが「LowShelving」に設定されている場合、Low Q
の値は効果しません。

0.1 ～ 12.0

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip
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Page 3/6

パラメーター 説明 設定 初期値
MidLow Freq 各マイク端子につき、EQ中低域の中心周波数を設定します。 100 Hz ～ 10.0 kHz シーン(Mic)での設定値
MidLow Gain 各マイク端子につき、EQ中低域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
MidLow Q 各マイク端子につき、EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0

Page 4/6

パラメーター 説明 設定 初期値
MidHigh Freq 各マイク端子につき、EQ中高域の中心周波数を設定します。 100 Hz ～ 10.0 kHz シーン(Mic)での設定値
MidHigh Gain 各マイク端子につき、EQ中高域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
MidHigh Q 各マイク端子につき、EQ中高域のQ(周波数特性)を設定します。 0.1 ～ 12.0

Page 5/6

パラメーター 説明 設定 初期値
High Freq 各マイク端子につき、EQ高域の中心周波数を設定します。 500 Hz ～ 16.0 kHz シーン(Mic)での設定値
High Gain 各マイク端子につき、EQ高域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
High Q 各マイク端子につき、EQ高域のQ(周波数特性)を設定します。

値が大きくなると周波数の範囲が狭くなり、急な音色変化になり
ます。値が小さくなると周波数の範囲が広くなり、なだらかな音
色変化になります。
High Shapeが「HighShelving」に設定されている場合、High 
Qの値は効果しません。

0.1 ～ 12.0

High Shape EQ高域の周波数特性の形状を選択します。
「LPF」を選択した場合は、イコライザー全体がローパスフィル
ターに切り替わります。

HighShelving, 
PeakDip, LPF

Page 6/6

パラメーター 説明 設定 初期値
HPF Freq 各マイク端子につき、ハイパスフィルターのカットオフ周波数を

設定します。
Thru, 56 Hz ～.
2.0 kHz

シーン(Mic)での設定値

HPF Q 各マイク端子につき、ハイパスフィルターのQ(周波数特性)を設
定します。

0.1 ～ 12.0
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[F3] Setting →Mic →Mic TranComp
各マイク端子につき、入力音のトランジェント(アタック感やリリース感)やコンプレッサーのかかり具合を調整します。本製品において
両エフェクトのオン/オフは同時に行います。
ここでは、[F1] MicSelボタンでマイク端子を選んでから、各項目を設定します。1ページめでタイプ選択や深さ(Depth)設定をする
ことで、2ページめ以降の詳細項目は自動で設定されます。タイプ選択や深さ設定をしたあと、さらに細かく調整したい場合は、2ペー
ジめ以降の詳細項目を設定します。

Page 1/3

パラメーター 説明 設定 初期値
On/Off 各マイク端子につき、入力音にトランジェントコンプレッサーをか

ける(On)/かけない(Off)を設定します。
Off, On プリセットシーン(Mic)で

は一律「On」

Type 各マイク端子につき、トランジェントコンプレッサータイプを選択
します。

(タイプリスト参照) シーン(Mic)での設定値

Depth 各マイク端子につき、トランジェントコンプレッサーのかかり具合
を調整します。

0～ 127

Page 2/3

パラメーター 説明 設定 初期値
Tran Attack 各マイク端子につき、入力音のアタック感を調整します。 −50 ～ 0 ～ +50 シーン(Mic)での設定値
Tran Release 各マイク端子につき、入力音のリリース感を調整します。 −50 ～ 0 ～ +50
Tran Sensitivity 各マイク端子につき、ドラムを叩いた強さに応じたトランジェント

効果のかかる感度を調整します。
1～ 4

Page 3/3

パラメーター 説明 設定 初期値
Comp 
Threshold

各マイク端子につき、コンプレッサーの効果が効き始める入力レ
ベル(スレッショルド)を設定します。

−48dB ～ −6dB シーン(Mic)での設定値

Comp Ratio 各マイク端子につき、スレッショルドを超えた部分の音を圧縮す
る度合いを設定します。大きい数値ほど、多く圧縮されます。

1.0, 1.5, 2.0, 3.0, 
4.0. 5.0, 7.0, 10.0, 
20.0

Comp Attack 各マイク端子につき、入力レベルがスレッショルドを超えてから、
コンプレッサーの効果が最大に達するまでの時間を設定します。

1 ms ～ 40 ms

Comp Release 各マイク端子につき、入力レベルがスレッショルドを下回ってか
ら、コンプレッサーの効果がなくなるまでの時間を設定します。

10 ms ～ 680 ms

Comp Out Level 各マイク端子につき、コンプレッサーからの出力レベルを設定し
ます。

−18.0 dB ～ 0.0 dB 
～ +18.0 dB
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[F3] Setting →Mic →Mic Out
各マイク端子からの入力音を、どのようなルートを通って外部出力するかを設定します。

エフェクト結線図（マイク入力）

A
B

アコドラム部

マイク入力1

マイク入力４

マイク入力２

マイク入力5

マイク入力3

マイクごとの﻿
エフェクト

パートEQ

トランジェント.
コンプレッサー

インサーション.
エフェクト１

インサーション.
エフェクト２

分岐点の設定
[MIC/TRIG] →[F3] Setting →Mic →Mic Out 
→Effect Thru=On の場合、
[MIC/TRIG] →[F3] Setting →Mic →Mic Out 
→EQ Tran Thru の設定により、以下3つのう
ちのいずれか1つの場所から、音の流れを分
岐させることができます。

EQ Tran Thru=
・EQ Thru の場合

・Tran Thru の場合

・Off の場合

システム﻿
エフェクト

マスター﻿
エフェクト

・	リバーブ
・	 FX1
・	 FX2

・	マスター FX
・	マスター.
コンプレッサー

・	マスター EQ

AとBについては、以下のとおり、設定値の変更により連動します。
[MIC/TRIG] →[F3] Setting →Mic →Mic Out →Effect Thru=On の場合：Aオフ、Bオン
[MIC/TRIG] →[F3] Setting →Mic →Mic Out →Effect Thru=Off の場合：Aオン、Bオフ

Phones
EQ

[OUTPUT]端子
(Main Out)

[MENU] →Output 
→Phones EQ

[USB TO HOST]端子
(USB Audio Out 1/2)

[MIC/TRIG] →[F3] Setting 
→Mic →Mic Out .
→IndivOut

[INDIVIDUAL OUTPUT]端子
・IndivOut 1/2
・IndivOut ３/4
・IndivOut 5/6
・IndivOut 7/8

USBオーディオの各チャ
ンネルは、IndivOutの
設定に従います。

[USB TO HOST]端子
・USB Audio Out 3/4
・USB Audio Out 5/6
・USB Audio Out 7/8
・USB Audio Out 9/10

[MIC/TRIG] →[F3] Setting 
→Effect 

[MIC/TRIG] →[F3] Setting 
→Effect 
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Page 1/2

パラメーター 説明 設定 初期値
EQ Tran Thru マイク端子からの入力音を、エフェクト結線の途中で分岐し、以降

のエフェクトをバイパスして出力することができます。ここでは
その分岐する場所を設定します。
•	Off：システムエフェクトに入る前で分岐します。
•	EQ Thru：パートEQに入る前で分岐します。
•	Tran Thru：トランジェントコンプレッサーに入る前に分岐します。

Off, EQ Thru, .
Tran Thru

プリセットシーン(Mic).
では一律「Off」

Effect Thru 各マイク端子からの入力音につき、本製品のシステムエフェクト部
およびマスターエフェクト部に通す(Off)/通さない(On)を設定し
ます。「On」を選択した場合は、「EQ Tran Thru」で選択した分岐
点からの音をマスターエフェクト部の後ろのルートに通します。

Off, On

Main Out Effect Thruが「On」の場合のみ表示されます。「EQ Tran Thru」
で選択した分岐点からの音につき、[OUTPUT]端子から出力す
る(On)/出力しない(Off)を個別に設定します。

Off, On プリセットシーン(Mic).
では一律「On」

Phones Out Effect Thruが「On」の場合のみ表示されます。「EQ Tran Thru」
で選択した分岐点からの音につき、[PHONES]端子から出力す
る(On)/出力しない(Off)を個別に設定します。

Off, On

USB Audio Out 
1/2

Effect Thruが「On」の場合のみ表示されます。「EQ Tran Thru」
で選択した分岐点からの音につき、[USB TO HOST]端子から
出力する(On)/出力しない(Off)を個別に設定します。

Off, On

Page 2/2

パラメーター 説明 設定 初期値
IndivOut 各マイク端子からの入力音につき、エフェクト結線図上の分岐点

から、端子別/チャンネル別に分けて出力することができます。
各マイク端子からの入力音につき、演奏音を[INDIVIDUAL 
OUTPUT]端子のどこから出力させるかを設定します。
NOTE
IndivOut1-8はUSB Audio Outの3-10と連動しています。例えば
Mic1=L1+R2 に設定したとしたら、Mic1の音は USB Audio 3/4 
経由でPCなどにも出力されます。

Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8
*	各設定値については、
下表をご参照ください。

プリセットシーン(Mic).
では一律「Off」

IndivOut Vol 各マイク端子からの入力音につき、演奏音をエフェクト結線図
の分岐点(92ページ)から出力する際の音量を調節します。

「Variable」に設定すると、音量は[MIC/TRIG]スライダーの操
作に連動します。

Variable, 1 ～ 127 プリセットシーン(Mic).
では一律「Variable」

IndivOut の各設定値

設定値 解説
実際にオーディオが出力されることになる端子

INDIVIDUAL OUTPUT 
–BALANCED- USB TO HOST

Off オーディオは出力されません。 ー ー
L1+R2, L3+R4, 
L5+R6, L7+R8

これらの設定では、2つの端子からの
ステレオ出力になります。

設定値にある数字は端子番号を示しています。
例えば「L1+R2」に設定した場合は、以下の通りで
す。
•	ステレオL：[1]端子
•	ステレオR：[2]端子

設定値にある数字は、1 ～ 8=USB Audio Out 
3 ～ 8を示しています。例えば「L1+R2」に設定
した場合は、以下の通りです。
•	ステレオL：USB Audio Out 3
•	ステレオR：USB Audio Out 4

L1, R2, L3, R4, 
L5, R6, L7, R8

これらの設定では、ステレオのLだけま
たはRだけを、モノラル出力すること
になります。

設定値にある数字は端子番号を示しています。
例えば「L1」に設定した場合はステレオLが[1]端
子から出力され、ステレオRは出力されません。

設定値にある数字は、1 ～ 8=USB Audio Out 
3 ～ 8を示しています。例えば「L1」に設定した
場合は、ステレオLだけがUSB Audio Out 3から
出力されます。「R2」に設定した場合は、ステレオL
だけがUSB Audio Out 4から出力されます。

(L+R)1, (L+R)2, 
(L+R)3, (L+R)4, 
(L+R)5, (L+R)6, 
(L+R)7, (L+R)8

これらの設定では、ステレオLとRが
ミックスされたオーディオが、1つの
端子から出力されることになります。

設定値にある数字は端子番号を示しています。
例えば「(L+R)1」に設定した場合は、[1]端子から
出力されることになります。

設定値にある数字は、1 ～ 8=USB Audio Out 
3 ～ 8を示しています。例えば「(L+R)1」に設定
した場合は、ステレオLとRがミックスされたオー
ディオがUSB Audio Out 3から出力されます。
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[F3] Setting →Trigger
トリガー端子やフットスイッチ端子からの入力信号につき、どのように処理して電子音(ボイス)を鳴らすか(出力するか)を設定します。
全設定につき、「Trigger」としてシーンに登録されます。

[F3] Setting →Trigger →Trig Pairing
2つの数字が併記されたトリガー入力端子(モノラル×2インプット)の2インプットにつき、ペアリングする(Paired)/しない(Separate)
を設定します。
Paired
トリガー信号の入力につき、2インプットをいずれも同じパッドから取り込みたい場合に設定します。単一のパッドと1対1で接続して
いる場合が前提になります。
Separate
トリガー信号の入力につき、2インプットを2つの違うパッドから取り込みたい場合に設定します。2つのパッドとY字ケーブルで接続
している場合か、KPシリーズなど接続したパッドの[PAD INPUT]端子にさらに別のパッドを接続している場合が前提になります。

パラメーター 説明 設定 初期値
Kick/Trig6 [q KICK/y]端子への入力方式を選択します。

[q KICK/y]端子には付属のセンサーユニットまたは電子ドラ
ムのキックパッドKPシリーズ(1ゾーンパッド)からのケーブルが
接続されることを想定し、初期設定は「Separate」としています。
KPシリーズ以外を接続する場合は、接続するパッドのゾーン数に
応じて設定を変更してください。

Separate, Paired シーン(Trigger)での.
設定値

Snare/Trig7 [w SNARE/u]端子への入力方式を選択します。
[w SNARE/u]端子にはドラムトリガーからのケーブルが接続
されることを想定し、初期設定は「Paired」としています。

Separate, Paired

Trig3/Trig8 [e /i]端子への入力方式を選択します。 Separate, Paired

Trig4/Trig9 [r /o]端子への入力方式を選択します。 Separate, Paired

Trig5/Trig10 [t /!0]端子への入力方式を選択します。 Separate, Paired
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[F3] Setting →Trigger →Trig In
本製品に入力されたトリガー信号をどう処理するかを設定します。

[F3] Setting →Trigger →Trig In →Pad
本製品にトリガー入力信号を送り込んでくるパッドに関する設定です。電子ドラムのパッドにはキック、スネア、タム、シンバル、ハイハッ
ト、ドラムトリガーなどの種類があり、特性もそれぞれ異なります。本製品では、それぞれのパッドの特性に最適な設定群を「パッドタ
イプ」として用意していますので、パッドごと(トリガー入力ごと)に最適なものを選択してください。
[F1]ボタンを押してトリガー入力(パッド)を選択してから、各項目を設定します。

NOTE
Trig6 ～ Trig10 の設定はTrig Pairing=「Separete」の時だけ有効です。 

Page 1/5

パラメーター 説明 設定 初期値
Category パッドタイプのカテゴリーを選択します。 Off, Kick, Snare, 

Tom, Cymbal, HH, 
Others

シーン(Trigger)での設定
値

Type パッドタイプとして具体的な品番を選択します。 ファームウェアのバー
ジョンによる

Page 2/5

パラメーター 説明 設定 初期値
Gain パッドを叩いたときに入力される信号のゲイン(増幅率)を設定し

ます。
NOTE
この値を高く設定すると、あるレベル以上の入力信号をすべて同じレ
ベル(最大レベル)の信号として扱います。このため叩く強さのばらつ
き補正をすることができます。この値を低く設定すると、パッドを叩く
強弱が信号レベルに反映されやすくなるため表現力が広がります。

1～ 127 プリセットシーン
(Trigger)ではパッドタイ
プに適した値

Rim Gain XP125SD-Xなどマルチピエゾパッドを接続した場合の、リム部
のゲインを設定します。Trig Pairing=「Paired」のときだけ有
効になります。

1～ 127

H/R Balance XP125SD-Xなどマルチピエゾパッドのヘッドとリムのバランスを
設定します。リムを叩いてヘッドが鳴る場合は、R側の値を大き
くするとリムが鳴りやすくなります。同様にヘッドを叩いてリム
が鳴る場合は、H側の値を大きくするとヘッドが鳴りやすくなり
ます。モノラル×2インプット端子を使う場合は、Trig Pairing=

「Paired」のときだけ有効なパラメーターです。

H49～ H1, H=R, .
R1 ～ R49

Gain Auto Setup [MIC/TRIG] →Mic →Mic In にある同名のパラメーターと同じです。87ページをご参照ください。
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Page 3/5

パラメーター 説明 設定 初期値
Wait Time 設定対象のパッドがトリガー信号を検出するまでの時間を設定し

ます。トリガー信号が最大ピークのときに検出し、パッドを叩いた
強さに対して正しい強さで音が出るように時間を調整します。

1 ms～ 64 ms プリセットシーン
(Trigger)ではパッドタイ
プに適した値

Reject Time 設定した時間内の連打で発生したトリガー信号を無視します。
NOTE
Reject Time(リジェクトタイム)の時間内でも、2回目の打音レベルが
1回目の2倍以上だった場合は、無視されずに発音されます。

4 ms～ 500 ms

Sensitivity パッドを連打したときの感度を設定します。 1～ 13

Page 4/5

パラメーター 説明 設定 初期値
Min Level
Max Level

ベロシティー値を出力するトリガー入力信号のレベルを最小(％)
～最大(％)で設定します。ここで設定した最小レベル以下のトリ
ガー信号では音が出ません。ここで設定した最大レベル以上の
トリガー信号は、次のMin Velocity/Max Velocity(最小ベロシ
ティー /最大ベロシティー )で設定する最大ベロシティーとなり
ます。

1～ 100 プリセットシーン
(Trigger)ではパッドタイ
プに適した値

Min Velocity
Max Velocity

上記のMin Level/Max Levelで設定したトリガー入力信号レベ
ルに対応したベロシティー値を最小～最大で設定します。ここで
設定したベロシティーの範囲で音が出ます。

1～ 127

Page 5/5

パラメーター 説明 設定 初期値
Xstick On/Off マルチピエゾパッドを接続した端子にのみ有効な設定です。

「On」に設定すると、パッドを叩く強さによってオープンリム
ショット音とクローズドリムショット音が切り替わります。
NOTE
•	 Xstick On/Off が「Off」のときは常にオープンリムショット音が出

ます。
•	 シングルピエゾパッドを接続した場合は効果がありません。

Off, On プリセットシーン
(Trigger)ではパッドタイ
プに適した値

Xstick Adjust マルチピエゾパッドを接続した端子にのみ有効な設定です。
Xstick On/Off が「On」のときに、マルチピエゾパッドのリムを
叩いたときのクロススティック音とオープンリムショット音の切り
替わりやすさを設定します。値を大きくするとパッドを強打した
ときにクロススティック音が出やすくなり、値を小さくすると弱打
でもオープンリムショット音が出やすくなります。

1～ 127
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パラメーター 説明 設定 初期値
Position Trig3 ～ Trig5 にのみ有効な設定項目で、パッドの位置検出機能

を活用する(On)/活用しない(Off)を設定します。「On」に設定す
ると、打点位置による音色変化が得られます。位置検出機能付
きのパッドが接続され、位置検出機能に対応したボイスがパッド
のインストに割り当てられている場合にのみ、有効な設定です。
NOTE
位置検出機能付きのパッドについては、「Pad Module Compatibility 
Table」でご確認ください。位置検出機能に対応したボイスについて
は、データリストにある「ボイスリスト」をご参照ください。いずれもヤ
マハウェブサイト(4ページ)からダウンロードできます。

Off, On プリセットシーン
(Trigger)ではパッドタイ
プに適した値

Attenuator Trig3～Trig5およびTrig8～Trig10にのみ有効な設定項目で、
トリガー信号を減衰させる(On)/させない(Off)を設定します。
通常は「Off」で問題ありませんが、ヤマハ以外のパッドを接続した
場合などで、入力レベルが合わない場合に「On」に設定してくだ
さい。

Off, On

[F3] Setting →Trigger →Trig In →Vel Curve
パッドを叩いたときに入力される信号(トリガー入力レベル)の変化に対する音の強さ(ベロシティー )の変化の仕方(ベロシティーカー
ブ)を、パッドごと(トリガー入力ごと)に選択します。
[F1]ボタンを押してトリガー入力(パッド)を選択してから、各項目を設定します。

パラメーター 説明 設定 初期値
Curve ベロシティーカーブを選択します。 Normal, .

Hard1～ 10, .
Loud1～ 10, .
Spline A1～ 10, 
Spline B1 ～ 10, 
Offset1 ～ 10, .
Fix1 ～ 10, Custom

プリセットシーン
(Trigger)では一律
「Normal」

Loud1‒10 Hard1‒10

Normal

Spline A1‒A10 Spline B1‒B10 Offset1‒Offset10 Fix1‒Fix10

Offset10

Offset1

NormalSpline B1

Spline B10

Hard10

Spline A1

Spline A10
Fix1

Fix10

Loud10

Fix6

Hard1

Loud1

トリガー入力レベル トリガー入力レベル トリガー入力レベル トリガー入力レベル トリガー入力レベル

べ
ロ
シ
テ
ィ
ー

べ
ロ
シ
テ
ィ
ー

べ
ロ
シ
テ
ィ
ー

べ
ロ
シ
テ
ィ
ー

べ
ロ
シ
テ
ィ
ー

•	「Custom」を選
択した場合
X1
Y1
X2
Y2

ベロシティーカーブで「Custom」を選択した場合に表示されます。
2点の座標(X1-Y1およびX2-Y2)を指定することで、折れ線カー
ブを作ります。

1～ 126 プリセットシーン
(Trigger)では一律「32」

1～ 127 プリセットシーン
(Trigger)では一律「32」

2～ 127 プリセットシーン
(Trigger)では一律「96」

1～ 127 プリセットシーン
(Trigger)では一律「96」
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画面での設定項目(パラメーター)
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[F3] Setting →Trigger →Trig In →Crosstalk(クロストーク)
電子ドラムのパッド(ドラムトリガーを取り付けたアコースティックドラムを含む)を叩いたとき、共振やパッド間の干渉により他のパッド
からトリガー信号が発生してしまうことを「クロストーク」といいます。ここでは各パッドがクロストークの発生源にならないようにする
ため、トリガー信号を出力しない最大値を個々に設定します。設定は、各パッドを叩くこと(Auto Setup)、または値(Reject Level)の
入力で行います。まずはAuto Setupで設定し、それでもクロストークが発生する場合は、パッドごとの値（Reject Level）を直接設定
することをおすすめします。

NOTE
プリセットシーンでは、Reject Levelの初期値は一律で高く設定されています。ドラムセットの中に電子ドラムパッドやトリガーセンサーを設置し
た場合は、演奏前に個々のトリガー入力(パッド/トリガーセンサー )に対してAuto Setupを実行することをお勧めします。

[F3] Setting →Trigger →Trig In →Crosstalk →Auto Setup (クロストーク防止のための自動設定)
特定のパッドを叩くことで、そのパッドが出すトリガー信号がクロストーク発生源にならない最大値(Reject Level)を設定します。

[ENTER]ボタン

[ENTER]
ボタン

1.
設定対象のトリガー入力(クロ
ストーク発生源にならないよう
に設定したいトリガー入力)を、
[+][−]ボタン/ノブで選択しま
す。選択したあと、[ENTER]
ボタンを押して次の画面に進み
ます。

進捗バー
クロストークが発生したら、発生
先のトリガー入力を表示した画
面に切り替わります。ここでは、
スネアパッドがTrig5に対してク
ロストークを発生させたことを
示しています。

3.	 進捗バーが100%に達したら、
[ENTER]ボタンを押して元の
画面に戻ります。これにより、
手順2での最終的なReject 
Levelが設定として確定します。

進捗バーが100%に達すると、
設定は完了です。

クロストーク発生先の
トリガー入力

この時点で、クロストークが再度発生しないよ
うな値にReject Levelの該当箇所(この画面
例ではTrig5の値)が暫定的に更新されます。叩いた回数がリセットされるの

で、手順２を最初からやり直して
ください。

2.	 手順1で選択したトリガー入力に該当するパッドを繰り返し叩きます。.
パッドを叩いてもクロストークが発生しない場合は、叩いた回数に応じて、
図のように進捗バーが進みます。

NOTE
•	 正しい設定にするため、手順2においてパッドの様々な位置

を、様々な強さで叩いてください。
•	 手順2において、手順1.で選択したパッド以外のパッドを

叩いてしまった場合や、パッド選択をやり直したい場合は、
[EXIT]ボタンを押し、手順1からやり直してください。
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画面での設定項目(パラメーター)
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[F3] Setting →Trigger →Trig In →Crosstalk →Reject Level (クロストーク防止のための手動設定)
画面右上に表示されているパッド(クロストークの発生元)と、その他の任意のパッド(クロストークの発生先)の間でクロストークを解決
したい場合に設定します。たとえば、Snareを叩いたときにKickが誤発音してしまう場合は、スネアパッドを叩いて画面右上に「Snare」
が表示されるように設定したあと、「1」(Kick)にカーソルを移動し、Reject Levelを上げます。これにより、Kickから設定値以下の
トリガー信号音が出力されなくなります。値が大きいほどクロストークが起きにくくなりますが、他のパッドと同時に音が出にくくなり
ます。
[設定] 
0 ～ 99
(クロストーク発生元とクロストーク発生先のパッドが同じ場合は「-」と表示)

F1 F2 F3 F1 F2 F3

[ENTER]
ボタン

1.	 該当パッドを叩くこと
で設定対象のトリガー
入力を選択します。

クロストーク発生元となり得るトリガー入力(設定対象)

トリガー入力選択画面で、トリガー入力を
選択する方法もあります。

2.	 [F2] [F3]ボタンで、各トリガー入力の
設定値(Reject Level)にカーソル移動
します。

[EXIT]
ボタン

3.	 設定対象以外のトリガー入力につき、
クロストークの発生先にならないよ
う、トリガー信号が出力される最小値
(Reject Level)を個別に設定します。
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画面での設定項目(パラメーター)
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[F3] Setting →Trigger →Trig In →Foot Sw1
フットスイッチ端子([FOOT SW1]端子)に接続した別売品のフットスイッチ(ペダル)を踏むことで、トリガー信号を発生します。また
パッドと組み合わせてハイハットとして使うこともできます。

Page 1/2

パラメーター 説明 設定 初期値
Type フットスイッチ端子に接続したモデルを選択します。 FC3A, FC4A/5, 

FC7, HH40, HH65, 
RHH135

プリセットシーン
(Trigger)では一律
「HH65」

HH Trig In フットスイッチ端子に接続した機器がコントロールするパッド(ト
リガー入力信号)を選択します。「Off」以外を選択すると、選択し
たパッドと接続したフットスイッチ(ペダル)の組み合わせにより、
HH(ハイハットシンバル)の演奏ができます。「Off」を選択した場
合は、フットスイッチ単独の操作によりFOOT SW1のボイスが鳴
ります。詳細は18ページをご参照ください。

Off, Kick, Snare, 
Trig3 ～ 10

シーン(Trigger)での設
定値

HH Pitch Up 「HH Trig In」が「Off」以外の場合に表示され、設定可能になります。
フットスイッチ端子に接続した機器を深く踏み込んだときに、現在
鳴っているボイスのピッチを上げる(On)/上げない(Off)を設定
します。現在選択中のボイスがカテゴリー「HiHat1」の場合の
み有効です。

Off, On プリセットシーン
(Trigger)では一律「On」

HH Clutch Pos 「HH Trig In」が「Off」以外の場合に表示され、設定可能になります。
ハイハットクラッチの位置を調節した効果が得られます。設定値
が小さいほどハイハットオープン音が速く減衰します。

−32 ～ 0 ～ +32 プリセットシーン
(Trigger)では一律「0」

Page 2/2

パラメーター 説明 設定 初期値
Foot Close Pos 「HH Trig In」が「Off」以外の場合に表示され、設定可能になります。

フットスイッチ端子に接続した機器を踏んだときに、オープン音
からクローズ音に切り替わる位置を調節します。値が小さいほど
トップとボトムの開きが狭い感じになります。

−32 ～ 0 プリセットシーン
(Trigger)では一律「0」

Foot Close Vel 「HH Trig In」が「Off」以外の場合に表示され、設定可能になります。
フットスイッチ端子に接続した機器を踏んだときに発生するベロ
シティーにつき、強さに応じる(Variable)か固定値にする(1 ～
127)かを選択します。

Variable, 1 ～ 127 プリセットシーン
(Trigger)では一律
「Variable」

Foot Splash 
Sens

「HH Trig In」が「Off」以外の場合に表示され、設定可能になります。
ハイハットスプラッシュを鳴らすときの感度を設定します。値を大
きくすると、ハイハットスプラッシュは鳴りやすくなります。ハイハッ
トコントローラーまたはハイハットペダルを軽く踏んでリズムを取
るときなど、音を鳴らしたくない場合は「Off」に設定します。

Off, 1 ～ 127 プリセットシーン
(Trigger)では一律「30」
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画面での設定項目(パラメーター)
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[F3] Setting →Trigger →Trig In →Foot Sw2
フットスイッチ端子([FOOT SW2]端子)に接続した別売品のフットスイッチ(ペダル)を踏むことで、ハイハットシンバルのトリガー音色
を鳴らします。

Page 1/2

パラメーター 説明 設定 初期値
Type [FOOT SW2]端子に接続したモデルを選択します。 FC3A, FC4A/5, 

FC7, HH40, HH65, 
RHH135

シーン(Trigger)での設
定値

HH Trig In 「Foot Sw1」(100ページ)と同じです。
HH Pitch Up
HH Clutch Pos

Page 2/2

パラメーター 説明 設定 初期値
Foot Close Pos 「Foot Sw1」(100ページ)と同じです。
Foot Close Vel
Foot Splash 
Sens
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画面での設定項目(パラメーター)
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[F3] Setting →Kit
現在選択されているシーンに属する電子ドラムのキットにつき、様々な設定を行います。

[F3] Setting →Kit →Kit Volume

パラメーター 説明 設定 初期値
Volume 現在選択されている電子ドラムのキット全体の音量を設定します。

これにより、マイク音の音量([MIC/TRIG] →[F3] Setting →Mic 
→Mic Volume)とバランスをとります。

0～ 127 シーン(Kit)での設定値

[F3] Setting →Kit →Inst
現在選択されているシーンにつき、各パッド(各トリガー入力)に割り当てるインストに関する様々な設定を行います。パッド(トリガー
入力)を選択してから、各項目を設定してください。

NOTE
トリガー入力については16 ～ 20ページをご参照ください。

[F3] Setting →Kit →Inst →Inst
各トリガー入力(各パッド)に割り当てられたインストに対して、インスト自体の選択など基本的な設定を行います。

Page 1/4

パラメーター 説明 設定 初期値
On/Off 各トリガー入力(各パッド)につき、トリガー音を出す(On)/出さな

い(Off)を設定します。パネル左下にある[TRIG]オン時に、パネ
ル中央下部の1 ～ 5のボタンを押すことによっても切り替えられ
ます。

Off, On プリセットシーン(Kit)で
は一律「On」

Category 各トリガー入力(各パッド)に割り当てるインストの分類(カテゴ
リー )を選択します。

NOTE
インストのカテゴリーを選択することで、Tuning/Size、Muffling/
Sustain/Decayが自動的に最適値に設定されます。

データリスト参照 シーン(Kit)での設定値

Number 各トリガー入力(各パッド)に割り当てるインストの番号を選択しま
す。

データリスト参照

Import Wave インストとして使うオーディオファイルを、USBフラッシュメモ
リー /SDカードからインポート(読み込み)します。

データリスト参照

[+][−]ボタンまたはノブで外部メモリー上にある
オーディオファイルを選択し、[F1] TrigSelボタン
を繰り返し押すことでオーディオファイルの割当先
となるトリガー入力を選択します。

[F1]ボタンを押すと、インポートが実行
されます。

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味で、操作説明のために便宜的につけた
ボタン名称です。製品本体には印字されていません。



EAD50　ユーザーガイド 103

画面での設定項目(パラメーター)
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Page 2/4

パラメーター 説明 設定 初期値
Volume 各トリガー入力(各パッド)に割り当てられたインストにつき、音量

を設定します。同一キット内のインスト間のバランスを取りたい
ときに調節します。

0～ 127 シーン(Kit)での設定値

Pan 各トリガー入力(各パッド)に割り当てられたインストにつき、定位
(パン)を設定します。

L63～ C～ R63

Phase 各トリガー入力(各パッド)に割り当てられたインストにつき、発音
時の位相を反転させる(On)/させない(Off)を設定します。

Off, On

Delay 各トリガー入力(各パッド)に割り当てられたインストにつき、発音
の遅延(ディレイ)を設定します。

0 ms～ 0.1 ms ～.
10.0 ms

Page 3/4 (インストカテゴリーにより、表示されるパラメーターが変わります。

パラメーター 説明 設定 初期値
Tuning 各トリガー入力(各パッド)に割り当てられたインストにつき、ピッチ

(音高)を25セント単位で設定します。0.01が1セントに相当します。
NOTE
セントとは、半音を100等分したピッチの単位です。(100セント＝半音)

−12.00 ～ 0.00 ～ 
+12.00

シーン(Kit)での設定値

Size 各トリガー入力(各パッド)に割り当てられたインストにつき、シン
バルのサイズ感を設定します。

−32 ～ 0 ～ +32

Attack 各トリガー入力(各パッド)に割り当てられたインストにつき、パッドを
叩いてから音量が最大レベルに達するまでの時間を設定します。

−64 ～ 0 ～ +63

Muffling 各トリガー入力(各パッド)に割り当てられたインストにつき、マフ
リング(ヘッドのミュート具合)を設定します。

0～ +16

Sustain 各トリガー入力(各パッド)に割り当てられたインストにつき、シン
バルのサステイン効果を設定します。

−32 ～ 0

Decay 各トリガー入力(各パッド)に割り当てられたインストにつき、最大
レベルの音量から減衰するのに要する時間を設定します。

−16 ～ 0

Page 4/4

パラメーター 説明 設定 初期値
Gate 各トリガー入力につき、ゲート機能をオン/オフします。

「ゲート」は、指定値を下回る音量のサウンドをカットする機能で
す。通常はゲートが開いた状態で、カットする際にゲートが閉ま
ることになります。生ドラムのマイクの被り(ターゲットにしたい
楽器以外の音が入ってくること)を防いだり、タムやスネアの余韻
をカットして音の長さを調整することに活用します。

Off, On シーン(Kit)での設定値

Gate Threshold 各トリガー入力につき、入力音をカットする(ゲートが閉まる)境と
なるしきい値(スレッショルド)を設定します。音がここで設定した
値を下回ったときに、ゲートが閉まり始めます。

−73 dB ～ −30 dB

Gate Hold 1度ゲートを開いたあとに、ゲートが閉まり始めるまでの最低時
間を指定します。音量がスレッショルドを下回っても、ここで設定
した時間以内はゲートは閉じず、設定時間を超えてから閉まり始
めます。

0 ms～ 500 ms

Gate Attack ゲートが開き始めてから(音量が徐々に上がり始めてから)音が通
常ボリュームで鳴るようになるまでの時間を設定します。

0.02 ms ～ 40 ms

Gate Release ゲートが閉まり始めてから(サウンドカットが始まってから)無音に
なるまでの時間を設定します。

10 ms～ 680 ms
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[F3] Setting →Kit →Inst →Inst EQ
本製品では、トリガー音に対して4バンドのEQ(イコライザー )やハイパスフィルターをかけられます。ここでは、EQ関連設定をトリ
ガー入力ごと(パッドごと)に行います。[F1] TrigSelボタンでトリガー入力を選んでから、各項目を設定します。1ページめでタイプ
選択やカラー設定をすることで、2ページめ以降の詳細項目は連動して設定されます。タイプ選択やカラー設定をしたあと、さらに
細かく調整したい場合は、2ページめ以降の詳細項目を設定します。

NOTE
•	 設定対象となるトリガー入力は、画面右上に表示されます。
•	 イコライザーについては、25ページの図解をご参照ください。

Page 1/6

パラメーター 説明 設定 初期値
On/Off EQを適用する(On)/適用しない(Off)を設定します。 Off, On プリセットシーン(Kit)で

は一律「On」
Type EQタイプを選択します。 EQタイプを参照 シーン(Kit)での設定値
Color EQのかかり具合を設定します。 −64 ～ 0 ～ +63

Page 2/6

パラメーター 説明 設定 初期値
Low Freq EQ低域の中心周波数を設定します。 32 Hz ～ 2.0 kHz シーン(Kit)での設定値
Low Gain EQ低域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
Low Q EQ低域のQ(周波数特性)を設定します。 

Low Shapeが「LowShelving」に設定されている場合、Low Q
の値は効果しません。

0.1 ～ 12.0

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip

Page 3/6

パラメーター 説明 設定 初期値
MidLow Freq EQ中低域の中心周波数を設定します。 100 Hz ～ 10.0 kHz シーン(Kit)での設定値
MidLow Gain EQ中低域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
MidLow Q EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0

Page 4/6

パラメーター 説明 設定 初期値
MidHigh Freq EQ中高域の中心周波数を設定します。 100 Hz ～ 10.0 kHz シーン(Kit)での設定値
MidHigh Gain EQ中高域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
MidHigh Q EQ中高域のQ(周波数特性)を設定します。 0.1 ～ 12.0
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Page 5/6

パラメーター 説明 設定 初期値
High Freq EQ高域の中心周波数を設定します。 500 Hz ～ 16.0 kHz シーン(Kit)での設定値
High Gain EQ高域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
High Q EQ高域のQ(周波数特性)を設定します。

High Shapeが「HighShelving」の場合、High Qの値は効果し
ません。

0.1 ～ 12.0

High Shape EQ高域の周波数特性の形状を選択します。
「LPF」を選択した場合は、イコライザー全体がローパスフィル
ターに切り替わります。

HighShelving, 
PeakDip, LPF

Page 6/6

パラメーター 説明 設定 初期値
HPF Freq インスト音を、ハイパスフィルター (HPF)に通す(56 Hz ～ 

2.0 kHz)か通さない(Thru)かを設定します。22 Hz ～ 2.0 kHz
に設定した場合は、該当周波数よりも低い周波数域をカットする
ことになります。

Thru, 56 Hz ～.
2.0 kHz

シーン(Kit)での設定値

HPF Q ハイパスフィルターのQ(周波数特性)を設定します。 0.1 ～ 12.0

[F3] Setting →Kit →Inst →InstTranComp
各トリガー入力(各パッド)に割り当てられたインストに対して、トランジェントエフェクト(アタック感やリリース感)とコンプレッサーをか
けます。両エフェクトのオン/オフは同時設定となります。ここでは、[F1] TrigSelボタンでトリガー入力を選んでから、各項目を設
定します。1ページめでタイプ選択や深さ(Depth)設定をすることで、2ページめ以降の詳細項目は自動で設定されます。タイプ選
択や深さ設定をしたあと、さらに細かく調整したい場合は、2ページめ以降の詳細項目を設定します。

Page 1/3

パラメーター 説明 設定 初期値
On/Off トランジェントエフェクト(アタック感やリリース感)とコンプレッ

サーを同時にオン/オフします。
Off, On プリセットシーン(Kit)で

は一律「On」

Type インスト別に、本エフェクトのタイプを選択します。 トランジェントコンプ
レッサータイプリスト
参照

シーン(Kit)での設定値

Depth インスト別に、本エフェクトの効果のかかり具合を設定します。 0 ～ 127

Page 2/3

パラメーター 説明 設定 初期値
Tran Attack インスト別に、トランジェントエフェクトのアタック感を調整します。 −50～ 0～+50 シーン(Kit)での設定値
Tran Release インスト別に、トランジェントエフェクトのリリース感を調整します。 −50～ 0～+50
Tran Sensitivity インスト別に、叩いた強さに応じてトランジェントエフェクトがどう

効果するかの感度を設定します。
1 ～ 6



EAD50　ユーザーガイド 106

画面での設定項目(パラメーター)

M
od

ifi
er

 
ノ

ブ
[ M

IC
 / 

TR
IG

 ]
[ S

CE
NE

 ]
[ C

LIC
K 

]
[ R

EC
O

RD
ER

 ]
[ L

IV
E S

ET
 ]

[ M
EN

U 
]

M
ic

Tr
ig

ge
r

Ki
t

Ef
fe

ct
Re

co
rd

er
Lo

op
er

Sa
m

pl
in

g
Ut

ilit
y

O
ut

pu
t

Au
x 

In
US

B 
Au

dio
Bl

ue
to

ot
h

Fi
le

Ve
rs

io
n

LE
D 

ロ
ー

タ
リ

ー
フ

ェ
ー

ダ
ー

Fa
ct

or
y 

Re
se

t

Page 3/3

パラメーター 説明 設定 初期値
Comp 
Threshold

インスト別に、コンプレッサーの効果が効き始めるレベル(スレッ
ショルド)を設定します。

−48 dB ～ 6 dB シーン(Kit)での設定値

Comp Ratio インスト別に、Comp Thresholdより上のレベルの音量を圧縮
する比率を設定します。

1.0, 1.5, 2.0, 3.0, 
4.0. 5.0, 7.0, 10.0, 
20.0

Comp Attack インスト別に、叩いた直後からコンプレッサーの効果が最大に達
するまでの時間を設定します。

1 ms～ 40 ms

Comp Release インスト別に、コンプレッサーの効果が最大な時点から効果がゼ
ロになるまでの時間を設定します。

10 ms～ 680 ms

Comp Out Level インスト別に、コンプレッサーからの出力レベルを設定します。 −18.0 dB～ 0.0 dB
～ +18.0 dB

[F3] Setting →Kit →Inst →Inst Out
電子ドラムの各インストにつき、演奏音をどのようなルートを通って外部出力するかを設定します。

EQ Tran Thru=
・EQ Thru の場合

・Tran Thru の場合

・Off の場合

分岐点の設定
[MIC/TRIG] →[F3] Setting →Kit →Inst .
→Inst Out →Effect Thru=On の場合、
[MIC/TRIG] →[F3] Setting →Kit →Inst .
→Inst Out →EQ Tran Thru の設定により、
以下3つのうちのいずれか1つの場所から
音の流れを分岐させることができます。

A
B

エフェクト結線図（トリガー入力）

電子ドラム部

音源パート1

　　：

音源パート2

音源パート24

音源パート3

トリガーごとの﻿
エフェクト

パートEQ

トランジェント.
コンプレッサー

インサーション.
エフェクト１

システム﻿
エフェクト

マスター﻿
エフェクト

・	リバーブ
・	 FX1
・	 FX2

・	マスター FX
・	マスター.
コンプレッサー

・	マスター EQ

*	1パート.
=1トリガー入力.
=1インスト(1パッド)

[MIC/TRIG] →[F3] Setting 
→Effect 

[MIC/TRIG] →[F3] Setting 
→Effect 

[MIC/TRIG] →[F3] Setting 
→Kit →Inst →Inst Out .
→IndivOut

[INDIVIDUAL OUTPUT]端子
・IndivOut 1/2
・IndivOut ３/4
・IndivOut 5/6
・IndivOut 7/8

USBオーディオの各チャ
ンネルは、IndivOutの設
定に従います。

[USB TO HOST]端子
・USB Audio Out 3/4
・USB Audio Out 5/6
・USB Audio Out 7/8
・USB Audio Out 9/10

AとBについては、以下のとおり、設定値の変更により連動します。
[MIC/TRIG] →[F3] Setting →Kit →Inst →Inst Out →Effect Thru=On の場合：Aオフ、Bオン
[MIC/TRIG] →[F3] Setting →Kit →Inst →Inst Out →Effect Thru=Off の場合：Aオン、Bオフ

Phones
EQ

[OUTPUT]端子
(Main Out)

[MENU] →Output 
→Phones EQ

[USB TO HOST]端子
(USB Audio Out 1/2)
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Page 1/2

パラメーター 説明 設定 初期値
EQ Tran Thru 電子ドラム各インスト(各トリガー入力)の演奏音につき、エフェク

ト結線の途中で分岐し、以降のエフェクトをバイパスして出力す
ることができます。ここではその分岐する場所を設定します。
•	Off：システムエフェクトに入る前で分岐します。
•	EQ Thru：パートEQに入る前で分岐します。
•	Tran Thru：トランジェントコンプレッサーに入る前に分岐します。

Off, EQ Thru, .
Tran Thru

プリセットシーン(Kit)で
は一律「Off」

Effect Thru 電子ドラム各インスト(各トリガー入力)の演奏音につき、本製品
のシステムエフェクト部およびマスターエフェクト部に通す(Off)/
通さない(On)を設定します。「On」を選択した場合は、「EQ Tran 
Thru」で選択した分岐点からの音をマスターエフェクト部の後ろ
のルートに通します。

Off, On

Main Out Effect Thruが「On」の場合のみ表示されます。「EQ Tran Thru」
で選択した分岐点からの音につき、[OUTPUT]端子から出力す
る(On)/出力しない(Off)を個別に設定します。

Off, On プリセットシーン(Kit)で
は一律「On」

Phones Out Effect Thruが「On」の場合のみ表示されます。「EQ Tran Thru」
で選択した分岐点からの音につき、[PHONES]端子から出力す
る(On)/出力しない(Off)を個別に設定します。

Off, On

USB Audio Out 
1/2

Effect Thruが「On」の場合のみ表示されます。「EQ Tran Thru」
で選択した分岐点からの音につき、[USB TO HOST]端子から
出力する(On)/出力しない(Off)を個別に設定します。

Off, On

Page 2/2

パラメーター 説明 設定 初期値
IndivOut 電子ドラムの各インスト(各トリガー入力)につき、エフェクト結線

図上の分岐点から、端子別/チャンネル別に分けて出力すること
ができます。
電子ドラムの各インストにつき、演奏音をINDIVIDUAL端子のど
こから出力させるかを設定します。

NOTE
IndivOut1-8はUSB Audio Outの3-10と連動しているので、ここ
での設定によりUSB Audio Out3-10の出力先も自動的に決まりま
す。例えばマイク1=L1+R2に設定したとしたら、マイク1の音はUSB 
Audio 3/4のルートでPCなどに出力されます。

Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8 
*	各設定値については、
93ページ下にある
表をご参照ください。

プリセットシーン(Kit)で
は一律「Off」

IndivOut Vol 電子ドラムの各インスト(各トリガー入力)につき、演奏音をエフェ
クト結線図の分岐点(106ページ)から出力する際の音量を調
節します。「Variable」に設定すると、音量は[MIC/TRIG]スライ
ダーの操作に連動します。

Variable, 1 ～ 127 プリセットシーン(Kit)で
は一律「Variable」
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[F3] Setting →Kit →Voice
本製品では、各トリガー入力ソース(各ゾーン)に対して4つのレイヤーが準備されており、各レイヤーにボイスを割り当てることで、複
数ボイスを重ねた重厚なサウンドを作れます。ここでは、各レイヤーへのボイスの割り当てや関連項目の設定を行います。

[F3] Setting →Kit →Voice →Voice
各レイヤーへのボイス割り当てやレイヤー間でどのようにボイスを重ねるかなど、演奏に直接かかわる設定を行います。

Page 1/6

パラメーター 説明 設定 初期値
Category 各レイヤーに割り当てるボイスにつき、カテゴリーを選択します。 ボイスリスト参照 シーン(Kit)での設定値
Number 各レイヤーに割り当てるボイスの番号を選択します。 ボイスリスト参照

Page 2/6

パラメーター 説明 設定 初期値
Volume 各レイヤーに割り当てたボイスの音量を設定します。 0～ 127 シーン(Kit)での設定値

Pan 各レイヤーに割り当てたボイスの定位(パン)を設定します。 L63～ C～ R63

Page 3/6

パラメーター 説明 設定 初期値
Tuning 各レイヤーに割り当てたボイスをチューニングします。 −24.0 ～ 0.0 ～ 

+24.0
シーン(Kit)での設定値

Attack 各レイヤーに割り当てたボイスにつき、アタックの速さ(パッドを
叩いてから発音時の最大レベルに到達するまでの速さ)を設定し
ます。値を小さくするほど音の立ち上がりが遅くなります。

−64 ～ 0 ～ +63

Decay 各レイヤーに割り当てたボイスにつき、ディケイタイム(発音時の
最大レベルから無音に減衰するまでの速さ)を設定します。値を
大きくするほど減衰が速くなります。

−64 ～ 0

Cutoff 各レイヤーに割り当てたボイスにかけるフィルターの、カットオフ
周波数を設定します。

−64 ～ 0 ～ +63

Resonance 各レイヤーに割り当てたボイスにかけるフィルターの、Q(フィル
ターレゾナンス)を設定します。フィルターのカットオフ周波数付
近の信号を持ち上げることにより、音にクセをつけます。

−64 ～ 0 ～ +63
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Page 4/6

パラメーター 説明 設定 初期値
Mono/Poly レイヤーごとに、パッドを続けて叩いたときの音の鳴り方を設定

します。
「Mono」に設定した場合は、同じパッドを続けて叩いたときに、後
から叩いて出た音が先に鳴っていた音を消します。「Poly」に設定
した場合は、先に鳴っていた音は消されずに最後まで鳴り切りま
す。

Mono, Poly シーン(Kit)での設定値

Choke Send レイヤーごとに、チョーク奏法の消音指示を送る側とする(1 ～ 64)
かしない(Off)かを設定します。
1 ～ 64に設定した場合は、発音時にChoke Receive で同じ番号
を設定したボイス(レイヤー )を消音することになります。

Off, 1 ～ 64

Choke Receive レイヤーごとに、チョーク奏法の消音指示を受ける側とする(1 ～
64)かしない(Off)かを設定します。1 ～ 64に設定した場合は、
Choke Send で同じ番号を設定したボイス(レイヤー )により消
音されることになります。

Off, 1 ～ 64

Humanize レイヤーごとに、同じパッドの連打時に発音が自然なばらつきに
なるよう(一定になりすぎないよう)にする(On)/しない(Off)かを
設定します。

Off, On

Fixed Velocity レイヤー別に、ボイス発音の音量を固定(1 ～ 127)にするか、叩
いた強さに応じた音量にするか(Off)を設定します。

Off, 1 ～ 127

Page 5/6

パラメーター 説明 設定 初期値
Hold Mode ボイスごとに、パッドを叩いたときの再生方法を設定します。

On： ﻿
パッドを叩くとループ再生が始まり、もう一度パッドを叩くとルー
プ再生が止まります。なお、パッドを叩くたびにMIDIキーオンと
キーオフを交互に出力します。
Off：﻿
ワンショット再生します。パッドを叩くとMIDIキーオンだけを出
力し、ゲートタイム経過後、自動的にキーオフを出力します。

Off, On シーン(Kit)での設定値

Layer Mode 各レイヤーに登録したボイスをどのように発音させるかを設定し
ます。
Stack： ﻿
パッドを叩くと、レイヤーに登録した全ボイスが同時に鳴ります。
Alt： ﻿
パッドを叩くごとに、レイヤーに登録した個々のボイスが順に鳴り
ます。

Stack, Alt
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Page 6/6

パラメーター 説明 設定 初期値
Velocity Limit 
Low
Velocity Limit 
High

現在選択されているレイヤーに対して、パッドが叩かれたときに反
応する強さ(ベロシティー )の範囲を設定します。

1～ 127 シーン(Kit)での設定値

Velocity Fade 
Low
Velocity Fade 
High

ベロシティーリミットの両端において、叩いた強さに応じて音量が
徐々にフェードイン/フェードアウトするよう、その度合いを設定し
ます。値が大きくなるほど、フェードイン/フェードアウトの度合い
が大きくなります。グラフの左端においてはVelLimitLo=0 とし
て、叩いた強さに応じて徐々に音量がフェードインします。グラフ
の右端においてはVelLimitHi=0として、叩いた強さに応じて音量
がフェードアウトします。

0～ 127



EAD50　ユーザーガイド 111

画面での設定項目(パラメーター)

M
od

ifi
er

 
ノ

ブ
[ M

IC
 / 

TR
IG

 ]
[ S

CE
NE

 ]
[ C

LIC
K 

]
[ R

EC
O

RD
ER

 ]
[ L

IV
E S

ET
 ]

[ M
EN

U 
]

M
ic

Tr
ig

ge
r

Ki
t

Ef
fe

ct
Re

co
rd

er
Lo

op
er

Sa
m

pl
in

g
Ut

ilit
y

O
ut

pu
t

Au
x 

In
US

B 
Au

dio
Bl

ue
to

ot
h

Fi
le

Ve
rs

io
n

LE
D 

ロ
ー

タ
リ

ー
フ

ェ
ー

ダ
ー

Fa
ct

or
y 

Re
se

t

[F3] Setting →Kit →Voice →Voice MIDI
パッドのMIDIメッセージに関する設定を、レイヤー A ～ Dそれぞれに行います。
[F1]TrigSelボタンを押して設定したいトリガー入力ソースおよびレイヤーを選んでから、設定します。

Page 1/4

パラメーター 説明 設定 初期値
Note Num 1～ 4 設定対象のパッドを叩いたときに出力するMIDIノートとチャンネ

ルを設定します。レイヤーごとに最大4つのMIDIノートを割り当
てて出力できます。また、レイヤー AのNote1に設定したMIDI
ノートとチャンネルを受信すると、該当するトリガー入力ソースの
トリガー信号が発生したとみなされます。

NOTE
「Global」を設定した場合は、[MENU] →Utility →MIDI Global 
Channel で設定した値がチャンネルとなります。

Off, 0 ～ 127 プリセットシーン(Kit)に
ついては「MIDI Note 
Map」を参照

Note Ch 1 ～ 4 Global, 1 ～ 16 プリセットシーン(Kit)で
は一律「Global」

Page 2/4

パラメーター 説明 設定 初期値
Note Port Note Ch1 ～ 4のMIDIポートを設定します。ポートを「2」に設

定した場合、[MIDI OUT]端子からは出力されません。
NOTE

「Global」を設定した場合は、[MENU] →Utility →MIDI Global 
Port で設定した値がポートとなります。

Global, 1 ～ 2 プリセットシーン(Kit)で
は一律「Global」

Note Gate Time パッドを叩いたときに出力する、MIDIノートオンからノートオフ
までの時間を設定します。

0.0 s ～ 9.9 s プリセットシーン(Kit)で
は一律「0.3 s」

Page 3/4

パラメーター 説明 設定 初期値
CC Number 
Note

本製品では、パッドを叩くことでコントロールチェンジメッセージ
を外部に送信できます。ここでは、設定対象パッドのコントロー
ルチェンジ番号を設定すると、該当パッドを叩いた強さ(ベロシ
ティー )がコントロールチェンジ値として出力されます。

Off, 0 ～ 127 プリセットシーン(Kit)で
は一律「Off」
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パラメーター 説明 設定 初期値
CC Number 
Position

本製品では、パッドを叩くことでコントロールチェンジメッセージ
を外部に送信できます。ここで設定対象パッドのコントロール
チェンジ番号を設定すると、該当パッドを叩いた位置によりコント
ロールチェンジ値が出力されます。MIDI送信は以下の場合に機
能します。
•	トリガー入力ソースがFoot1 ～ 2およびHH1 ～ 2の場合(トリ
ガー入力ソースの先頭かつレイヤー Aが使用されます)

•	位置検出機能対応のパッドタイプを接続/選択中([MIC/
TRIG] →[F3] Setting →Trigger →Trig In →Pad 
→Position=「On」)

また、ここで設定した番号のコントロールチェンジを受信すると、
その値でフットコントローラーを操作したことになる、またはボイ
スの位置検出を実行したことになり、それに応じて該当ボイスが
発音します。MIDI受信は以下の場合に機能します。
•	トリガー入力ソースがFoot1 ～ 2およびHH1 ～ 2の場合
•	位置検出機能対応のボイスを選択中の場合
NOTE
HH1 ～ 2では、OpBwの設定が全てのトリガー入力ソースに効果します。

Off, 0 ～ 127 プリセットシーン(Kit)で
は一律で以下のとおり。
・Foot1Src レイヤーA：4
・HH1OpBw レイヤーA：4
・その他：Off

CC Channel 各レイヤーにつき、コントロールチェンジメッセージを、どのMIDI
チャンネルで出力するかを設定します。
NOTE

「Global」を設定した場合は、[MENU] →Utility →MIDI Global 
Channel で設定した値がチャンネルとなります。

Global, 1 ～ 16 プリセットシーン(Kit)で
は一律「Global」

CC Port 各レイヤーにつき、コントロールチェンジメッセージを、どのMIDI
ポートで出力するかを設定します。ポートを「2」に設定した場合、
[MIDI OUT]端子からは出力されません。
NOTE

「Global」を設定した場合は、[MENU] →Utility →MIDI Global Port 
で設定した値がポートとなります。

Global, 1 ～ 2

Page 4/4

パラメーター 説明 設定 初期値
CC Min Value 各レイヤーにつき、パッドを弱く叩いたときのコントロールチェン

ジ値の最小値を設定します。MIDI送信のみ有効です。
0～ 127 プリセットシーン(Kit)で

は一律「0」

CC Max Value 各レイヤーにつき、パッドを強く叩いたときのコントロールチェン
ジ値の最大値を設定します。MIDI送信のみ有効です。

0～ 127 プリセットシーン(Kit)で
は一律「127」
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[F3] Setting →Kit →Voice →Voice Func
パッドを叩いたとき、ボイスを鳴らすだけでなく、キット番号やテンポを変えるなどの機能を各トリガー入力ソースに割り当てられま
す。[F1]TrigSelボタンを押してトリガー入力ソースを選んでから、割り当てたい機能を選択します。

選択可能な機能 説明 設定 初期値補助項目
Off 機能を割り当てません。 ー ー
Scene Select 指定のシーンが選択される機能が割り当てられます。

Scene 
Number

シーン番号を指定します。 P001～ P070, 
U001～U200

シーン(Function)での設
定値

Scene Inc シーンの次の番号を選択する機能が割り当てられます。 ー ー
Scene Dec シーンの1つ前の番号を選択する機能が割り当てられます。 ー ー
Scene Toggle 2つのシーンAとBが交互に切り替わる機能が割り当てられます。 ー ー

Scene 
Number A

シーン番号Aを指定します。 P001～ P070, 
U001～U200

シーン(Function)での設
定値

Scene 
Number B

シーン番号Bを指定します。 P001～ P070, 
U001～U200

Tempo Inc テンポ値が増える機能が割り当てられます。 ー ー
Value プラスされるテンポ値を設定します。 1～ 127 シーン(Function)での設

定値
Tempo Dec テンポ値が減る機能が割り当てられます。 ー ー

Value マイナスされるテンポ値を設定します。 1～ 127 シーン(Function)での設
定値

Tempo Tap パッドを叩く時間間隔を元にテンポが設定される機能が割り当て
られます。

ー ー

Tempo Control テンポを変更する機能が割り当てられます。 ー ー
Control 
Type

Velocity：最小値(Min Value) ～最大値(Max Value)の間で、
叩く強さに応じたテンポになります。
Volume：最小値(Min Value) ～最大値(Max Value)の間で、

フットコントローラー FC7の踏み込み量に応じたテンポになり
ます。
Toggle：叩くごとに最小値(Min Value)と最大値(Max Value)

が交互に切り替わります。
Hold A：フットスイッチを踏んでいる間またはパッドを強く叩いた

ときに最大テンポ値(Max Value)になります。フットスイッチ
を踏んでいない場合またはパッドを弱く叩いたときに最小テン
ポ値(Min Value)になります。
Hold B：Hold Aの逆です。

Velocity, Volume, 
Toggle, Hold A, 
Hold B

シーン(Function)での設
定値

Min Value この機能におけるテンポの最小値を設定します。 30.0 ～ 300.0
Max Value この機能におけるテンポの最大値を設定します。 30.0 ～ 300.0
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選択可能な機能 説明 設定 初期値補助項目
Modifier Control パネル左部にあるModifierノブ操作に該当する効果を、自在に

コントロールする機能が割り当てられます。
ー ー

Control 
Type

Velocity：最小値(Min Value) ～最大値(Max Value)の間で、
叩く強さに応じた効果になります。
Volume：最小値(Min Value) ～最大値(Max Value)の間で、

フットコントローラー FC7の踏み込み量に応じた効果になりま
す。
Toggle：叩くごとに最小値(Min Value)と最大値(Max Value)

が交互に切り替わります。
Hold A：フットスイッチを踏んでいる間またはパッドを強く叩い

たときに最大値(Max Value)になります。フットスイッチを踏
んでいない場合またはパッドを弱く叩いたときに最小値(Min 
Value)になります。
Hold B：Hold Aの逆です。

Velocity, Volume, 
Toggle, Hold A, 
Hold B

シーン(Function)での設
定値

Min Value この機能における効果の最小値を設定します。 0～ 127
Max Value この機能における効果の最大値を設定します。 0～ 127
Modifier1 ～ 6 ノブごとに本機能の有効(チェックマーク有)/無効(チェックマーク

無)を設定します。
各項目に対して、
・チェックマーク有
・チェックマーク無

Mic/Trig 
Control

各エフェクトのオン/オフおよび各チャンネル(マイク入力音および
トリガー音)のオン/オフを切り替える機能が割り当てられます。

ー ー

Control 
Type

オン/オフの切り替わり方を設定します。
Toggle：パッドを叩くごとに、各項目のオンとオフが交互に切り替

わります。
Hold A：フットスイッチを踏んでいる間はオン、踏んでいないとき

はオフになります。パッドをベロシティー 64以上で叩くとオン、
64未満で叩くとオフになります。
Hold B：Hold Aの逆です。

Toggle, Hold A, 
Hold B

シーン(Function)での設
定値

Reverb ～
Master EQ

エフェクトのオン/オフを切り替える(チェックマーク有)/切り替え
ない(チェックマーク無)を、エフェクトブロック別に設定します。

各項目に対して、.
・チェックマーク有.
・チェックマーク無

シーン(Function)での設
定値

Mic1～Mic5 マイク入力音のオン/オフを切り替える(チェックマーク有)/切り
替えない(チェックマーク無)を、マイク端子ごとに設定します。

各項目に対して、.
・チェックマーク有.
・チェックマーク無

Kick～Trig22 トリガー音のオン/オフを切り替える(チェックマーク有)/切り替え
ない(チェックマーク無)を、トリガー入力ソースごとに設定します。

各項目に対して、.
・チェックマーク有.
・チェックマーク無

プリセットシーン
(Function)では一律、
チェックマーク無
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選択可能な機能 説明 設定 初期値補助項目
Talk Control マイク入力の設定につき、トーク用に切り替えたり元に戻したりす

る機能を割り当てます。

	注意
トークを「On」にすると、マイクに関する様々な設定がトーク用の値に切
り替わります。特にゲイン値は上がりますので、トークを「On」にしたま
まドラム演奏をすると予想外の大音量になるおそれがあります。トー
クを「On」にしたまま演奏することがないよう十分ご注意ください。

ー ー

Control 
Type

Toggle：パッドを叩くごとに、トーク用に切り替わったり元に戻っ
たりします。
Hold A：フットスイッチを踏んでいる間はトーク用、踏んでいな

いときは元の状態(演奏用)になります。パッドをベロシティー
64以上で叩くとトーク用に、64未満で叩くと演奏用(元の状態)
に切り替わります。
Hold B：Hold Aの逆です。

Toggle, Hold A, 
Hold B

シーン(Function)での設
定値

Mic Input どのマイク端子をトーク用設定への切替対象にするか、選択します。 Mic1～ 5
Xstick Control 電子ドラムパッドのクロススティック([MIC/TRIG] →Trigger 

→Trig In →Pad →Xstick On/Off)につき、オン/オフを切り替
える機能を割り当てます。

ー ー

Control 
Type

Toggle：パッドを叩くごとに、電子ドラムのクロススティックのオ
ン/オフが切り替わります。
Hold A：フットスイッチを踏んでいる間はクロススティックオン、

踏んでいないときはオフになります。パッドをベロシティー 64
以上で叩くとクロススティックオンに、64未満で叩くとオフに
切り替わります。
Hold B：Hold Aの逆です。

Toggle, Hold A, 
Hold B

プリセットシーン
(Function)では一律、
「Toggle」

Kick, Snare, 
Trig3 ～ 5

各トリガー入力ソースにつき、クロススティックオン/オフの対象に
する(チェックマーク有)/しない(チェックマーク無)を設定します。

各項目に対して、.
・チェックマーク有.
・チェックマーク無

シーン(Function)での設
定値
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選択可能な機能 説明 設定 初期値補助項目
Sound Off 現在鳴っている全ての電子ドラム音(ボイス)を止める機能が割り

当てられます。
ー ー

Click Start/Stop クリック再生を開始/停止する機能が割り当てられます。 ー ー
Recorder 
Control A

以下機能が割り当てられます。
•	レコーダーの録音を開始/停止する機能
•	ルーパーの録音開始/再生開始を行う機能
•	サンプリングの録音開始/停止を行う機能

ー ー

Recorder 
Control B

以下機能が割り当てられます。
•	レコーダーのオーディオファイル再生を開始/停止する機能
•	ルーパーの再生停止/クリアを行う機能
•	サンプリングの再生開始/停止を行う機能

ー ー

Live Set Select 指定のライブセットが選択される機能が割り当てられます。 ー ー
Live Set 
Number

ライブセット番号を指定します。 U01～U50 シーン(Function)での設
定値

Live Set Inc ライブセットの次の番号を選択する機能が割り当てられます。 ー ー
Live Set Dec ライブセットの1つ前の番号を選択する機能が割り当てられます。 ー ー
Live Set Step 
Select

指定のライブセットステップが選択される機能が割り当てられます。 ー ー

Live Set Step 
Number

ライブセットステップ番号を指定します。 S01～ S50 シーン(Function)での設
定値

Live Set Step Inc 現在のライブセットにおいて、次のステップ番号を選択する機能
が割り当てられます。

ー ー

Live Set Step Dec 現在のライブセットにおいて、1つ前のステップ番号を選択する
機能が割り当てられます。

ー ー
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[F3] Setting →Kit →User Voice
トリガー音(トリガー信号を元に鳴らす電子音)につき、内蔵のボイスだけでなく、外部オーディオファイルを取り込むことでユーザーボ
イスを使う方法もあります。

NOTE
ユーザーボイスのメモリー構造については、26 ～ 27ページをご参照ください。

パラメーター 説明 
Import Wave オーディオファイルを読み込み、ユーザーボイスに割り当てます。

詳細は以下をご参照ください。
Edit Velocity 
Limit L/H

各ユーザーボイスにつき、ウェーブの鳴らし方を設定します。 
1つのユーザーボイスは10のウェーブバンクで構成されており、ベロシティーの範囲に応じて該当バンクの
ウェーブが鳴ります。操作方法は以下をご参照ください。

Sort Wave ユーザーボイス内のウェーブを自由に入れ替えます。操作方法は「基本操作」51ページをご参照ください。
Delete Wave 本製品にインポートされたウェーブを削除します。
WaveMem Info 本製品のインポート用ウェーブメモリーの使用状況を表示します。

	■ Import Wave(外部オーディオファイルを本製品に読み込む)
File to Bank(ユーザーボイスのバンクに読み込む)
●1つのファイルを1つのバンクに読み込む
1つのバンクに1つのオーディオファイルを読み込めます。

1.	 USBフラッシュメモリーまたは
SDカード上にあるオーディオ
ファイルを選択します。

2.	 読み込み先のユーザーボイスと
バンクを選択します。

3.	「ENTER]ボタンを押して、
読み込みを実行します。

[Alt]ボタン×2回 [Alt]ボタン×2回選択されたオーディオ
ファイルを再生します。

[Alt]ボタン

読み込み先のユーザーボイス
につき、名称設定ができます。

読み込み先のユーザーボイス
バンクにつき、名称設定ができ
ます。

読み込み先になったことを示す
チェックマーク

「User Audio 1」が読み込み対
象になったことを示すチェック
マーク

「Completed」が表
示されたら読み込
み完了です。

「Completed」が表
示されたら読み込
み完了です。

「Completed」が表
示されたら読み込
み完了です。

手順1～ 3
を繰り返し
ます。

1.	 読み込みたいファイルを
選択します。

2.	 読み込みたい先のユーザー
ボイス/バンクを選択します。

4.	 手順1～3を繰り返したあと、
[ENTER]ボタンを押して読み
込みを実行します。

3.	 [F1] Check ボタンを押すと、
ファイルにチェックマークがつき
ます。

●複数ファイルを複数バンクにまとめて読み込む
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	■ Import Wave(外部オーディオファイルを本製品に読み込む)
Files to Voices(ユーザーボイスに読み込む)
外部メモリー (USBフラッシュメモリーまたはSDカード) のルートディレクトリーにある全オーディオファイルを、ソートされた状態で、
空のユーザーボイスの小さい番号から順に1つずつ、一括で読み込みます。

「Completed」が表
示されたら読み込
み完了です。

Files by Name(ファイル名に沿って順に読み込む)
あらかじめオーディオファイル名を整備しておくことにより、ワンタッチでお好みの状態にオーディオファイルを読み込めます。

1.	 コンピューターなどでオーディオファイルの名前を整
備します。例えば、ユーザーボイス001のバンク01～
06に読み込みたい場合は以下のようにネーミングして
おきます。

2.	 手順1で準備したファイルの入ったUSBフラッシュメモ
リーまたはSDカードを本製品に接続します。

3.	 本画面を表示します。.
[MIC/TRIG]→[F3] Setting →Kit →User Voice 
→Import Wave→Files by Name 

4.	 [ENTER]ボタンを押すと、読み込み中であることを示
すメッセージ「Now importing…」が表示されたあと、
読み込みが完了します。

5.	 以下画面にて、読み込み状況を確認します。.
[MIC/TRIG]→[F3] Setting→Kit →User Voice 
→Sort Wave

	■ Edit Velocity Limit L/H(ベロシティーの範囲をバンクごとに設定する)
バンクごとに個別に設定する

現在選択されているバンク
を鳴らします。

割り当てられたオーディオファイルが、ベロシティー
の範囲ごとに個別に鳴るよう、設定を[F1]ボタンの
ワンタッチだけで行います。

各バンクのベロシティー範囲を
ご確認ください。

ここにカーソルを移動し、ベロシティーの
範囲(最小値/最大値)を設定します。

ユーザーボイス番号、バンク番号を
選択します。

ご注意
ここでの設定は電源をオフする前に、必ず[ENTER]ボタンで保存してください。
保存操作をせずに電源をオフすると設定が失われるので、ご注意ください。
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	■ Delete Wave(ウェーブの削除)
本製品にインポートされたウェーブを、バンクごとに削除します。

1.
[+][−]ボタン/ノブでユーザー
ボイスを選択します。

2.
[F3]ボタンで、カーソルをバンク
の列に移動します。

3.
[F2][F3]ボタンで、削除したい
バンクにカーソルを移動します。

4.
[F1] Yesボタンでデリート(削除)
を実行します。

カーソル位置に該当するバンクに割り当て
られたウェーブを聞けます。

「Completed」
が表示されたら
完了です。

バンクの列ユーザーボイス

	■WaveMem Info(ウェーブメモリーの使用状況)

「Completed」が表示された
ら完了です。

[F1] Optim. ﻿
(ウェーブメモリーの最適化)

本製品のウェーブメモリーを最適化します。.
最適化とは、メモリー領域を整理し直すことで、
メモリーの有効活用領域を拡大する作業のこ
とです。メモリーが断片化していると、空き容
量が十分あってもオーディオファイルがイン
ポートできない場合があります。そのような
場合に本機能を使えば、連続した空き容量が増
え、問題を解消できます。
[F1]ボタンを押すと、確認画面が表示されるの
で、[F1] YESボタンを押すことで最適化を実
行します。

[F3] Format ﻿
(ウェーブメモリーのフォーマット)

本製品のウェーブメモリーをフォーマットしま
す。フォーマットを実行すると、ウェーブメモ
リーに保存されているすべてのデータは削
除されます。
[F3]ボタンを押すと、確認画面が表示される
ので、[F1] YESボタンを押すことで最適化
を実行します。

ウェーブメモリー
使用量

ウェーブメモリー
全体量
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[F3] Setting →Effect
マイク端子からの入力音やトリガー端子からの入力信号にもとづくボイス音(音源パート)にかける、エフェクトに関する設定です。本
製品のエフェクト結線図については、21ページ、92ページ、106ページをご参照ください。

[F3] Setting →Effect →Reverb
本製品に3つ搭載されている「システムエフェクト」(23ページ)の1つであるリバーブに関する設定を行います。

Page 1/4

パラメーター 説明 設定 初期値
On/Off リバーブをかける(On)・かけない(Off)を設定します。 Off, On プリセットシーン(Effect)

では一律「On」
Category リバーブタイプのカテゴリーを選択します。 エフェクトタイプリスト

参照
シーン(Effect)での設定値

Type リバーブタイプを選択します。 エフェクトタイプリスト
参照

Send All 本製品で鳴らされるサウンド全パートの音につき、一律にリバーブ
エフェクトに送る量(センドレベル)を設定します。

0～ 127

Page 2/4

パラメーター 説明 設定 初期値
Send Mic マイク端子からの入力音につき、リバーブエフェクトに送る量(セ

ンドレベル)を端子別に設定します。
0～ 127 シーン(Effect)での設定値

Send Mic Curve マイク端子からの入力音につき、音量に応じてどの程度のセンド
レベルでリバーブエフェクトへ送るかのカーブを、端子別に選択
します。

C1～ C7

Send Trig トリガー端子からの入力信号にもとづいて鳴っているボイス音
(音源パート)につき、リバーブエフェクトへの送り量(センドレベ
ル)をトリガー入力別に設定します。

0～ 127

Send Trig Curve トリガー端子からの入力信号にもとづいて鳴っているボイス音(音
源パート)につき、入力信号量に応じてどの程度のセンドレベルで
リバーブエフェクトへ送るかのカーブを、トリガー入力別に選択し
ます。

C1～ C7

Page 3/4

パラメーター 説明 設定 初期値
Return リバーブエフェクトで処理された音信号のリターンレベルを、全

パート一律に設定します。
0～ 127 シーン(Effect)での設定値

IndivOut リバーブエフェクトで生成されたウェット音だけを、個別に出力す
ることができます。ここではその出力先を設定します。

Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8 

プリセットシーン(Effect)
では一律「Off」

Return IndivOut 上記で設定された出力先への音信号のレベルを設定します。 0～ 127 プリセットシーン(Effect)で
は一律「0」
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Page 4/4以降

パラメーター 説明 設定 初期値
パラメーター群.
(エフェクトタイプ
により異なる)

現在のリバーブタイプに属する様々なパラメーター (項目)を調
整します。

エフェクトタイプリスト
参照

シーン(Effect)での設定値

[F3] Setting →Effect →Real Ambi
各トリガーソースにつき、Real Ambi に関する設定を行います。トリガーソースに割り当てられているインスト(ボイス)がリアルアン
ビエンス(13ページ)に対応している場合のみ有効な設定項目です。

パラメーター 説明 設定 初期値
On/Off 現在選択中のシーンに含まれるキットの中でリアルアンビエンス

に対応しているインストにつき、リアルアンビエンスの波形を活
用する(On)かしない(Off)かを選択します。

Off, On プリセットシーン(Effect)
では一律「On」

Depth All 全トリガー入力につき、一律でリアルアンビエンスの深さを設定
します。

0～ 127 シーン(Effect)での設定値

Depth Trig 各トリガー入力につき、入力信号にもとづいて鳴っているボイス
のリアルアンビエンスの深さを設定します。

0～ 127

Depth Trig 
Curve

各トリガー入力につき、リアルアンビエンスの深さを入力信号の
レベルに応じてどの程度とするか、7種類のカーブの中から選択
します。

C1～ C7

[F3] Setting →Effect →FX1
本製品に3つ搭載されている「システムエフェクト」(23ページ)の1つであるFX1に関する設定を行います。

Page 1/4

パラメーター 説明 設定 初期値
On/Off FX1をかける(On)・かけない(Off)を設定します。 Off, On プリセットシーン(Effect)

では一律「On」
Category FX1タイプのカテゴリーを選択します。 エフェクトタイプリスト

参照
シーン(Effect)での設定値

Type FX1タイプを選択します。 エフェクトタイプリスト
参照

Send All 本製品で鳴るサウンド全パートの音につき、一律にFX1エフェクト
に送る量(センドレベル)を設定します。

0～ 127

Page 2/4

パラメーター 説明 設定 初期値
Send Mic マイク端子からの入力音につき、FX1エフェクトに送る量(センド

レベル)を端子別に設定します。
0～ 127 シーン(Effect)での設定値

Send Mic Curve マイク端子からの入力音につき、音量に応じてどの程度のセンドレ
ベルでFX1エフェクトへ送るかのカーブを、端子別に選択します。

C1～ C7

Send Trig トリガー端子からの入力信号にもとづいて鳴っているボイス音に
つき、FX1エフェクトへの送り量(センドレベル)をトリガー入力別
に設定します。

0～ 127

Send Trig Curve トリガー端子からの入力信号にもとづいて鳴っているボイス音に
つき、入力信号量に応じてどの程度のセンドレベルでFX1エフェク
トへ送るかのカーブを、トリガー入力別に選択します。

C1～ C7
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Page 3/4

パラメーター 説明 設定 初期値
Send to Reverb FX1で処理された音のリバーブへのセンドレベルを、全チャンネ

ル一律で設定します。
0～ 127 シーン(Effect)での設定値

Return FX1で処理された音のリターンレベルを、全チャンネル一律に設
定します。

0～ 127

IndivOut FX1で生成されたウェット音だけを、個別に出力することができま
す。ここではその出力先を設定します。

Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8 

プリセットシーン(Effect)
では一律「Off」

Return IndivOut 上記で設定された出力先への音信号のレベルを設定します。 0～ 127 プリセットシーン(Effect)
では一律「0」

Page 4/4

パラメーター 説明 設定 初期値
パラメーター群.
(エフェクトタイプ
により異なる)

現在のFX1タイプに属する様々なパラメーター (項目)を調整し
ます。

エフェクトタイプリスト
参照

シーン(Effect)での設定値

[F3] Setting →Effect →FX2
本製品に3つ搭載されている「システムエフェクト」(23ページ)の1つであるFX2に関する設定を行います。
設定項目は、以下画面と同じです。
[F3] Setting →Effect →FX1

[F3] Setting →Effect →Dry
マイク端子・トリガー端子からの入力音のうち、「システムエフェクト」を経由させない音(ドライ音)に関する設定を行います。

Page 1/2

パラメーター 説明 設定 初期値
On/Off 「On」に設定すると、音をシステムエフェクトに経由させないルー

トが有効になります。
「Off」に設定すると、ドライ音が出なくなります。(Level All＝0と
同等の効果です。)

Off, On プリセットシーン(Effect)
では一律「On」

Level All マイク端子・トリガー端子からのすべての入力音につき、システム
エフェクトに送らない量を設定します。「０」に設定した場合は、ドラ
イ音が出なくなります。(Dry=Off と同等の効果です。)	

0～ 127 シーン(Effect)での設定値



EAD50　ユーザーガイド 123

画面での設定項目(パラメーター)

M
od

ifi
er

 
ノ

ブ
[ M

IC
 / 

TR
IG

 ]
[ S

CE
NE

 ]
[ C

LIC
K 

]
[ R

EC
O

RD
ER

 ]
[ L

IV
E S

ET
 ]

[ M
EN

U 
]

M
ic

Tr
ig

ge
r

Ki
t

Ef
fe

ct
Re

co
rd

er
Lo

op
er

Sa
m

pl
in

g
Ut

ilit
y

O
ut

pu
t

Au
x 

In
US

B 
Au

dio
Bl

ue
to

ot
h

Fi
le

Ve
rs

io
n

LE
D 

ロ
ー

タ
リ

ー
フ

ェ
ー

ダ
ー

Fa
ct

or
y 

Re
se

t

Page 2/2

パラメーター 説明 設定 初期値
Level Mic マイク端子からの入力音につき、ドライレベル(システムエフェク

トを経由させない量)を端子別に設定します。
0～ 127 シーン(Effect)での設定値

Level Mic Curve マイク端子からの入力音につき、音量に応じてどの程度のドライレ
ベル(システムエフェクトを経由させない量)とするかのカーブを、
端子別に選択します。

C1～ C7

Level Trig トリガー端子からの入力信号にもとづいて鳴っているボイス音に
つき、ドライレベル(システムエフェクトを経由させない量)をトリ
ガー入力別に設定します。

0～ 127

Level Trig Curve トリガー端子からの入力信号にもとづいて鳴っているボイス音につ
き、音量に応じてどの程度のドライレベル(システムエフェクトを経
由させない量)とするかのカーブを、トリガー入力別に選択します。

C1～ C7

[F3] Setting →Effect →Ins1 Mic
本製品では、マイク端子からの入力音に対して2系統のインサーションエフェクト(22ページ)をかけられます。ここではインサー
ション1のエフェクトに関する設定を、端子別に行います。

Page 1/2

パラメーター 説明 設定 初期値
On/Off マイク音にインサーションエフェクト1をかける(On)/かけない

(Off)を、端子別に設定します。Offの場合、Type=Thruと同等
の効果になります。

Off, On プリセットシーン(Effect)
では一律「On」

Category インサーション1につき、エフェクトタイプのカテゴリーを選択し
ます。

エフェクトタイプリスト
参照

シーン(Effect)での設定値

Type インサーション1につき、エフェクトタイプを選択します。 エフェクトタイプリスト
参照

Depth エフェクトのかけ具合(深さ)を設定します。この値を変更すると、
パラメーター (設定項目)群の一部の値が自動的に変更されます。

0～ 127

Page 2/2

パラメーター 説明 設定 初期値
パラメーター群
(インサーションエ
フェクトタイプによ
り異なる)

現在のインサーションエフェクト1タイプに属する様々なパラ
メーター (設定項目)の値を調整します。

エフェクトタイプリスト
参照

シーン(Effect)での設定値

[F3] Setting →Effect →Ins2 Mic
本製品では、マイク端子からの入力音に対して2系統のインサーションエフェクト(22ページ)をかけられます。ここではインサー
ション2のエフェクトに関する設定を、端子別に行います。
設定項目は、以下画面と同じです。
[F3] Setting →Effect →Ins1 Mic
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[F3] Setting →Effect →Ins Trig
トリガー端子からの入力信号にもとづき鳴っているボイス音に対して、1系統のインサーションエフェクト(22ページ)をかけられま
す。

Page 1/2

パラメーター 説明 設定 初期値
On/Off トリガー端子からの入力信号にもとづき鳴っているボイス音に、

インサーションエフェクトをかける(On)/かけない(Off)を、トリ
ガー入力別に設定します。Offの場合、Type=Thruと同等の効
果になります。

Off, On プリセットシーン(Effect)
では一律「On」

Category トリガー入力別に、エフェクトタイプのカテゴリーを選択します。 エフェクトタイプリスト
参照

シーン(Effect)での設定値

Type トリガー入力別に、エフェクトタイプを選択します。 エフェクトタイプリスト
参照

Depth トリガー入力別に、エフェクトのかけ具合(深さ)を設定します。 0～ 127

Page 2/2

パラメーター 説明 設定 初期値
パラメーター群
(インサーションエ
フェクトタイプによ
り異なる)

トリガー入力別に、現在のエフェクトタイプに属する様々なパラ
メーター (項目)を調整します。

エフェクトタイプリスト
参照

シーン(Effect)での設定値

[F3] Setting →Effect →Master FX
本体サウンド全体に対して一律にかけるエフェクトです。

Page 1/3

パラメーター 説明 設定 初期値
On/Off マスターエフェクトをかける(On)/かけない(Off)を設定します。

Offの場合、Type=Thruと同等の効果になります。
Off, On プリセットシーン(Effect)

では一律「On」

Category マスターエフェクトタイプのカテゴリーを選択します。 エフェクトタイプリスト
参照

シーン(Effect)での設定値

Type マスターエフェクトタイプを選択します。 エフェクトタイプリスト
参照

Depth マスターエフェクトのかけ具合(深さ)を設定します。 0～ 127

Page 2/3

パラメーター 説明 設定 初期値
Depth Curve 全体サウンドの量に応じて、マスターエフェクトの深さをどの程度と

するかのカーブを選択します。
C1～ C7 シーン(Effect)での設定値

Page 3/3

パラメーター 説明 設定 初期値
パラメーター群.
(エフェクトタイプ
により異なる)

現在のエフェクトタイプに属する様々なパラメーター (項目)を調
整します。

エフェクトタイプリスト
参照

シーン(Effect)での設定値
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[F3] Setting →Effect →Master Comp
本製品のサウンド全体に対して一律にかけるコンプレッサーです。

Page 1/3

パラメーター 説明 設定 初期値
On/Off マスターコンプレッサーをかける(On)/かけない(Off)を設定しま

す。Offの場合、Type=Thruと同等の効果になります。
Off, On プリセットシーン(Effect)

では一律「On」

Category マスターコンプレッサータイプのカテゴリーを選択します。 エフェクトタイプリスト
参照

シーン(Effect)での設定値

Type マスターコンプレッサータイプを選択します。 エフェクトタイプリスト
参照

Depth マスターコンプレッサーのかけ具合(深さ)を設定します。 0～ 127

Page 2/3

パラメーター 説明 設定 初期値
Depth Curve 全体サウンドの量に応じて、マスターコンプレッサーの深さをど

の程度とするかのカーブを選択します。
C1～ C7 シーン(Effect)での設定値

Page 3/3

パラメーター 説明 設定 初期値
パラメーター群.
(エフェクトタイプ
により異なる)

現在のコンプレッサータイプに属する様々なパラメーター(項目)
を調整します。

エフェクトパラメーター
リスト参照

シーン(Effect)での設定値

[F3] Setting →Effect →Master EQ
本製品のサウンド全体に対して一律にかける5バンドのイコライザー (EQ)です。

NOTE
イコライザー (EQ)については、25ページの図解をご参照ください。

Page 1/6

パラメーター 説明 設定 初期値
On/Off マスター EQをかける(On)/かけない(Off)を設定します。Offの

場合、Type=Thruと同等の効果になります。本製品ではマス
ター EQのためにタイプを準備しておらず、各設定項目を調整す
ることでお好みのサウンドに仕上げます。

Off, On プリセットシーン(Effect)
では一律「On」

Page 2/6

パラメーター 説明 設定 初期値
Low Freq EQ低域の中心周波数を設定します。 32 Hz ～ 2.0 kHz シーン(Effect)での設定値
Low Gain EQ低域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
Low Q EQ低域のQ(周波数特性)を設定します。

Low Shapeが「LowShelving」に設定されている場合、Low Q
の値は効果しません。

0.1 ～ 12.0

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip
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Page 3/6

パラメーター 説明 設定 初期値
MidLow Freq EQ中低域の中心周波数を設定します。 100 Hz ～ 10.0 kHz シーン(Effect)での設定値
MidLow Gain EQ中低域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
MidLow Q EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0

Page 4/6

パラメーター 説明 設定 初期値
Mid Freq EQ中域の中心周波数を設定します。 100 Hz ～ 10.0 kHz シーン(Effect)での設定値
Mid Gain EQ中域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
Mid Q EQ中域のQ(周波数特性)を設定します。 0.1 ～ 12.0

Page 5/6

パラメーター 説明 設定 初期値
MidHigh Freq EQ中高域の中心周波数を設定します。 100 Hz ～ 10.0 kHz シーン(Effect)での設定値
MidHigh Gain EQ中高域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
MidHigh Q EQ中高域のQ(周波数特性)を設定します。 0.1 ～ 12.0

Page 6/6

パラメーター 説明 設定 初期値
High Freq EQ高域の中心周波数を設定します。 500 Hz ～ 16.0 kHz シーン(Effect)での設定値
High Gain EQ高域のゲイン量を設定します。 −12 dB ～ 0 dB ～ 

+12 dB
High Q EQ高域のQ(周波数特性)を設定します。 

High Shapeが「HighShelving」の場合、High Qの値は効果し
ません。

0.1 ～ 12.0

High Shape EQ高域の周波数特性の形状を選択します。 HighShelving, 
PeakDip
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[F3] Setting →Effect →Effect Out
システムエフェクト/マスターエフェクトの処理を終えた演奏音をどのように出力するかを設定します。

パラメーター 説明 設定 初期値
Main Out システムエフェクト/マスターエフェクトの処理を終えた演奏音に

つき、[OUTPUT]端子から出力する(On)/しない(Off)を選択し
ます。

Off, On プリセットシーン(Effect)
では一律「On」

Phones Out システムエフェクト/マスターエフェクトの処理を終えた演奏音に
つき、[PHONES]端子から出力する(On)/しない(Off)を選択し
ます。

Off, On

USB Audio 
Out1/2

システムエフェクト/マスターエフェクトの処理を終えた演奏音に
つき、[USB TO HOST]端子から出力する(On)/しない(Off)を
選択します。

Off, On
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[CLICK] 
クリックの再生や関連する設定を行う画面です。

NOTE
図におけるF1 ～ F6の「F」および「Alt」は、F＝
Function(機能)および Alt=Alternate(切替)
の意味で、操作説明のために便宜的につけた
ボタン名称です。製品本体には印字されてい
ません。 

テンポ(BPM)値を0.1ずつ増減します。
なお、[+][−]ボタン/ノブで1ずつ増減します。

1番め 2番め

クリックのテンポ設定/再生/停止　

F1 F2 F3 F1 F2 F3

クリック停止中 クリック再生中

F1 F2 F3 F1 F2 F3

クリック停止中 .
(タイマー設定時）

クリック再生中
(タイマー設定時)

タイマーとしてカウントダウンします。以下画面により設定された
タイマー表示 
[CLICK] →[F3] Setting 
→Click →Timer

タイマーを30秒延長します。

[+] [−]ボタンおよびノブ
クリックのテンポ(BPM)値を1単位で設定します。
[設定] 30.0 ～ 300.0  [初期値] シーン「Tempo」への登録値

[F4] [F6]
クリックのテンポ(BPM)値を0.1単位で設定します。
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[F1] Tap
任意の速さで[F1]ボタンを押す、または電子ドラムパッドを叩くことで、テンポ(BPM)値を設定します。曲やフレーズのビートに合わ
せてボタンまたはパッドを叩くと、クリックが好みのテンポに設定されます。

1.	 [F1]ボタンを押すと、[F1]ボタンの
該当表示がタップ専用のアイコンに
切り替わります。

2.	 [F1]ボタンを3回以上叩くと、その叩
いた時間間隔によりテンポ値が設定
されます。

3.	 [F1]ボタンまたはパッドを最後に叩いてから
3秒以上経過すると、元の画面に戻りテンポ
値が確定します。3秒経過する前に[EXIT]ボ
タンを押すことでも、画面はもとに戻りテン
ポ値は確定します。

[F1]ボタンの該当表示は、[F1]ボタン
またはパッドを叩く度にアイコンが変化
します。

[F2] [F5] 
クリックを再生したり停止したりします。

NOTE
パッドを叩くことで、クリック以外の画面表示中でもクリックの再生/停止ができます。設定は以下画面で行います。
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice Func →Click Start/Stop

NOTE
上記の操作とは別に、以下画面で設定されたトリガー入力ソースに該当するパッドを叩くことで、テンポ(BPM)値を設定
することもできます。この方法は、クリック以外の画面表示中でも有効です。
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice Func →Tempo Tap
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クリック関連の設定　

[F3] Setting
クリックに関する様々な設定を行う画面に移動します。

[F3] Setting →Click
クリック音に関して設定します。

Page 1/4

パラメーター 説明 設定 初期値
Volume クリックの音量を設定します。 0～ 127 プリセットシーン(Click)

では一律「100」
Voice Set クリックの音色を選択します。 Metronome1, 

Metronome2, 
Claves, Cowbell, 
Shaker, Stick

プリセットシーン(Click)で
は一律「Metronome1」

Beat クリックの拍子(アクセントを何拍ごとに入れるか)を設定します。 1/4～ 16/4, 1/8
～ 16/8, 1/16～
16/16

プリセットシーン(Click)
では一律「4/4」

Human Voice クリック音を鳴らしながら人間の声でカウントする機能です。例
えば本製品が4拍子に設定されている場合、ここを「1」に設定
すると全部の拍で「1,2,3,4」の音が繰り返され、「2」に設定すると

「1,2,3,4」→ 「2,2,3,4」→「3,2,3,4」→「4,2,3,4」の音が繰り返
されます。

Off, 1, 2 プリセットシーン(Click)
では一律「Off」

Human Volume 「Human Voice」の音量を設定します。 0～ 127 プリセットシーン(Click)
では一律「100」

Page 2/4

パラメーター 説明 設定 初期値
Timer クリックを鳴らす時間を30秒単位で指定し、タイマーとして使え

ます。時間を決めて練習したいときに便利です。ここでの設定
値は、クリックトップ画面のテンポ値の下に表示されます。クリッ
クをスタートすると[F3]ボタンが「+30sec」の表示になり、押す
ことによりタイマー値が30秒延長されます。

Off, 00:30 ～ 60:00 プリセットシーン(Click)
では一律「Off」

Count Off 実際に演奏を始める前のカウントにクリック再生を活用できま
す。その場合、「1」または「2」に設定してください。「1」に設定す
ると、クリック音は1小節だけ鳴って止まります。「2」に設定する
と、クリック音は2小節だけ鳴って止まります。
停止操作をするまでクリック音を鳴らし続けたい場合は、「Off」に
設定します。

Off, 1, 2
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パラメーター 説明 設定 初期値
Recorder Sync レコーダー機能でのオーディオファイル再生と同期をとる(On)

か、とらない(Off)かを選択します。
「On」に設定すると、オーディオファイル再生開始と同時にクリッ
クは同期再生されます。別途、オーディオファイルに合ったテ
ンポ設定や、「Offset Time」による再生開始タイミングの調整、

「Pre Count」の設定が必要です。

Off, On プリセットシーン(Click)
では一律「Off」

Pre Count Recorder Sync=On の場合のみ表示されます。オーディオファ
イル再生前に鳴らすプリカウントの小節数を設定します。

「Off」に設定すると、プリカウントは鳴りません。
「1」または「2」に設定すると、クリックが1小節または2小節再生し
たあと、オーディオファイルの再生が始まりクリックの再生もその
まま継続されます。

「1 (Stop)」または「2 (Stop)」に設定すると、クリックが1小節また
は2小節再生したあと、オーディオファイルの再生が始まり、クリッ
クの再生は止まります。

Off, 1, 1 (Stop), 2, 
2 (Stop)

Offset Time Recorder Sync=On の場合のみ表示されます。
レコーダー機能でのオーディオファイル再生(実際に音が鳴り始
めるタイミング)とクリック音との同期をとりたい場合に、そのず
れ時間を設定します。
オーディオファイルの先頭から実音の1拍目が鳴るまでの時間を
セットしておくことで、クリック音とのズレを無くします。ここでの
設定値を基準にクリックの1拍目のタイミングが決まり、これを元
にクリックのプリカウントが付加されます。

0 ms～.
99 sec 999 ms

プリセットシーン(Click)
では一律「0 ms」

Page 3/4

パラメーター 説明 設定 初期値
Category 拍子の分解能（音符）ごとに、クリックのボイスを選択できます。

ここでは、ボイスカテゴリーを選択します。[F1] NoteSelボタ
ンを押すと、画面右上にある分解能(音符)の表示が切り替わるの
で、それぞれ個別にボイスカテゴリーを選択します。
NOTE
[F1] NoteSelボタンで選択できる音符は、拍子(Beat)の設定により異
なります。
•	 Beat=1/4 ～ 16/4の場合：Accent, 4th, 8th, 16th, 8thTriplet
•	 Beat=1/8 ～ 16/8の場合：Accent, Dotted4th, 8th, 16th, 

8thTriplet (「Dotted 4th」はBeat=3/8, 6/8, 9/8, 12/8, 15/8の
場合のみ有効)

•	 Beat=1/16 ～ 16/16の場合：Accent, 4th, 8th, 16th, 8thTriplet

ボイスリストをご参照
ください。

シーン(Click)での設定値

Number クリックをどのボイスで鳴らすかを、拍子の分解能別(音符別)に
選択できます。ここでは、現在のボイスカテゴリーの中から使い
たいボイスを選択します。[F1] NoteSelボタンを押すと、画面
右上にある分解能(音符)の表示が切り替わるので、それぞれ個別
にここでの選択を行います。

ボイスリストをご参照
ください。

シーン(Click)での設定値
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パラメーター 説明 設定 初期値
Import Wave USBフラッシュメモリーまたはSDカードから、クリック用のウェー

ブファイルを拍子の分解能別(音符別)に読み込みます。
1.	「Import Wave」にカーソルがある状態で[ENTER]ボタンを

押します。
2.	[F1] NoteSelボタンで、ウェーブファイルを割り当てたい分

解能(音符)を選択します。
3.	[+][−]ボタン/ノブで、USBフラッシュメモリー上またはSD

カード上にあるオーディオファイルから1つを選択します。必
要に応じて、[F3] ボタンでオーディオファイルを視聴しま
す。

4.	[ENTER]ボタンを押します。
5.	「Are You Sure?」と表示されるので、[F1] Yesボタンを押

し、ファイルを読み込みます。

— —

Page 4/4

パラメーター 説明 設定 初期値
Note Volume クリック用に選択した各ボイスの音量を、拍子の分解能別(音符

別)に調節します。分解能(音符)は、[F1] NoteSelボタンで選
択します。

0～ 127 プリセットシーン(Click)
では一律「100」

Note Pan クリック用に選択した各ボイスのパン(ステレオ定位)を、拍子の
分解能(音符)別に調節します。分解能(音符)は、[F1] NoteSel
ボタンで選択します。

L63～ C～ R63 プリセットシーン(Click)
では一律「C」

Note Tuning クリック用に選択した各ボイスを、拍子の分解能(音符)別に
チューニングします。分解能(音符)は、[F1] NoteSelボタンで
選択します。

−24.0 ～ 0.0 ～ 
+24.0

プリセットシーン(Click)
では一律「0.0」

[F3] Setting →Click →Click EQ
クリック再生音のイコライザー (EQ)を設定します。

NOTE
イコライザー (EQ)については、25ページの図解をご参照ください。

Page 1/6

パラメーター 説明 設定 初期値
On/Off クリック再生音にEQをかける(On)か、かけない(Off)かを設定し

ます。
「Off」に設定した場合は各周波数域のゲイン=0、およびHPF 
Freq=Thru と同等の効果になります。

Off, On プリセットシーン(Click)
では一律「Off」
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Page 2/6

パラメーター 説明 設定 初期値
Low Freq EQ低音域の中心周波数を設定します。 32 Hz ～ 2.0 kHz プリセットシーン(Click)

では一律「125 Hz」
Low Gain Low Freqで設定した周波数付近の信号をブースト/カットします。 −12 dB ～ 0 dB ～ 

+12 dB
プリセットシーン(Click)
では一律「0 dB」

Low Q EQ低域のQ(周波数特性)を設定します。Low Shapeが
「LowShelving」に設定されている場合、Low Qの値は効果し
ません。

0.1 ～ 12.0 プリセットシーン(Click)
では一律「0.9」

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip

プリセットシーン(Click) 
では一律「LowShelving」

Page 3/6

パラメーター 説明 設定 初期値
MidLow Freq EQの中低音域の中心周波数を設定します。 100 Hz ～ 10.0 kHz プリセットシーン(Click)

では一律「500 Hz」

MidLow Gain MidLow Freqで設定した周波数付近の信号をブースト/カットし
ます。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(Click)
では一律「0 dB」

MidLow Q EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン(Click)
では一律「0.9」

Page 4/6

パラメーター 説明 設定 初期値
MidHigh Freq EQの中高域の中心周波数を設定します。 100 Hz ～ 10.0 kHz プリセットシーン(Click)

では一律「4.0 Hz」
MidHigh Gain MidHigh Freqで設定した周波数付近の信号をブースト/カットし

ます。
−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(Click)
では一律「0 dB」

MidHigh Q EQ中高域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン(Click)
では一律「0.9」

Page 5/6

パラメーター 説明 設定 初期値
High Freq EQの高域の中心周波数を設定します。 500 Hz ～ 16.0 kHz プリセットシーン(Click)

では一律「9.0 kHz」
High Gain High Freqで設定した周波数付近の信号をブースト/カットします。 −12 dB ～ 0 dB ～ 

+12 dB
プリセットシーン(Click)
では一律「0 dB」

High Q EQ高域のQ(周波数特性)を設定します。High Shapeが
「HighShelving」の場合、High Qの値は効果しません。

0.1 ～ 12.0 プリセットシーン(Click)
では一律「0.9」

High Shape EQ高域の周波数特性の形状を選択します。「LPF」を選択した場
合は、イコライザー全体がローパスフィルターに切り替わります。

HighShelving, 
PeakDip, LPF

プリセットシーン(Click)
では一律「HighShelving」
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Page 6/6

パラメーター 説明 設定 初期値
HPF Freq クリック再生音には、EQ設定とは別にハイパスフィルター (HPF)

も適用できます。ここで設定した周波数より低い周波数域の音は
カットします。「Thru」に設定した場合は、HPFは適用されません。

Thru, 56 Hz ～.
2.0 kHz

プリセットシーン(Click)
では一律「Thru」

HPF Q ハイパスフィルターのQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン(Click)
では一律「0.7」

[F3] Setting →Click →Click Out
クリック再生音につき、どの端子から出力するかを設定します。

Page 1/2

パラメーター 説明 設定 初期値
Main Out クリック音につき、[OUTPUT]端子から出力する(On)か出力し

ない(Off)かを設定します。
Off, On プリセットシーン(Click)

では一律「On」

Phones Out クリック音につき、[PHONES]端子から出力する(On)か出力し
ない(Off)かを設定します。

Off, On

USB Audio Out 
1/2

クリック音につき、[USB TO HOST]端子から出力する(On)か
出力しない(Off)かを設定します。

Off, On

Page 2/2

パラメーター 説明 設定 初期値
IndivOut クリック音の左右(LとR)のチャンネルにつき、外部出力時にどの

チャンネル([INDIVIDUAL OUTPUT]端子)を使うかを設定しま
す。

Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8
*	各設定値については、
93ページ下にある
表をご参照ください。

プリセットシーン(Click)
では一律「Off」

IndivOut Vol クリック音につき、[INDIVIDUAL OUTPUT]端子から出力す
るときの音量を設定します。「Variable」に設定すると、音量は
[CLICK]スライダーの操作に連動します。

Variable, 1 ～ 127 プリセットシーン(Click)
では一律「Variable」
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[RECORDER] 
[RECORDER]ボタンを繰り返し押すことで、以下3つの画面が順に表示されます。
●Recorder (レコーダー )：
演奏の録音やオーディオファイルの再生を行う機能です。
●Looper (ルーパー )：
演奏を録音したあと、そのままループ再生させながら、重ねて演奏したり録音したりする機能です。
●Sampling (サンプリング)
演奏を録音したあと、ユーザーボイスとして取り込んで活用する機能です。

NOTE
録音に関連した本製品の内部メモ
リー構造については、26ページ
をご参照ください。

重要
レコーダー /ルーパー /サンプリング機能においては、録音データ保存のため、[USB TO DEVICE]
端子にUSBフラッシュメモリーが接続されているか、SDカードスロットにSDカードが挿入されている
必要があります。
•	 ルーパー /サンプリング機能においては、内部メモリーに録音したあと、これらのメディア(外部メモ
リー )に保存します。

•	 レコーダー機能においては、これらのメディアに直接録音する手順となります。内部メモリーに録
音したあとメディア(外部メモリー )に保存する方法もあります。

•	 USBフラッシュメモリーとSDカードの両方が接続されている場合、どちらのメディアを扱うか選択
する必要があります。その場合は、各機能の画面下部に「USB/SD」が表示されますので、該当する
Fボタン([F8]ボタン)を押すことでメディアを選択してください。

[RECORDER]-Recorder　
[RECORDER]ボタンを何回か押すことで、Recorder(レコーダー )画面が開きます。レコーダーには以下2つの機能があります。
●再生機能
[USB TO DEVICE]端子に接続したUSBフラッシュメモリーまたはSDカードスロットに挿入されたSDカードに保存されたオーディオ
ファイルを選択し、再生することができます。同一メディアの2ファイルまでを同時に再生できます。
2ファイルを同時に再生できることで、例えば、途中にテンポ変更があって内蔵クリックと同期できない曲をバックに演奏(練習)したい
ときに、以下のように役割分担すればよいでしょう。
•	 1つは曲そのもののオーディオデータ(バッキングデータ)
•	 もう1つはガイド用オーディオデータ(途中の変更含め曲のテンポ設定に沿ったクリック)
これらを聞きながらであれば、正しいテンポで演奏することができます。またこのとき、ガイド用データはPHONES端子からだけの出
力にしておけばよいでしょう。
●録音機能
[USB TO DEVICE]端子に接続したUSBフラッシュメモリーまたはSDカードスロットに挿入されたSDカードに、自分の演奏はもちろ
ん様々な端子から入力されるオーディオを録音します。USBフラッシュメモリーを接続していない場合およびSDカードが挿入されて
いない場合は、内部メモリーに録音します。

NOTE
シーン選択の度にオーディオファイルを切り替えたい場合は、[SCENE] →[F3] Setting →Scene Load →Recorder=Onに設定します。工場
出荷時の初期設定ではOffに設定されており、シーンを切り替えてもオーディオファイルは切り替わらないようになっています。
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	■ オーディオの録音/データ保存

[F1] / [F1]
本製品の内部メモリーまたはメディア(USBフラッシュメモリーまたはSDカード)に、自分の演奏音や外部機器の再生音などをまとめて
録音します。必要な接続・準備を行ったあと、[F1]ボタンを押して録音を開始し、演奏が終了したら再度[F1]ボタンを押して録音を終
了します。

NOTE
レコーダー機能における内部メモリーについては、26ページをご参照ください。

ご注意
内部メモリーへの録音は一度だけです。次に録音を行うと、前回の録音は上書きで消去されます。また内部メモリーへの録音内容は電源オフに
より消去されバックアップされません。したがって、内部メモリーへの録音を保存しておきたい場合は、メディア(USBフラッシュメモリーまたはSD
カード)を接続した上で[F9] Saveボタンをご活用ください。

レコーダー(再生装置)を選択する(1と2の切替)

NOTE
図におけるF1 ～ F9の「F」および

「Alt」は、F＝Function(機能)および 
Alt=Alternate(切替)の意味で、操作説明
のために便宜的につけたボタン名称です。
製品本体には印字されていません。 

1.	2回押す
2.	押すごとにレコーダー
(再生装置)の1と2が交
互に切り替わる

3.	2回押して元の画面に戻る

メディア(外部メモリー)を選択する
USBフラッシュメモリーとSDカードの両方が接続されている場合、どちらのメディア(外部メモリー )を使うか選択する必要があります。

1.	2回押す 2.	 [F8]ボタンを押すことで、
メディアを切り替えます。

本製品がUSBフラッシュメモリーを
扱うことを示しています。

本製品がSDカードを扱うことを
示しています。
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録音する(メディアを接続していない場合)

1. 必要な設定を行う
３.	 録音を終了する2.	 録音を開始する

	 録音中は[RECORDER]ボタ
ンが赤に点灯

4.	 2回押す

5.	 USBメモリーを接続する。
	 または、SDカードをスロットに挿入する

6.	 USBメモリーまたはSDカードに
保存する。

	 [F9] Save をご参照ください

録音前 録音中 録音終了後

録音する(メディアを接続している場合)　* イラストはUSBフラッシュメモリーを接続している場合

[F9] Save 
本製品の内部メモリーに録音されたデータは、[F9]ボタンを押すことでUSBフラッシュメモリーまたはSDカードにWAVファイルとし
て保存できます。

内部メモリーからメディアに保存する

1. 必要な設定を行う
３.	 録音を終了する2.	 録音を開始する

	 録音中は[RECORDER]ボタ
ンが赤に点灯

録音前 録音中 録音終了後

自動的にファイル名がついた
状態で、WAVファイルとして
保存されます。

F1 F2 F3 F1 F2 F3F1 F2 F3

ENTER

F7 F8 F9

録音終了後 保存画面 ファイル名編集
USBフラッシュメモリー
またはSDカードに保存

[F2][F3]ボタンでファイル名のカーソル
を移動し、[+][−]ボタン/ノブで入力した
い文字を選びます。詳細は50ページ
をご参照ください。

2回押す
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	■ オーディオファイルの選択/再生
USBフラッシュメモリーまたはSDカードに保存されたオーディオデータ(WAVファイル)は、以下操作にて再生します。

[−] [+] (ファイルを選択する)
外部メディア(USBフラッシュメモリーまたはSDカード)が接続されている場合のみ、操作できます。[F7]ボタンでオーディオファイル
再生装置を選択したあと、お好みのオーディオファイルを選択します。

[F2] /[F2]
選択された1つまたは2つのオーディオファイルを再生します。再生中に再度このボタンを押すと、再生位置をリセットした上で停止します。

[F4]
選択された1つまたは2つのオーディオファイルを早戻しします。

[F5] /[F5]
選択された1つまたは2つのオーディオファイルを再生します。再生中に再度このボタンを押すと、その時点の再生位置のままで停止します。

[F6]
選択された1つまたは2つのオーディオファイルを早送りします。

[F7] PlaySel
オーディオ再生装置を選択します。

[F8]  MemSel
USBフラッシュメモリーおよびSDカードの両方が接続されているときに表示されます。どちらのメディア(外部メモリー )を使うかを
選択します。

2つのレコーダー (再生装置)のうち、
どちらを使うか選択します。

再生開始ボタンです。
再生中は該当表示が に替わり、
一時停止ボタンとして機能します。

再生開始ボタンです。.
再生中は該当表示が に替わり、
再生停止ボタンとして機能します。

早送りボタンと
して機能します。

早戻しボタンと
して機能します。

NOTE
図におけるF1 ～ F9の「F」および

「Alt」は、F＝Function(機能)お
よび Alt=Alternate(切替)の意
味で、操作説明のために便宜的に
つけたボタン名称です。製品本
体には印字されていません。 

2番め1番め 3番め

再生速度

メディア(WAVファイル
の保存場所)

2つのレコーダー
(再生装置) 
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	■ レコーダー関連の設定を行う([F3] Setting)
トップ画面において[F3] Settingボタンを押すと、録音に関する設定項目群が表示されます。いくつかの階層があるので、[ENTER]
ボタンで下階層に進み、[EXIT]ボタンで上階層に戻ることで、設定したい項目を探します。

[F3] Setting →Recorder
録音されたオーディオを再生するときの基本的な設定です。

パラメーター 説明 設定 初期値
Volume 2つのレコーダー (再生装置)の音量を個別に設定することで、両

者のバランスを調整します。[F1] PlaySelボタンでレコーダー
を選択してから数値を設定します。

0～ 127 プリセットシーン
(Recorder)では一律
「100」

Repeat オーディオファイルの再生方法を設定します。2つのレコーダー
(再生装置)に共通の設定です。
Off
現在選択中のファイルが1回再生されたあとに再生が自動で停
止します。
Single
現在選択中のファイルのリピート再生が、停止ボタンを押すまで
続きます。
List
USBフラッシュメモリーまたはSDカードのルートディレクトリー
にある認識可能な全オーディオファイルを、順番に連続再生しま
す。再生は停止ボタンを押すまで続きます。

Off, Single, List プリセットシーン
(Recorder)では一律
「Off」

Speed オーディオファイルの再生速度を設定します。「1.00x」が元デー
タの速度で、数字が大きくなるほど速く、数字が小さくなるほど遅
くなります。2つのレコーダー (再生装置)に共通の設定です。

0.50x ～ 1.50x プリセットシーン
(Recorder)では一律
「1.00x」

[EXIT]ボタン

[ENTER]ボタン

[EXIT]ボタン

[F3]ボタン

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味で、操作説明のために
便宜的につけたボタン名称です。製品本体には印字されていません。
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画面での設定項目(パラメーター)
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[F3] Setting →Recorder Rec
オーディオを録音するときの条件を設定します。

Page 1/2

パラメーター 説明 設定 初期値
Rec Gain 録音されるオーディオのゲイン(音量レベル)を設定します。 −18dB, −12dB, .

−6dB, 0dB, +6dB, 
+12dB, +18dB

プリセットシーン
(Recorder)では一律「.
0 dB」

Rec Click クリックを録音する(On)かしない(Off)かを設定します。 Off, On プリセットシーン
(Recorder)では一律
「On」

Rec Aux In [AUX IN]端子から入力されるオーディオにつき、録音する(On)
かしない(Off)かを設定します。

Off, On

Rec USB Audio 
In1/2

[USB TO HOST]端子から入力されるオーディオのチャンネル
1/2につき、録音する(On)かしない(Off)かを設定します。

Off, On

Rec USB Audio 
In3/4

[USB TO HOST]端子から入力されるオーディオのチャンネル
3/4につき、録音する(On)かしない(Off)かを設定します。

Off, On

Page 2/2

パラメーター 説明 設定 初期値
Rec USB Audio 
In5/6

[USB TO HOST]端子から入力されるオーディオのチャンネル
5/6につき、録音する(On)かしない(Off)かを設定します。

Off, On プリセットシーン
(Recorder)では一律
「On」Rec USB Audio 

In7/8
[USB TO HOST]端子から入力されるオーディオのチャンネル
7/8につき、録音する(On)かしない(Off)かを設定します。

Off, On

Rec Recorder 
Play

レコーダーの再生音につき、録音する(On)かしない(Off)かを設
定します。

Off, On

Rec Bluetooth Bluetooth経由で入力されるオーディオにつき、録音する(On)か
しない(Off)かを設定します。

Off, On
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[F3] Setting →Recorder EQ
オーディオファイル再生音のEQ(イコライザー )につき、それぞれのレコーダー (再生装置) に対して個別に設定します。 
[F1] PlaySelボタンでレコーダー (再生装置)を選択してから設定します。

NOTE
イコライザー (EQ)については、25ページの図解をご参照ください。

Page 1/6

パラメーター 説明 設定 初期値
On/Off 再生時にオーディオにEQをかける(On)か、かけない(Off)かを設

定します。
「Off」に設定した場合は各周波数域のゲイン=0、およびHPF 
Freq=Thru と同等の効果になります。

Off, On プリセットシーン
(Recorder)では一律
「Off」

Page 2/6

パラメーター 説明 設定 初期値
Low Freq EQ低音域の中心周波数を設定します。 32 Hz ～ 2.0 kHz プリセットシーン

(Recorder)では一律
「125 Hz」

Low Gain Low Freqで設定した周波数付近の信号をブースト/カットしま
す。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Recorder)では一律.
「0 dB」

Low Q EQ低域のQ(周波数特性)を設定します。Low Shapeが
「LowShelving」に設定されている場合、Low Qの値は効果し
ません。

0.1 ～ 12.0 プリセットシーン
(Recorder)では一律
「0.9」

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip

プリセットシーン
(Recorder)では一律
「LowShelving」

Page 3/6

パラメーター 説明 設定 初期値
MidLow Freq EQの中低音域の中心周波数を設定します。 100 Hz ～ 10.0 kHz プリセットシーン

(Recorder)では一律
「500 Hz」

MidLow Gain MidLow Freqで設定した周波数付近の信号をブースト/カットし
ます。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Recorder)では一律.
「0 dB」

MidLow Q EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Recorder)では一律
「0.9」
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Page 4/6

パラメーター 説明 設定 初期値
MidHigh Freq EQの高低音域の中心周波数を設定します。 100 Hz ～ 10.0 kHz プリセットシーン

(Recorder)では一律
「4.0 Hz」

MidHigh Gain MidHigh Freqで設定した周波数付近の信号をブースト/カットし
ます。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Recorder)では一律.
「0 dB」

MidHigh Q EQ中高域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Recorder)では一律
「0.9」

Page 5/6

パラメーター 説明 設定 初期値
High Freq EQの高音域の中心周波数を設定します。 500 Hz ～ 16.0 kHz プリセットシーン

(Recorder)では一律
「9.0 kHz」

High Gain High Freqで設定した周波数付近の信号をブースト/カットします。 −12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Recorder) では一律.
「0 dB」

High Q EQ高域のQ(周波数特性)を設定します。High Shapeが
「HighShelving」の場合、High Qの値は効果しません。

0.1 ～ 12.0 プリセットシーン
(Recorder) では一律
「0.9」

High Shape EQ高域の周波数特性の形状を選択します。「LPF」を選択した場
合は、イコライザー全体がローパスフィルターに切り替わります。

HighShelving, 
PeakDip, LPF

プリセットシーン
(Recorder) では一律
「HighShelving」

Page 6/6

パラメーター 説明 設定 初期値
HPF Freq レコーダー再生音には、EQ設定とは別にハイパスフィルター

(HPF)も適用できます。ここで設定した周波数より低い周波数域
の音はカットします。「Thru」に設定した場合は、HPFは適用されま
せん。

Thru, 56 Hz ～.
2.0 kHz

プリセットシーン
(Recorder)では一律
「Thru」

HPF Q ハイパスフィルターのQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Recorder)では一律
「0.7」
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[F3] Setting →Recorder Out
オーディオデータ(WAVファイル)再生時の出力設定を、レコーダー (再生装置)ごとに行います。[F1] PlaySelボタンでレコーダー
(再生装置)を選択してから設定します。

Page 1/2

パラメーター 説明 設定 初期値
Mode 再生中のオーディオファイルにつき、出力時にどのように処理す

るかを設定します。
Stereo (ステレオ)
入力されたステレオ音を、ステレオのまま処理します。
L Mono (Lモノラル)
左チャンネルの音だけを使います。
R Mono (Rモノラル)
右チャンネルの音だけを使います。
L+R Mono (L+Rモノラル)﻿
左チャンネルと右チャンネルをミックスして、モノラル音として処
理します。
L Guide (Lガイド)
ガイド(クリック)音がL側に、その他のバッキング音がR側に分離し
たオーディオファイルを再生するときに選びます。ガイド(クリッ
ク)音とバッキング音がセンター定位で[PHONES]端子から、バッ
キング音が[OUTPUT]端子および[USB TO HOST]端子からセ
ンター定位で出力されます。[PHONES]端子のガイド(クリック)
音量は[CLICK]スライダーで、バッキングの音量は[AUDIO]スラ
イダーで調節できます。
R Guide (Rガイド)
ガイド(クリック)音がR側に、その他のバッキング音がL側に分離し
たオーディオファイルを再生するときに選びます。ガイド(クリッ
ク)音とバッキング音がセンター定位で[PHONES]端子から、バッ
キング音が[OUTPUT]端子および[USB TO HOST]端子からセ
ンター定位で出力されます。[PHONES]端子のガイド(クリック)
音量は[CLICK]スライダーで、バッキングの音量は[AUDIO]スラ
イダーで調節できます。

Stereo, L Mono, R 
Mono, L+R Mono, 
L Guide, R Guide

プリセットシーン
(Recorder)では一律
「Stereo」

Main Out 再生中のオーディオファイルにつき、[OUTPUT]端子から出力
する(On)か出力しない(Off)かを設定します。

Off, On プリセットシーン
(Recorder)では一律
「On」Phones Out 再生中のオーディオファイルにつき、[PHONES]端子から出力

する(On)か出力しない(Off)かを設定します。
Off, On

USB Audio Out 
1/2

再生中のオーディオファイルにつき、[USB TO HOST]端子か
ら出力する(On)か出力しない(Off)かを設定します。

Off, On

Backing Out 
Level

Mode=L Guide または R Guide のときに表示される項目です。
[OUTPUT]端子および[USB TO HOST]端子(USB Audio 1/2)
から出力されるバッキングの音量を設定します。

0～ 127 プリセットシーン
(Recorder)では一律
「127」
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Page 2/2

パラメーター 説明 設定 初期値
IndivOut 再生中のオーディオファイルの左右(LとR)のチャンネルにつき、

外部出力時にどのチャンネル([INDIVIDUAL OUTPUT]端子)
を使うかを設定します。

Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L(1+2), R(1+2), 
L(3+4), R(3+4), 
L(5+6), R(5+6), 
L(7+8), R(7+8), 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8 
*	各設定値については、
93ページ下にある
表をご参照ください。

プリセットシーン
(Recorder)では一律
「Off」

IndivOut Vol 本機能で再生されるオーディオにつき、[INDIVIDUAL OUTPUT]
端子から出力するときの音量を設定します。「Variable」に設定する
と、音量は[AUDIO]スライダーの操作に連動します。

Variable, 1 ～ 127 プリセットシーン
(Recorder)では一律
「Variable」
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[RECORDER]-Looper　
[RECORDER]ボタンを何回か押すことで、ルーパー画面が表示されます。この画面ではまず基本のリズムを録音し、それをそのまま
ループ再生させながら重ねて別のリズムを叩いて楽しみます。別のリズム演奏は、既存リズムに重ねて録音(オーバーダブ録音)する
こともできます。録音されたデータは内部メモリーに保存されますが、恒久的に残しておきたい場合はUSBフラッシュメモリーまた
はSDカードに保存(セーブ)します。

	■ 初回の録音/オーバーダブ/データ保存
Rec Beat Length=Off の場合(初回録音からボタン操作によりループ再生へ)

Rec Beat Length=4 の場合(初回録音から自動でループ再生へ)

録音前
初回の録音﻿
([RECORDER]赤く点灯)

オーバーダブ録音﻿
([RECORDER]赤く点灯)ループ再生 録音終了後

[F2][F1]

4拍終わったら.
自動的に状態遷移

[F1]

必要に応じて関連設定
を行います。

Undo/Redoボ
タンとして機能
します。

録音データをクリア
(消去)します。このタイミングでも

録音停止できます。

NOTE
図におけるF1 ～ F9の「F」および

「Alt」は、F＝Function(機能)および 
Alt=Alternate(切替)の意味で、操作説明
のために便宜的につけたボタン名称です。
製品本体には印字されていません。 

NOTE
ルーパー機能においては、クリックを鳴らし
ながらタイミングよく[F1]ボタンを押すこと
が、上手に録音を開始するコツです。

NOTE
上記は Rec Mode=「Rec →Play →Dub」 の場合の画面遷移
です。Rec Mode=「Rec →Dub →Play」 と設定することによ
り、ループ再生(Play)とオーバーダブ録音(Overdub)の順番を
入れ替えることもできます。

ルーパー機能の基本手順

初回の録音

ループ再生
録音済データの確認

オーバーダブ録音
録音済データをループ再生しな
がら重ねて録音

ボタン操作または
自動で遷移

録音終了後

ボタン操作

メディアにデータ保存

録音前
初回の録音﻿
([RECORDER]赤く点灯)

オーバーダブ録音﻿
([RECORDER]赤く点灯)ループ再生 録音終了後

[F2][F1][F1][F1]

必要に応じて関連設定
を行います。

Undo/Redoボ
タンとして機能
します。

録音データをクリア
(消去)します。このタイミングでも

録音停止できます。
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[F1] / [F1]
内部メモリーに録音データがない場合の停止中およびループ再生中、[F1]は録音開始ボタンとして機能します。後者の場合は、既
存データに重ねて録音(オーバーダブ録音)することになります。
また、録音中(オーバーダブ含め)および録音終了後の停止中、[F1]は再生開始ボタンとして機能します。いずれの場合も、それまで
に録音された全てのデータをループ再生する状態に切り替わります。

[F2] / [F2] Clear
録音中、ループ再生中、オーバーダブ録音中において、[F2]は停止ボタンとして機能します。
また停止中、[F2]は内部メモリー上の録音データを消去するボタンとして機能します。

[F3] Undo / [F3] Redo
ループ再生中においてこのボタンは Undo/Redoボタンとして機能します。オーバーダブ録音の直後にループ再生している場合な
ど、直前に録音したデータのみを消去(Undo) したり、復元(Redo)したりすることができます。

[F6] Save (内部メモリーからメディアに保存する)
ルーパーによる録音はすべて内部メモリーに保存されています。恒久的に残しておきたい場合は、[F6]ボタンを押すことでUSBフラッ
シュメモリーまたはSDカードに保存します。操作方法は、レコーダー画面の場合と同じです。

[F2][F3]ボタンでファイル名の
カーソルを移動し、[+][−]ボタ
ン/ノブで入力したい文字を選
ぶ。詳細は50ページをご参
照ください。

録音終了後 ファイル名編集
USBフラッシュメモリー
またはSDカードに保存[F6]

[F1]1番め 2番め

2回押す

NOTE
図におけるF1 ～ F9の「F」および「Alt」は、F＝Function(機能)および 
Alt=Alternate(切替)の意味で、操作説明のために便宜的につけたボ
タン名称です。製品本体には印字されていません。 
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	■ 設定([F3] Setting)

[F3] Setting →Looper Vol

パラメーター 説明 設定 初期値
Volume	 録音後にサンプルを再生するときの音量を調節します。 0～ 127 プリセットシーン

(Recorder)では一律
「100」

[F3] Setting →Looper Rec
録音時の基本的な設定です。

Page 1/2

パラメーター 説明 設定 初期値
Rec Gain 録音時のオーディオソースのゲインを調節します。 −18 dB, −12 dB, .

−6 dB, 0 dB, +6 dB, 
+12 dB, +18 dB

プリセットシーン
(Recorder)では一律.
「0 dB」

Rec Mode ルーパー録音時の方式を2種類から選択します。
Rec →Play →Dub
演奏を「録音」したあと、ボタン操作を経て「再生」に移行し、さらに
ボタン操作を経て「オーバーダブ」(既に録音されたフレーズに
さらに重ねて録音)に移行します。
Rec →Dub →Play﻿
演奏を「録音」したあと、ボタン操作を経て「オーバーダブ」(既に
録音されたフレーズにさらに重ねて録音)に移行し、さらにボタン
操作を経て「再生」に移行します。

Rec →Play .
→Dub, Rec .
→Dub →Play

プリセットシーン
(Recorder)では一律
「Rec →Play →Dub」

Rec Beat Length 初回録音時に何拍分を録音するかを設定します。クリック再生の
テンポでここで設定した拍数の録音が終わると、自動的に先頭に
戻って再生またはオーバーダブ録音に移行します。クリックに合
わせて録音を開始すれば、自動で先頭に戻るので演奏に集中で
きます。
NOTE
本項目の設定を録音中に変更できますが、有効になるのは既存の録音
をクリア([F2] Clear)した後からです。

Off, 1 ～ 32 プリセットシーン
(Recorder)では一律.
「Off」

Rec Click クリックを録音する(On)かしない(Off)かを設定します。 Off, On プリセットシーン
(Recorder)では一律.
「On」

Rec Aux In [AUX IN]端子から入力されるオーディオにつき、録音する(On)
かしない(Off)かを設定します。

Off, On
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Page 2/2

パラメーター 説明 設定 初期値
Rec USB Audio 
In1/2

[USB TO HOST]端子から入力されるオーディオのチャンネル
1/2につき、録音する(On)かしない(Off)かを設定します。

Off, On プリセットシーン
(Recorder)では一律.
「On」Rec USB Audio 

In3/4
[USB TO HOST]端子から入力されるオーディオのチャンネル
3/4につき、録音する(On)かしない(Off)かを設定します。

Off, On

Rec USB Audio 
In5/6

[USB TO HOST]端子から入力されるオーディオのチャンネル
5/6につき、録音する(On)かしない(Off)かを設定します。

Off, On

Rec USB Audio 
In7/8

[USB TO HOST]端子から入力されるオーディオのチャンネル
7/8につき、録音する(On)かしない(Off)かを設定します。

Off, On

Rec Bluetooth Bluetooth経由入力されるオーディオにつき、録音する(On)かし
ない(Off)かを設定します。

Off, On

[F3] Setting →Looper EQ
本機能で再生されるオーディオにつき、EQに関する設定です。

NOTE
イコライザー (EQ)については、25ページの図解をご参照ください。

Page 1/6

パラメーター 説明 設定 初期値
On/Off 本機能で再生されるオーディオにつき、EQをかける(On)かかけ

ない(Off)かを設定します。「Off」に設定した場合は、各周波数域で
のゲイン=0かつHPF FreqのThru設定と同等の効果になります。

Off, On プリセットシーン
(Recorder)では一律
「Off」

Page 2/6

パラメーター 説明 設定 初期値
Low Freq 本機能で再生されるオーディオにつき、EQ低音域の中心周波数

を設定します。
32 Hz ～ 2.0 kHz プリセットシーン

(Recorder)では一律
「125 Hz」

Low Gain Low Freqで設定した周波数付近の信号をブースト/カットします。 −12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Recorder)では一律.
「0 dB」

Low Q EQ低域のQ(周波数特性)を設定します。Low Shapeが
「LowShelving」に設定されている場合、Low Qの値は効果し
ません。

0.1 ～ 12.0 プリセットシーン
(Recorder)では一律.
「0.9」

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip

プリセットシーン
(Recorder)では一律.
「LowShelving」
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Page 3/6

パラメーター 説明 設定 初期値
MidLow Freq 本機能で再生されるオーディオにつき、EQの中低音域の中心周

波数を設定します。
100 Hz ～ 10.0 kHz プリセットシーン

(Recorder)では一律
「500 Hz」

MidLow Gain MidLow Freqで設定した周波数付近の信号をブースト/カットし
ます。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Recorder)では一律.
「0 dB」

MidLow Q EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Recorder)では一律.
「0.7」

Page 4/6

パラメーター 説明 設定 初期値
MidHigh Freq 本機能で再生されるオーディオにつき、EQの高低音域の中心周

波数を設定します。
100 Hz ～ 10.0 kHz プリセットシーン

(Recorder)では一律
「4.0 kHz」

MidHigh Gain MidHigh Freqで設定した周波数付近の信号をブースト/カットし
ます。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Recorder)では一律.
「0 dB」

MidHigh Q EQ中高域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Recorder)では一律.
「0.9」

Page 5/6

パラメーター 説明 設定 初期値
High Freq 本機能で再生されるオーディオにつき、EQの高音域の中心周波

数を設定します。
500 Hz ～ 16.0 kHz プリセットシーン

(Recorder)では一律
「9.0 kHz」

High Gain High Freqで設定した周波数付近の信号をブースト/カットします。 −12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Recorder)では一律.
「0 dB」

High Q EQ高域のQ(周波数特性)を設定します。High Shapeが
「HighShelving」の場合、High Qの値は効果しません。

0.1 ～ 12.0 プリセットシーン
(Recorder)では一律
「0.9」

High Shape EQ高域の周波数特性の形状を選択します。「LPF」を選択した場
合は、イコライザー全体がローパスフィルターに切り替わります。

HighShelving, 
PeakDip, LPF

プリセットシーン
(Recorder)では一律
「HighShelving」

Page 6/6

パラメーター 説明 設定 初期値
HPF Freq 本機能で再生されるオーディオにつき、EQ設定とは別にハイパス

フィルター (HPF)も適用できます。ここで設定した周波数より低
い周波数域の音はカットします。「Thru」に設定した場合は、HPFは
適用されません。

Thru, 56 Hz ～.
2.0 kHz

プリセットシーン
(Recorder)では一律
「Thru」

HPF Q ハイパスフィルターのQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Recorder)では一律
「0.7」
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[F3] Setting →Looper Out
本機能で再生されるオーディオにつき、外部出力時に関する設定です。

Page 1/2

パラメーター 説明 設定 初期値
Main Out 本機能で再生されるオーディオにつき、[OUTPUT]端子から出

力する(On)か出力しない(Off)かを設定します。
Off, On プリセットシーン

(Recorder)では一律
「On」Phones Out 本機能で再生されるオーディオにつき、[PHONES]端子から出

力する(On)か出力しない(Off)かを設定します。
Off, On

USB Audio Out 
1/2

本機能で再生されるオーディオにつき、[USB TO HOST]端子
から出力する(On)か出力しない(Off)かを設定します。

Off, On

Page 2/2

パラメーター 説明 設定 初期値
IndivOut 本機能で再生されるオーディオにつき、外部出力時にどのチャン

ネル([INDIVIDUAL OUTPUT]端子)を使うかを設定します。
Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L(1+2), R(1+2), 
L(3+4), R(3+4), 
L(5+6), R(5+6), 
L(7+8), R(7+8), 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8 
*	各設定値については、
93ページ下にある
表をご参照ください。

プリセットシーン
(Recorder)では一律
「Off」

IndivOut Vol 本機能で再生されるオーディオにつき、[INDIVIDUAL OUTPUT]
端子から出力するときの音量を設定します。「Variable」に設定する
と、音量は[AUDIO]スライダーの操作に連動します。

Variable, 1 ～ 127 プリセットシーン
(Recorder)では一律
「Variable」
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[RECORDER]-Sampling　
[RECORDER]ボタンを何回か押すことで、サンプリング画面が表示されます。サンプリングは、楽器音やボーカルなどのオーディオ
を、デジタルデータとして本体内部メモリーに録音し、データ内部の波形を編集することでサンプルとして仕上げる機能です。自分で
録音(サンプリング)する代わりに、USBフラッシュメモリーやSDカードに保存されているWAVファイルを読み込むことも可能です。
編集により仕上がったサンプルは、ユーザーボイスに割り当てることにより、演奏に活用することができます。

NOTE
サンプリング機能の操作では、録音データ(サンプル) を内部メモリー上で波形編集し、完成品をウェーブメモリーに保存する流れになります。これ
らメモリー構造については、26ページをご参照ください。

サンプリング機能の基本手順

録音(サンプリング) ユーザーボイスへの
割り当て

波形の編集
サンプルとして仕上げる

メディアに編集データを
WAVファイルとして保存

メディアからWAV
ファイルを読み込み

内部メモリー
ウェーブメモリー

	■ 録音する/編集する

必要に応じて関連
設定を行います。

録音開始前 編集

NOTE
F1 ～ F3の「F」は、F＝Function(機能)の意味で、操作説明のために便宜的に
つけたボタン名称です。製品本体には印字されていません。

録音中 録音終了後

[F1]
サンプリング画面に入った時点(録音開始前の状態)では、このボタンはレコード(録音)ボタンとして機能します。

[F1]
録音中においては、このボタンは録音停止ボタンとして機能します。
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[F2] Edit
録音終了後の、内部メモリーにサンプル(録音データ)がある場合にのみ表示されます。サンプルを構成する波形を編集します。

[F2] Edit →[F1] Play / [F1] Stop
現在編集中のサンプルを再生したり停止したりします。

パラメーター 説明 設定 初期値
Start Point サンプルの再生を開始する位置を設定します。この位置よりも

前側にあるデータは再生されません。
0～サンプルの終端
直前の位置を示す数
値

プリセットシーン
(Recorder)では一律「0」

Loop Point サンプル再生時にループを開始する位置を設定します。 0～サンプルの終端
直前の位置を示す数
値

End Point サンプルの再生を終了する位置を設定します。この位置よりも
後ろ側にあるデータは再生されません。

1～サンプルの終端
位置を示す数値

サンプルの終端位置を示
す数値

Normalize サンプルの音量を最大限に増幅した状態にデータ変換します。
小さな音量でサンプリングしてしまったサンプルを、適正な音量
に増幅したい場合に使います。[ENTER]ボタンを押して表示さ
れる画面上で増幅比率(Ratio)を設定した上で、再度[ENTER]ボ
タンを押すことで実行します。

— —

Reverse 元サンプルを逆方向に再生させた状態にデータ変換します。
[ENTER]ボタンを押すことにより実行します。

— —
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[F3] Setting
録音前に、サンプリング時の条件を設定します。

[F3] Setting →Sampling Vol

パラメーター 説明 設定 初期値
Volume 録音後にサンプルを再生するときの音量を調節します。 0～ 127 プリセットシーン

(Recorder)では一律
「100」

[F3] Setting →Sampling Rec

Page 1/2

パラメーター 説明 設定 初期値
Rec Gain 録音時のオーディオソースのゲインを調節します。 −18 dB, −12 dB, .

−6 dB, 0 dB, .
+6 dB, +12 dB, 
+18 dB

プリセットシーン
(Recorder)では一律.
「0 dB」

Rec Click クリックを録音する(On)かしない(Off)かを設定します。 Off, On プリセットシーン
(Recorder)では一律.
「On」

Rec Aux In [AUX IN]端子から入力されるオーディオにつき、録音する(On)
かしない(Off)かを設定します。

Off, On

Rec USB Audio 
In1/2

[USB TO HOST]端子から入力されるオーディオのチャンネル
1/2につき、録音する(On)かしない(Off)かを設定します。

Off, On

Rec USB Audio 
In3/4

[USB TO HOST]端子から入力されるオーディオのチャンネル
3/4につき、録音する(On)かしない(Off)かを設定します。

Off, On

Page 2/2

パラメーター 説明 設定 初期値
Rec USB Audio 
In5/6

[USB TO HOST]端子から入力されるオーディオのチャンネル
5/6につき、録音する(On)かしない(Off)かを設定します。

Off, On プリセットシーン
(Recorder)では一律.
「On」Rec USB Audio 

In7/8
[USB TO HOST]端子から入力されるオーディオのチャンネル
7/8につき、録音する(On)かしない(Off)かを設定します。

Off, On

Rec Bluetooth Bluetooth経由入力されるオーディオにつき、録音する(On)かし
ない(Off)かを設定します。

Off, On
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	■ サンプルの保存/読み込み

[F4] Load
録音前に、サンプリング時の条件を設定します。
USBフラッシュメモリーまたはSDカードのオーディオファイル(WAV)を、内部メモリー (サンプル編集用の内部メモリーエリア)に読
み込みます。

2番め1番め

3回押す [+][−]ボタン/ノブで
ファイルを選択

メディアに保存されているWAVファイル数

[F6] Save
制作したサンプルを、USBフラッシュメモリーまたはSDカードにオーディオファイル(WAV)として保存します。

保存するファイルに名
前をつけます。詳細は、
50ページをご参照く
ださい。

必要に応じてメディア(USB
フラッシュメモリーまたは
SDカード)を選択します。

2番め1番め

録音終了後

内部メモリーにサンプリングしたデータ
がある場合のみ表示されます。ユーザーボイスのいずれかのバンク

にサンプルが割り当てられている場
合のみ表示されます。

USBフラッシュメモリーまたはSD
カードを挿している場合のみ表示
されます。

NOTE
図におけるF1 ～ F9の「F」およ
び「Alt」は、F＝Function(機能)
および Alt=Alternate(切替)
の意味で、操作説明のために便
宜的につけたボタン名称です。
製品本体には印字されていま
せん。 

2番め1番め 3番め

録音終了後



EAD50　ユーザーガイド 155

画面での設定項目(パラメーター)

M
od

ifi
er

 
ノ

ブ
[ M

IC
 / 

TR
IG

 ]
[ S

CE
NE

 ]
[ C

LIC
K 

]
[ R

EC
O

RD
ER

 ]
[ L

IV
E S

ET
 ]

[ M
EN

U 
]

M
ic

Tr
ig

ge
r

Ki
t

Ef
fe

ct
Re

co
rd

er
Lo

op
er

Sa
m

pl
in

g
Ut

ilit
y

O
ut

pu
t

Au
x 

In
US

B 
Au

dio
Bl

ue
to

ot
h

Fi
le

Ve
rs

io
n

LE
D 

ロ
ー

タ
リ

ー
フ

ェ
ー

ダ
ー

Fa
ct

or
y 

Re
se

t

[F7] LoadWM
ウェーブメモリーにある任意のユーザーボイス/バンクに割り当てられているサンプルを、内部メモリーに読み込みます。

[F9] SaveWM
制作したサンプルを、ウェーブメモリーの任意のユーザーボイス/バンクに保存します。

保存先のユーザーボイスおよびバンクに
名前をつけます。名前のつけかたについ
ては、50ページをご参照ください。

ユーザーボイスとバンク
の間でカーソルを移動し
ます。

3番め1番め

2回押す

録音終了後

3番め1番め

3回押す ユーザーボイスとバンクの間で
カーソルを移動します。

読み込み元のユーザーボイス番号(U001～
U500)とバンク番号(B01～B10)を、[+][−]
ボタン/ノブで選択します。

2回押す
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[LIVE SET] 
「ライブセット」とは、「シーン」を順番に並べ、順に切り替えていけるようにした機能のことです。たとえば、演奏に使いたいキットを登
録したシーンを順に並べてライブ演奏に使ったり、難易度順にオーディオファイルを登録したシーンを順に並べてリズム練習で使った
りなど、アイデア次第でさまざまな活用ができます。
本製品では、自分で作った「ライブセット」を50個まで保存しておき、いつでも自由に選んで演奏や練習に使えます。

[−] [+] Live Set 
[設定] U01～U50  [初期値] U01

[F1] Live Set Start 
ライブセットを選択した上で、ライブパフォーマンスを開始します。ライブパフォーマンス中は、ステップを進めることでシーンを切り
替えていきます。

NOTE
図におけるF1 ～ F3の「F」および「Alt」は、F＝Function(機能)および Alt=Alternate(切替)の意味で、
操作説明のために便宜的につけたボタン名称です。製品本体には印字されていません。 

1.	 [+][−]ボタンまたはノ
ブでライブセットを選
択します。 ライブパフォーマンス中(最上列に現在のステップが表示)

2.	 ライブセットを開始します。 4.	 ライブセットを停止します。3.	 [F3][F2] ボタンまたは[+][−]ボタン/ノブで、
ステップを前進/後退させます。

ステップ 01 (S01) ステップ 02 (S02) ステップ 03 (S03) ステップ 50 (S50)

ライブセット 01 (U01)

ライブセット 02 (U02)

ライブセット 03 (U03)

ライブセット 50 (U50)

Scene xxScene xxScene xxScene xx
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[F2] Job 

パラメーター 説明 
Sort ライブセット内のステップの順番を変更します。[ENTER]ボタンを押した上で操作します。詳細は「基本操作」

(45ページ)をご参照ください。
Clear 各ライブセットを空の状態にクリアします。

[ENTER]ボタンを押した上で、[+][−]ボタン/ノブでライブセットを選択し、再度[ENTER]ボタンを押してクリア
を実行します。

[F3] Setting
各ステップにシーン番号を登録することで、ライブセットを作ります。
[F1]Nameボタンを押すことで表示される画面上で、各ステップに名前をつけることができます。

1.	 [+][−]ボタン/ノブで
ライブセットを選択し
ます。

2.	 編集画面を呼び出します。 4.	 次のステップ(S02)
に進みます。

3.	 [+][−]ボタン/ノブでS01(ステップ01)のシーンを選択します。

名前編集画面を呼び出して、
ライブセットに名前をつける
ことができます。名前の付
け方手順については、50
ページをご参照ください。

５.	 同様に、[+][−]ボタン/ノブで
シーンを選択し、[F3]ボタンで
次のステップに進みます。

[Alt]ボタンを押すこと
で、[F1]ボタンの機能が 
「Name」⇔「Sort」で交互
に切り替わります。 

6.	 必要なステップまで編集できたら、
[EXIT]ボタンで元の画面に戻ります。
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[MENU] 
主に、製品全般に影響する共通の設定を行います。

Utility

Page 1/3

パラメーター 説明 設定 初期値
Auto Power Off 電力消費を抑えるため、本製品は一定時間操作がないと自動的

に電源がオフになります。ここでは、電源がオフになるまでの時
間を設定します。

Off, 5 min, 10 min, 
15 min, 30 min, .
60 min, 120 min

プリセットシーン(Utility)
では一律「15 min」

Pop-up Time パネル左上にあるModifierノブやパネル中央下部にあるLED
ロータリーフェーダーを操作したときなどに表示されるポップアッ
プウィンドウにつき、自動的に消えるまでの時間を設定します。

「Hold」に設定した場合は、他のボタン操作をするまでポップアッ
プウィンドウは消えません。

1.0 sec, 1.5 sec, 
2.0 sec, 2.5 sec, 
3.0 sec, 3.5 sec, 
4.0 sec, 4.5 sec, 
5.0 sec, 5.5 sec, 
6.0 sec, Hold

プリセットシーン(Utility)
では一律「3.0 sec」

LCD Contrast 画面のコントラストを調整します。 −50 ～ 0 ～ +50 プリセットシーン(Utility)
では一律「0」

Audition 
Velocity

Trigger Input Select画面(48ページ)で[F3]ボタンを押した
ときに鳴る試聴音(オーディション)のベロシティーを設定します。

Off, 1 ～ 127 プリセットシーン(Utility)
では一律「100」

1ページめ

2ページめ

[F3]ボタンで
カーソル下降[F2]ボタンで

カーソル上昇

[MENU] →Utility →Auto Power Off 
を例にしています。

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味で、操作説明のために
便宜的につけたボタン名称です。製品本体には印字されていません。
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Page 2/3

パラメーター 説明 設定 初期値
MIDI Local 
Control

電子ドラムのパッドを叩いた場合に本製品の内部音源を鳴らす
(On)か、鳴らさない(Off)かを設定します。接続先のMIDI機器の
音源だけを鳴らしたい場合に「Off」に設定します。

Off, On プリセットシーン(Utility)
では一律「On」

MIDI Global 
Channel

本製品で扱うMIDIメッセージを同一のチャンネルに統合したい
場合のチャンネルを設定します。

1～ 16 プリセットシーン(Utility)
では一律「10」

MIDI Global 
Port

「MIDI Global Channel」で設定されたチャンネルが所属する
MIDIポートを設定します。

1～ 2 プリセットシーン(Utility)
では一律「1」

MIDI PC Tx MIDI Program Change Transmission の略です。シーンを
変更したときに、プログラムチェンジを送信するかどうかを設定し
ます。

Off, On プリセットシーン(Utility)
では一律「On」

MIDI PC Rx MIDI Program Change Reception の略です。本製品がプロ
グラムチェンジを受信したときに、対応する(On)か無視する(Off)
かを設定します。

Off, On

Page 3/3

パラメーター 説明 設定 初期値
MIDI Clock Tx MIDI Clock Transmission の略です。MIDIクロックを送信す

るかどうかを設定します。「On」に設定すると、現在のテンポ設定
に従って常にF8を出します。

Off, On プリセットシーン(Utility)
では一律「On」

MIDI Clock Rx MIDI Clock Reception の略です。本製品がMIDIクロックを
受信したときに、対応する(On)か無視する(Off)かを設定します。

Off, On プリセットシーン(Utility)
では一律「Off」

MIDI Start/Stop 
Tx

MIDI Start/Stop Transmission の略です。本製品のクリック
再生/停止時にMIDIリアルタイムメッセージ(FA/FC)を送信する
(On)かしない(Off)かを設定します。

Off, On プリセットシーン(Utility)
では一律「On」

MIDI Start/Stop 
Rx

MIDI Start/Stop Reception の略です。MIDIリアルタイムメッ
セージ(FA/FC)を受信時に、本製品のクリックを再生/停止をす
る(On)かしない(Off)かを設定します。

Off, On

USB MIDI Thru 
MIDI

[USB TO HOST]端子経由で受信したMIDIポート1のメッセー
ジにつき、そのまま[MIDI OUT]端子から送信する(On)かしない
(Off)かを設定します。

Off, On プリセットシーン(Utility)
では一律「Off」
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Output

Output →Output Gain
本製品の各端子から出力されるオーディオのゲインを設定します。

Page 1/2

パラメーター 説明 設定 初期値
Main Out [OUTPUT]端子(LとR) から出力されるオーディオのゲインを設

定します。
−18 dB, −12 dB, .
−6 dB, 0 dB, +6 dB, 
+12 dB, +18 dB

プリセットシーン
(Output)では一律.
「0 dB」

Phones Out [PHONES]端子から出力されるオーディオのゲインを設定します。 −18 dB, −12 dB, .
−6 dB, 0 dB, +6 dB, 
+12 dB, +18 dB

Page 2/2

パラメーター 説明 設定 初期値
IndivOut1/2 [INDIVIDUAL OUTPUT]端子の1と2から出力されるオーディ

オのゲインを設定します。
−18 dB, −12 dB, .
−6 dB, 0 dB, +6 dB, 
+12 dB, +18 dB

プリセットシーン
(Output)では一律.
「0 dB」 

IndivOut3/4 [INDIVIDUAL OUTPUT]端子の3と4から出力されるオーディ
オのゲインを設定します。

−18 dB, −12 dB, .
−6 dB, 0 dB, +6 dB, 
+12 dB, +18 dB

IndivOut5/6 [INDIVIDUAL OUTPUT]端子の5と6から出力されるオーディ
オのゲインを設定します。

−18 dB, −12 dB, .
−6 dB, 0 dB, +6 dB, 
+12 dB, +18 dB

IndivOut7/8 [INDIVIDUAL OUTPUT]端子の7と8から出力されるオーディ
オのゲインを設定します。

−18 dB, −12 dB, .
−6 dB, 0 dB, +6 dB, 
+12 dB, +18 dB

Output →Phones EQ
ヘッドホンの音にかけるEQを調節します。

NOTE
イコライザー (EQ)については、25ページの図解をご参照ください。

Page 1/5

パラメーター 説明 設定 初期値
On/Off ヘッドホンの音にEQを適用するかどうかを設定します。 On, Off プリセットシーン

(Output)では一律.
「Off」

Type ヘッドホンの音に適用するEQのタイプを選択します。 EQタイプリスト参照 プリセットシーン
(Output)では一律.
「Thru」
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Page 2/5

パラメーター 説明 設定 初期値
Low Freq ヘッドホンの音に適用するEQの低音域の中心周波数を設定しま

す。
16.0 Hz～ 24.4 kHz プリセットシーン

(Output)では一律.
「100 Hz」

Low Gain Low Freq で設定した周波数付近の信号をブースト/カットします。−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Output)では一律.
「0 dB」

Low Q EQ低域のQ(周波数特性)を設定します。Low Shapeが
「LowShelving」に設定されている場合、Low Qの値は効果し
ません。

0.1 ～ 12.0 プリセットシーン
(Output)では一律.
「0.7」

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip

プリセットシーン
(Output)では一律.
「LowShelving」

Page 3/5

パラメーター 説明 設定 初期値
MidLow Freq ヘッドホンの音に適用するEQの中低音域の中心周波数を設定し

ます。
16.0 Hz～ 24.4 kHz プリセットシーン

(Output)では一律.
「500 Hz」

MidLow Gain MidLow Freq で設定した周波数付近の信号をブースト/カット
します。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Output)では一律.
「0 dB」

MidLow Q EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Output)では一律.
「0.7」

Page 4/5

パラメーター 説明 設定 初期値
MidHigh Freq ヘッドホンの音に適用するEQの中高音域の中心周波数を設定し

ます。
16.0 Hz～ 24.4 kHz プリセットシーン

(Output)では一律.
「2.00 ｋHz」

MidHigh Gain MidHigh Freq で設定した周波数付近の信号をブースト/カット
します。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Output)では一律.
「0 dB」

MidHigh Q EQ中高域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Output)では一律.
「0.7」

Page 5/5

パラメーター 説明 設定 初期値
High Freq ヘッドホンの音に適用するEQの高音域の中心周波数を設定しま

す。
16.0 Hz～ 24.4 kHz プリセットシーン

(Output)では一律.
「10.0 ｋHz」

High Gain High Freq で設定した周波数付近の信号をブースト/カットします。 −12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Output)では一律.
「0 dB」

High Q EQ高域のQ(周波数特性)を設定します。High Shapeが
「HighShelving」の場合、High Qの値は効果しません。

0.1 ～ 12.0 プリセットシーン
(Output)では一律.
「0.7」

High Shape EQ高域の周波数特性の形状を選択します。 HighShelving, 
PeakDip

プリセットシーン
(Output)では一律.
「HighShelving」
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Aux In
[AUX IN]端子から入力されるオーディオに関する設定です。

Aux In →Aux In Vol
[AUX IN]端子から入力されるオーディオの音量に関する設定です。

パラメーター 説明 設定 初期値
Volume [AUX IN]端子から入力されるオーディオの音量を調節します。 0～ 127 プリセットシーン(Aux In)

では一律「100」

Aux In →Aux In EQ
[AUX IN]端子から入力されるオーディオのEQに関する設定です。

NOTE
イコライザー (EQ)については、25ページの図解をご参照ください。

Page 1/6

パラメーター 説明 設定 初期値
On/Off [AUX IN]端子から入力されるオーディオにEQをかける(On)か

かけない(Off)かを設定します。
Off, On プリセットシーン(Aux In)

では一律「Off」

Page 2/6

パラメーター 説明 設定 初期値
Low Freq [AUX IN]端子から入力されるオーディオに適用するEQの低音

域の中心周波数を設定します。
32 Hz ～ 2.0 kHz プリセットシーン(Aux In)

では一律「125 Hz」

Low Gain Low Freq で設定した周波数付近の信号をブースト/カットします。−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(Aux In)
では一律「0 dB」

Low Q EQ低域のQ(周波数特性)を設定します。Low Shapeが
「LowShelving」に設定されている場合、Low Qの値は効果し
ません。

0.1 ～ 12.0 プリセットシーン(Aux In)
では一律「0.9」

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip

プリセットシーン(Aux In)
では一律「LowShelving」

Page 3/6

パラメーター 説明 設定 初期値
MidLow Freq [AUX IN]端子から入力されるオーディオに適用するEQの中低音

域の中心周波数を設定します。
100 Hz ～ 10.0 kHz プリセットシーン(Aux In)

では一律「500 Hz」

MidLow Gain MidLow Freq で設定した周波数付近の信号をブースト/カット
します。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(Aux In)
では一律「0 dB」

MidLow Q EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン(Aux In) 
では一律「0.9」
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Page 4/6

パラメーター 説明 設定 初期値
MidHigh Freq [AUX IN]端子から入力されるオーディオに適用するEQの高低音

域の中心周波数を設定します。
100 Hz ～ 10.0 kHz プリセットシーン(Aux In)

では一律「4.0 kHz」

MidHigh Gain MidHigh Freq で設定した周波数付近の信号をブースト/カット
します。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(Aux In)
では一律「0 dB」

MidHigh Q EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン(Aux In)
では一律「0.9」

Page 5/6

パラメーター 説明 設定 初期値
High Freq [AUX IN]端子から入力されるオーディオに適用するEQの高音域

の中心周波数を設定します。
500 Hz ～ 16.0 kHz プリセットシーン(Aux In)

では一律「9.0 kHz」

High Gain High Freq で設定した周波数付近の信号をブースト/カットします。 −12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(Aux In)
では一律「0 dB」

High Q EQ高域のQ(周波数特性)を設定します。High Shapeが
「HighShelving」の場合、High Qの値は効果しません。

0.1 ～ 12.0 プリセットシーン(Aux In)
では一律「0.9」

High Shape EQ高域の周波数特性の形状を選択します。「LPF」を選択した場
合は、イコライザー全体がローパスフィルターに切り替わります。

HighShelving, 
PeakDip, LPF

プリセットシーン(Aux In)
では一律「HighShelving」

Page 6/6

パラメーター 説明 設定 初期値
HPF Freq [AUX IN]端子から入力されるオーディオには、EQ設定とは別に

ハイパスフィルター (HPF)も適用できます。ここで設定した周波
数より低い周波数域の音はカットされます。「Thru」に設定した場合
は、HPFは適用されません。

Thru, 56 Hz ～.
2.0 kHz

プリセットシーン(Aux In)
では一律「Thru」

HPF Q ハイパスフィルターのQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン(Aux In)
では一律「0.7」
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Aux In →Aux In Out
[AUX IN]端子経由で本製品に入力されたオーディオの、外部出力時に関する設定です。

Page 1/2

パラメーター 説明 設定 初期値
Mode [AUX IN]端子経由で本製品に入力された左右(LとR)のオーディ

オにつき、どのように処理するかを設定します。
Stereo (ステレオ)
入力されたステレオ音を、ステレオのまま処理します。
L Mono (Lモノラル)
左チャンネルの音だけを使います。
R Mono (Rモノラル)
右チャンネルの音だけを使います。
L+R Mono (L+Rモノラル)
左チャンネルと右チャンネルをミックスして、モノラル音として処
理します。
L Guide (Lガイド)
ガイド(クリック)音がL側に、その他のバッキング音がR側に分離し
たオーディオを入力するときに選びます。[PHONES]端子から
ガイド(クリック)音とバッキング音が、[OUTPUT]端子と[USB 
TO HOST]端子からバッキング音のみが、それぞれセンター定
位で出力されます。[PHONES]端子のガイド(クリック)音量は
[CLICK]スライダーで、バッキングの音量は[AUDIO]スライダー
で調節できます。
R Guide (Rガイド)
ガイド(クリック)音がR側に、その他のバッキング音がL側に分離し
たオーディオを入力するときに選びます。[PHONES]端子から
ガイド(クリック)音とバッキング音が、[OUTPUT]端子と[USB 
TO HOST]端子からバッキング音のみが、それぞれセンター定
位で出力されます。[PHONES]端子のガイド(クリック)音量は
[CLICK]スライダーで、バッキングの音量は[AUDIO]スライダー
で調節できます。

Stereo, L Mono, R 
Mono, L+R Mono, 
L Guide, R Guide

プリセットシーン(Aux In)
では一律「Stereo」

Main Out [AUX IN]端子経由で本製品に入力されたオーディオにつき、
[OUTPUT]端子から出力する(On)か出力しない(Off)かを設定
します。

Off, On プリセットシーン(Aux In)
では一律「On」

Phones Out [AUX IN]端子経由で本製品に入力されたオーディオにつき、
[PHONES]端子から出力する(On)か出力しない(Off)かを設定し
ます。

Off, On

USB Audio Out 
1/2

[AUX IN]端子経由で本製品に入力されたオーディオにつき、
[USB TO HOST]端子から出力する(On)か出力しない(Off)かを
設定します。

Off, On

Backing Out 
Level

Mode=L Guide または R Guide のときに表示される項目で
す。[OUTPUT]端子および[USB TO HOST]端子(USB Audio 
1/2)から出力されるバッキングの音量を設定します。Mode=L 
Guideの場合はRがバッキング音になり、Mode=R Guide の場
合はLがバッキング音になります。

0～ 127 プリセットシーン(Aux In)
では一律「127」
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Page 2/2

パラメーター 説明 設定 初期値
IndivOut [AUX IN]端子経由で本製品に入力された左右(LとR)のオーディ

オにつき、外部出力時にどのチャンネルを使うかを設定します。
Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L(1+2), R(1+2), 
L(3+4), R(3+4), 
L(5+6), R(5+6), 
L(7+8), R(7+8), 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8 
*	各設定値については、
93ページ下にある
表をご参照ください。

プリセットシーン(Aux In)
では一律「Off」

IndivOut Vol [AUX IN]端子経由で本製品に入力された左右(LとR)のオーディ
オにつき、[INDIVIDUAL OUTPUT]端子から出力するときの
音量を設定します。「Variable」に設定すると、音量は[AUDIO]ス
ライダー操作に連動します。

Variable, 1 ～ 127 プリセットシーン(Aux In)
では一律「Variable」
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USB Audio
[USB TO HOST]端子経由で入出力されるオーディオに関する設定です。

USB Audio →USB Audio
[USB TO HOST]端子経由で入出力されるオーディオに関する設定です。

パラメーター 説明 設定 初期値
Mode [USB TO HOST]端子経由で入出力されるオーディオのチャン

ネル構成を設定します。ここでの設定は電源を入れ直したあと
有効になります。

2in/2out, 
8in/10out

プリセットシーン
(USB Audio)では一律
「2in/2out」

In Volume 入力時の各ステレオチャンネルの音量を調節します。USB 
Audio In 3/4, 5/6, 7/8 の設定は、Mode=8in/10outの場
合にのみ有効です。設定は、[F1] InSelで入力時のUSBオーディ
オチャンネルを選択してから、行ってください。

0～ 127 プリセットシーン(USB 
Audio)では一律「100」

Out Gain [USB TO HOST]端子からオーディオが出力されるときの
ゲインを調節します。USB Audio Out 3 ～ 10の設定は、
Mode=8in/10out の場合にのみ有効です。設定は、[F1] 
OutSelで出力時のUSBオーディオチャンネルを選択してから、
行ってください。

−18 dB, −12 dB, .
−6 dB, 0 dB, +6 dB, 
+12 dB, +18 dB

プリセットシーン(USB 
Audio)では一律「0 dB」

USB Audio →USB Audio EQ
[USB TO HOST]端子から入力されるオーディオのEQに関する設定です。ここでの各項目は、[F1] InSelで入力時のUSBオーディ
オチャンネルを選択してから、設定します。

NOTE
イコライザー (EQ)については、25ページの図解をご参照ください。

Page 1/6

パラメーター 説明 設定 初期値
On/Off [USB TO HOST]端子から入力されるオーディオに、EQをかけ

る(On)かかけない(Off)かを設定します。「Off」に設定した場合
は、各周波数域でのゲイン=0かつHPF FreqのThru設定と同等
の効果になります。

Off, On プリセットシーン(USB 
Audio)では一律「Off」

Page 2/6

パラメーター 説明 設定 初期値
Low Freq [USB TO HOST]端子から入力されるオーディオに適用する、

EQの低音域の中心周波数を設定します。
32 Hz ～ 2.0 kHz プリセットシーン(USB 

Audio)では一律.
「125 Hz」

Low Gain Low Freq で設定した周波数付近の信号をブースト/カットします。−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(USB 
Audio)では一律「0 dB」

Low Q EQ低域のQ(周波数特性)を設定します。Low Shapeが
「LowShelving」に設定されている場合、Low Qの値は効果し
ません。

0.1 ～ 12.0 プリセットシーン(USB 
Audio)では一律「0.9」

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip

プリセットシーン
(USB Audio)では一律
「LowShelving」
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Page 3/5

パラメーター 説明 設定 初期値
MidLow Freq [USB TO HOST]端子から入力されるオーディオに適用する、EQ

の中低音域の中心周波数を設定します。
100 Hz ～ 10.0 kHz プリセットシーン(USB 

Audio)では一律.
「500 Hz」

MidLow Gain MidLow Freq で設定した周波数付近の信号をブースト/カット
します。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(USB 
Audio)では一律「0 dB」

MidLow Q MidLow Freq で設定した周波数付近につき、ブースト/カットす
る帯域の幅を設定します。設定値が小さいほど帯域の幅が広く
なり、音の変化はなだらかになります。設定値が大きいほど帯域
が狭くなり、特徴的な音の変化となります。

0.1 ～ 12.0 プリセットシーン(USB 
Audio)では一律「0.9」

Page 4/6

パラメーター 説明 設定 初期値
MidHigh Freq [USB TO HOST]端子から入力されるオーディオに適用する、EQ

の高低音域の中心周波数を設定します。
100 Hz ～ 10.0 kHz プリセットシーン(USB 

Audio)では一律.
「4.0 kHz」

MidHigh Gain MidHigh Freq で設定した周波数付近の信号をブースト/カット
します。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(USB 
Audio)では一律「0 dB」

MidHigh Q MidHigh Freq で設定した周波数付近につき、ブースト/カットす
る帯域の幅を設定します。設定値が小さいほど帯域の幅が広く
なり、音の変化はなだらかになります。設定値が大きいほど帯域
が狭くなり、特徴的な音の変化となります。

0.1 ～ 12.0 プリセットシーン(USB 
Audio)では一律「0.9」

Page 5/6

パラメーター 説明 設定 初期値
High Freq [USB TO HOST]端子から入力されるオーディオに適用する、EQ

の高音域の中心周波数を設定します。
500 Hz ～ 16.0 kHz プリセットシーン(USB 

Audio)では一律.
「9.0 kHz」

High Gain High Freq で設定した周波数付近の信号をブースト/カットします。 −12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン(USB 
Audio)では一律「0 dB」

High Q EQ高域のQ(周波数特性)を設定します。High Shapeが
「HighShelving」の場合、High Qの値は効果しません。

0.1 ～ 12.0 プリセットシーン(USB 
Audio)では一律「0.9」

High Shape EQ高域の周波数特性の形状を選択します。 HighShelving, 
PeakDip, LPF

プリセットシーン(USB 
Audio)では一律.
「HighShelving」

Page 6/6

パラメーター 説明 設定 初期値
HPF Freq [USB TO HOST]端子から入力されるオーディオには、EQ設定と

は別にハイパスフィルター (HPF)も適用できます。ここで設定し
た周波数より低い周波数域の音はカットします。「Thru」に設定した
場合は、HPFは適用されません。

Thru, 56 Hz ～.
2.0 kHz

プリセットシーン(USB 
Audio)では一律「0.7」

HPF Q ハイパスフィルターのQ(周波数特性)を設定します。 0.1 ～ 12.0 0.7
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USB Audio →USB AudioOut
[USB TO HOST]端子経由で本製品に入力されたオーディオの、外部出力時に関する設定です。ここでの各項目は、[F1] InSelで
入力時のUSBオーディオチャンネルを選択してから、設定します。

Page 1/2

パラメーター 説明 設定 初期値
Mode [USB TO HOST]端子経由で本製品に入力されたオーディオに

つき、どのように処理するかを設定します。
Stereo (ステレオ)
入力されたステレオ音を、ステレオのまま処理します。
L Mono (Lモノラル)
左チャンネルの音だけを使います。
R Mono (Rモノラル)
右チャンネルの音だけを使います。
L+R Mono (L+Rモノラル)
左チャンネルと右チャンネルをミックスして、モノラル音として処
理します。
L Guide (Lガイド)
ガイド(クリック)音がL側に、その他のバッキング音がR側に分離
したオーディオを入力するときに選びます。ガイド(クリック)音と
バッキング音がセンター定位で[PHONES]端子から、バッキング
音が[OUTPUT]端子および[USB TO HOST]端子からセンター
定位で出力されます。[PHONES]端子のガイド(クリック)音量は
[CLICK]スライダーで、バッキングの音量は[AUDIO]スライダー
で調節できます。
R Guide (Rガイド)
ガイド(クリック)音がR側に、その他のバッキング音がL側に分離
したオーディオを入力するときに選びます。ガイド(クリック)音と
バッキング音がセンター定位で[PHONES]端子から、バッキング
音が[OUTPUT]端子および[USB TO HOST]端子からセンター
定位で出力されます。[PHONES]端子のガイド(クリック)音量は
[CLICK]スライダーで、バッキングの音量は[AUDIO]スライダー
で調節できます。

Stereo, L Mono, R 
Mono, L+R Mono, 
L Guide, R Guide

Stereo

Main Out [USB TO HOST]端子経由で本製品に入力されたオーディオに
つき、[OUTPUT]端子から出力する(On)か出力しない(Off)か
を設定します。

Off, On On

Phones Out [USB TO HOST]端子経由で本製品に入力されたオーディオに
つき、[PHONES]端子から出力する(On)か出力しない(Off)か
を設定します。

Off, On On

USB Audio 
Out1/2

[USB TO HOST]端子経由で本製品に入力されたオーディオに
つき、[USB TO HOST]端子から出力する(On)か出力しない
(Off)かを設定します。

Off, On On

Backing Out 
Level

Mode=L Guide または R Guide のときに表示される項目で
す。[OUTPUT]端子および[USB TO HOST]端子(USB Audio 
1/2)から出力されるバッキングの音量を設定します。Mode=L 
Guideの場合はRがバッキング音になり、Mode=R Guide の場
合はLがバッキング音になります。

0～ 127 127
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Page 2/2

パラメーター 説明 設定 初期値
IndivOut [USB TO HOST]端子経由で本製品に入力された左右(LとR)の

オーディオにつき、外部出力時にどのチャンネルを使うかを設定
します。

Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L(1+2), R(1+2), 
L(3+4), R(3+4), 
L(5+6), R(5+6), 
L(7+8), R(7+8), 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8 
*	各設定値については、
93ページ下にある
表をご参照ください。

Off

IndivOut Vol [USB TO HOST]端子経由で本製品に入力された左右(LとR)
のオーディオにつき、[INDIVIDUAL OUTPUT]端子から出力
するときの音量を設定します。「Variable」に設定すると、音量は
[AUDIO]スライダーの操作に連動します。

Variable, 1 ～ 127 Variable
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Bluetooth

	■ Bluetooth(無線によるオーディオ/MIDI通信)
本製品はBluetoothに対応しており、オーディオの受信(Bluetoothオーディオ)およびMIDIの送受信(Bluetooth MIDI)が可能です。
ここでは、主にBluetoothオーディオに関する設定を行います。

Bluetoothオーディオ接続
本製品でBluetooth On/Off を「On」に設定したあと、ペアリングを行うこと(後述)で、接続し
ます。接続が完了するとBluetooth機器の画面に「EAD50 Audio(xxxxxx)」と表示され、本
製品画面上のBluetoothアイコン下に「A」が表示されます。

Bluetooth MIDI接続
本製品でBluetooth On/Off を「On」に設定したあと、スマートデバイスなどBluetooth機器
のアプリから接続を実行します。ペアリングは不要です。接続が完了するとBluetooth機器
の画面に「EAD50 MIDI(xxxxxx)」と表示され、本製品画面上のBluetoothアイコン下に「M」
が表示されます。

NOTE
•	 Bluetoothアイコンの下にアルファベット表記がない場合は、オーディオおよびMIDIの両方の通信が

可能な状態であることを示しています。
•	 Bluetoothによる接続事例など、41ページにも関連説明がありますので、ご確認ください

Bluetooth →Bluetooth
Bluetoothの基本的な設定を行います。

パラメーター 説明 設定 初期値
On/Off Bluetooth経由でオーディオ/MIDI通信をする(On)/しない

(Off)を設定します。
Off, On プリセットシーン

(Bluetooth)では一律
「Off」

Volume Bluetooth経由で入力されたオーディオの音量を調節します。 0～ 127 プリセットシーン
(Bluetooth)では一律
「100」

Pairing [ENTER]ボタンを押すことで、Bluetooth機器とのペアリング
を実施します。Bluetooth機器側の画面に接続先として「EAD50 
Audio(xxxxxxxx）」が表示されたら、選択することでペアリング
が実施されます。
NOTE
•	 ペアリングは、5分以内に行ってください。5分を過ぎると、
「Bluetooth pairing...」の表示が自動的に終了します。また、パ
スキーの入力を要求された場合は、数字で｢0000｣を入力してくだ
さい。

•	 [MENU]ボタンを長押しすることでも、Bluetooth機器とのペアリ
ングを実施できます。

•	 ペアリング操作は、本製品に初めてBluetooth機器を接続する場合
に必要です。一度ペアリングを実施したら、Bluetooth機器側で
解除しない限り、再度行う必要はありません。

— —

Bluetoothアイコン(A)

Bluetoothアイコン(M)

Bluetoothアイコン(表記無し)
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Bluetooth →Bluetooth EQ
Bluetooth経由で入力されるオーディオの、EQに関する設定です。

NOTE
イコライザー (EQ)については、25ページの図解をご参照ください。

Page 1/6

パラメーター 説明 設定 初期値
On/Off Bluetooth経由で入力されるオーディオに、EQをかける(On)か

かけない(Off)かを設定します。「Off」に設定した場合は、各周波
数域でのゲイン=0かつHPF FreqのThru設定と同等の効果にな
ります。

Off, On プリセットシーン
(Bluetooth)では一律
「Off」

Page 2/6

パラメーター 説明 設定 初期値
Low Freq Bluetooth経由で入力されるオーディオにつき、EQ低音域の中

心周波数を設定します。
32 Hz ～ 2.0 kHz プリセットシーン

(Bluetooth)では一律
「125 Hz」

Low Gain Low Freq で設定した周波数付近の信号をブースト/カットします。−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Bluetooth)では一律.
「0 dB」

Low Q EQ低域のQ(周波数特性)を設定します。Low Shapeが
「LowShelving」に設定されている場合、Low Qの値は効果し
ません。

0.1 ～ 12.0 プリセットシーン
(Bluetooth)では一律
「0.9」

Low Shape EQ低域の周波数特性の形状を選択します。 LowShelving, 
PeakDip

プリセットシーン
(Bluetooth)では一律
「LowShelving」

Page 3/6

パラメーター 説明 設定 初期値
MidLow Freq Bluetooth経由で入力されるオーディオに適用する、EQの中低

音域の中心周波数を設定します。
100 Hz ～ 10.0 kHz プリセットシーン

(Bluetooth)では一律
「500 Hz」

MidLow Gain MidLow Freq で設定した周波数付近の信号をブースト/カット
します。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Bluetooth)では一律.
「0 dB」

MidLow Q EQ中低域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Bluetooth)では一律
「0.9」

Page 4/6

パラメーター 説明 設定 初期値
MidHigh Freq Bluetooth経由で入力されるオーディオに適用する、EQの高低音

域の中心周波数を設定します。
100 Hz ～ 10.0 kHz プリセットシーン

(Bluetooth)では一律
「4.0 kHz」

MidHigh Gain MidHigh Freq で設定した周波数付近の信号をブースト/カット
します。

−12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Bluetooth)では一律.
「0 dB」

MidHigh Q EQ中高域のQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Bluetooth) では一律
「0.9」
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Page 5/6

パラメーター 説明 設定 初期値
High Freq Bluetooth経由で入力されるオーディオに適用する、EQの高音域

の中心周波数を設定します。
500 Hz ～ 16.0 kHz プリセットシーン

(Bluetooth)では一律
「9.0 kHz」

High Gain High Freq で設定した周波数付近の信号をブースト/カットします。 −12 dB ～ 0 dB ～ 
+12 dB

プリセットシーン
(Bluetooth)では一律.
「0 dB」

High Q EQ高域のQ(周波数特性)を設定します。High Shapeが
「HighShelving」の場合、High Qの値は効果しません。

0.1 ～ 12.0 プリセットシーン
(Bluetooth)では一律
「0.9」

High Shape EQ高域の周波数特性の形状を選択します。 HighShelving, 
PeakDip, LPF

プリセットシーン
(Bluetooth)では一律
「HighShelving」

Page 6/6

パラメーター 説明 設定 初期値
HPF Freq Bluetooth経由で入力されるオーディオには、EQ設定とは別にハ

イパスフィルター (HPF)も適用できます。ここで設定した周波数
より低い周波数域の音はカットします。「Thru」に設定した場合は、
HPFは適用されません。

Thru, 56 Hz ～.
2.0 kHz

プリセットシーン
(Bluetooth)では一律
「Thru」

HPF Q ハイパスフィルターのQ(周波数特性)を設定します。 0.1 ～ 12.0 プリセットシーン
(Bluetooth)では一律
「0.7」
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Bluetooth →Bluetooth Out
Bluetooth経由で本製品に入力されたオーディオの、外部出力時に関する設定です。

Page 1/2

パラメーター 説明 設定 初期値
Mode Bluetooth経由で本製品に入力されたオーディオにつき、出力時

にどのように処理するかを設定します。
Stereo (ステレオ)
入力されたステレオ音を、ステレオのまま処理します。
L Mono (Lモノラル)
左チャンネルの音だけを使います。
R Mono (Rモノラル)
右チャンネルの音だけを使います。
L+R Mono (L+Rモノラル)
左チャンネルと右チャンネルをミックスして、モノラル音として処
理します。
L Guide (Lガイド)
ガイド(クリック)音がL側に、その他のバッキング音がR側に分離
したオーディオを入力するときに選びます。ガイド(クリック)音と
バッキング音がセンター定位で[PHONES]端子から、バッキング
音が[OUTPUT]端子および[USB TO HOST]端子からセンター
定位で出力されます。[PHONES]端子のガイド(クリック)音量は
[CLICK]スライダーで、バッキングの音量は[AUDIO]スライダー
で調節できます。
R Guide (Rガイド)
ガイド(クリック)音がR側に、その他のバッキング音がL側に分離
したオーディオを入力するときに選びます。ガイド(クリック)音と
バッキング音がセンター定位で[PHONES]端子から、バッキング
音が[OUTPUT]端子および[USB TO HOST]端子からセンター
定位で出力されます。[PHONES]端子のガイド(クリック)音量は
[CLICK]スライダーで、バッキングの音量は[AUDIO]スライダー
で調節できます。

Stereo, L Mono, R 
Mono, L+R Mono, 
L Guide, R Guide

プリセットシーン
(Bluetooth)では一律
「Stereo」

Main Out Bluetooth経由で本製品に入力されたオーディオにつき、
[OUTPUT]端子から出力する(On)か出力しない(Off)かを設定
します。

Off, On プリセットシーン
(Bluetooth)では一律
「On」

Phones Out Bluetooth経由で本製品に入力されたオーディオにつき、
[PHONES]端子から出力する(On)か出力しない(Off)かを設定し
ます。

Off, On

USB Audio Out 
1/2

Bluetooth経由で本製品に入力されたオーディオにつき、[USB 
TO HOST]端子から出力する(On)か出力しない(Off)かを設定
します。

Off, On

Backing Out 
Level

Mode=L Guide または R Guide のときに表示される項目で
す。[OUTPUT]端子および[USB TO HOST]端子(USB Audio 
1/2)から出力されるバッキングの音量を設定します。Mode=L 
Guideの場合はRがバッキング音になり、Mode=R Guide の場
合はLがバッキング音になります。

0～ 127 プリセットシーン
(Bluetooth)では一律
「127」
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Page 2/2

パラメーター 説明 設定 初期値
IndivOut Bluetooth経由で本製品に入力された左右(LとR)のオーディオ

につき、外部出力時にどのチャンネルを使うかを設定します。
Off, L1+R2, L3+R4, 
L5+R6, L7+R8, 
L(1+2), R(1+2), 
L(3+4), R(3+4), 
L(5+6), R(5+6), 
L(7+8), R(7+8), 
L1, R2, L3, R4, L5, 
R6, L7, R8, (L+R)1, 
(L+R)2, (L+R)3, 
(L+R)4, (L+R)5, 
(L+R)6, (L+R)7, 
(L+R)8 
*	各設定値については、
93ページ下にある
表をご参照ください。

プリセットシーン
(Bluetooth)では一律
「Off」

IndivOut Vol Bluetooth経由で本製品に入力されたオーディオにつき、
[INDIVIDUAL OUTPUT]端子から出力するときの音量を設定
します。「Variable」に設定すると、音量は[AUDIO]スライダー
の操作に連動します。

Variable, 1 ～ 127 プリセットシーン
(Bluetooth)では一律
「Variable」
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File
本製品に接続したメディア(USBフラッシュメモリーまたはSDカード)に保存したファイルに関する操作を行います。USBフラッシュメ
モリーやSDカードに本製品で制作したデータをファイルとして保存したり、逆にそれらに保存されたファイルを本製品に読み込んだり
します。

NOTE
本製品の内部メモリーと外部メモリー (メディア)との関係については、26ページの図をご参照ください。

File →File All
本製品で制作した全てのシーン、ライブセット、ユーザーボイスを収納するファイル(初期ファイル名「All.bin」)に関する操作です。

ご注意
レコーダー /ルーパー /サンプリングにより録音した内部メモリー上のデータやオーディオファイルは含みませんのでご注意ください。

	● Save
本製品で制作した全てのシーン、ライブセット、ユーザーボイスを、USBフラッシュメモリーまたはSDカードに、「All.bin」(初期ファイ
ル名)として保存します。[F1] Nameボタンにてファイル名を設定したあと、[ENTER]ボタンを押して保存(セーブ)を実行します。

「USB/SD」は、USBフラッ
シュメモリーとSDカード
の両方が接続されている
場合に表示されます。.
このボタンでどちらかを
選択します。

必要に応じて、保存先の
ファイル名を設定します。
名称設定の操作について
は、50ページをご参照
ください。

ご注意
保存先のメディアに同じ名称のファ
イルがある場合は、「Overwrite?」
(上書きしてもよいか)のメッセージ
が表示されます。その場合は、[F3] 
Noボタンを押して前の画面に戻り、
ファイル名を変更することをお勧め
します。

保存先のメディア(USBフラッシュ
メモリーまたはSDカード)

	● Load
USBフラッシュメモリー /SDカードに保存されている「All.bin」(初期ファイル名)のデータを本製品に読み込みます。
[+][−]ボタン/ノブにてファイルを選択したあと、[ENTER]ボタンを押して読み込み(ロード)を実行します。

USBフラッシュメモリーとSDカード
の両方が接続されている場合に表示
されます。このボタンでどちらかを
選択します。

[+][−]ボタン/ノブで、読み込
みたいファイルを選択します。

ご注意
この操作により、製品本体メモリー
に制作されていた全てのデータが
消去されるのでご注意ください。
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	● Rename
USBフラッシュメモリー /SDカードに保存されている「All.bin」(初期ファイル名)の名称を変更します。
[+][−]ボタン/ノブにてファイルを選択したあと、[F1] Nameボタンにて名称を変更し、[ENTER]ボタンを押して確定します。詳細
は50ページをご参照ください。

	● Delete
USBフラッシュメモリー /SDカードに保存されている「All.bin」(初期ファイル名)を削除します。
[+][−]ボタン/ノブにてファイルを選択したあと、[ENTER]ボタンを押して削除(デリート)を実行します。

File →File Scene
本製品で制作したシーンを個別に収納するファイル(初期ファイル名「Scene.bin」)に関する操作です。

	● Save
本製品で制作したシーンを、個別に「Scene.bin」(初期ファイル名)として保存します。選択したシーンにユーザーボイスがある場合は、
ユーザーボイスデータも含みます。

	● Load
USBフラッシュメモリー /SDカードに保存されているシーンのファイル(初期ファイル名「Scene.bin」)からデータを本体に読み込み
ます。

USBフラッシュメモリー
とSDカードの両方が接
続されている場合に表示
されます。このボタンで
どちらかを選択します。

必要に応じて、保存先の
ファイル名を設定します。
名称設定の操作方法につ
いては、50ページをご
参照ください。

ご注意
保存先のメディアに同じ名称のファ
イルがある場合は、「Overwrite?」
(上書きしてもよいか)のメッセージ
が表示されます。その場合は、[F3] 
Noボタンを押して前の画面に戻り、
ファイル名を変更することをお勧め
します。

保存先を選択します。[+][−]
ボタン/ノブで、既存ファイルを
選択するか、新規シーン(New 
Scene)を選択します。

[+][−]ボタン/ノブで、保存した
いシーンを選択します。

保存(セーブ)を実行します。

[+][−]ボタン/ノブで、読み込
み先とするシーン番号を選択し
ます。

[+][−]ボタン/ノブで、読み込
みたいファイルを選択します。 読み込み(ロード)を実行します。

ご注意
読み込み(ロード)により、読み込み
先のシーン番号にある設定は全て
消去されます。読み込み先のシー
ンに大切な設定が入っていないか、
ご注意ください。

NOTE
図におけるF1 ～ F3の「F」は

「Function(機能)」の意味で、
操作説明のために便宜的につ
けたボタン名称です。製品本
体には印字されていません。

必要に応じて、シーン内の各項目に対し
て読み込む(On)/読み込まない(Off) を
設定します。シーンのデータ構成につい
ては、50ページをご参照ください。

USBフラッシュメモリーと
SDカードの両方が接続さ
れている場合に表示されま
す。このボタンでどちらか
を選択します。
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	● Rename
USBフラッシュメモリー /SDカードに保存されているシーンのファイルの名称を変更します。
[+][−]ボタン/ノブにてファイルを選択したあと、[F1] Nameボタンにて名称を変更し、[ENTER]ボタンを押して確定します。詳細
は50ページをご参照ください。

	● Delete
USBフラッシュメモリー /SDカードに保存されているシーンのファイル(初期ファイル名「Scene.bin」)を削除します。
[+][−]ボタン/ノブにてファイルを選択したあと、[ENTER]ボタンを押して削除(デリート)を実行します。

File →File Wave
本製品は、「.aif」、「.aiff」、「.wav」の3種類のオーディオファイルに対応しています。

	● Rename
USBフラッシュメモリー /SDカードに保存されているオーディオファイルの名称を変更します。
[+][−]ボタン/ノブにてファイルを選択したあと、[F1] Nameボタンにて名称を変更し、[ENTER]ボタンを押して確定します。

	● Delete
USBフラッシュメモリー /SDカードに保存されているオーディオファイルを削除します。 
[+][−]ボタン/ノブにてファイルを選択したあと、[ENTER]ボタンを押して削除(デリート)を実行します。

File →ExtMem Info(外部メモリーの使用容量/フォーマット)
本製品に接続しているメディア(USBフラッシュメモリー /SDカード)の使用容量を表示します。

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の
意味で、操作説明のために便宜的につけたボタン
名称です。製品本体には印字されていません。

SDカードの全容量USBフラッシュメモリーの全容量

SDカードの使用容量USBフラッシュメモリーの使用容量

USBフラッシュメモリーを
フォーマットできます。

SDカードをフォーマット
できます。

[F1]ボタンを押すことにより、
フォーマットが実行されます。

本製品がSDカードを扱うことを
示しています。

本製品がUSBフラッシュメモリー
を扱うことを示しています。

[F2]ボタン

[F2]ボタン
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Factory Reset
本製品の内部メモリーを工場出荷時の初期状態に戻します。

Version
本製品に搭載されているファームウェアのバージョンが表示されます。

NOTE
図におけるF1 ～ F3の「F」は「Function(機能)」の意味
で、操作説明のために便宜的につけたボタン名称です。
製品本体には印字されていません。
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困ったときは

現象 考えられる原因 対策 参照﻿
ページ

音が思ったとおりに鳴らない(Unexpected Sound)
音が出ない .
(No Sound)

電源が入っていない 電源がオンになっているか確認してください。 クイック
ガイド

本製品でのボタン操作に
よる

•	パネル左下にある[MUTE ALL]ボタンの点灯状態を確認してく
ださい。

•	パネル中央下にあるチャンネルオン/オフボタン(1～5)の点灯状
態をご確認ください。

7
70
71

DSU50やコンデンサマイ
ク接続時のファンタム電
源設定

DSU50やコンデンサマイクを接続している場合は、ファンタム電
源が入っていないと音は出ません。下記画面にてご確認ください。
[MIC/TRIG] →[F3] Setting →Mic →Mic In →Phantom

87

ケーブルが正しく接続され
ていない、またはケーブル
が切れている

センサーユニットDSU50とメインユニット(本製品)が、正しく接続
されているか確認してください。

DSU50 
取扱説明書

お使いのケーブルに不良はないか確認してください。 ー
ヘッドフォンやアンプ/スピーカーなどの外部機器がメインユニッ
ト(本製品)と正しく接続されているか確認してください。

ー

エフェクト設定の中にある
出力先の個別設定による

以下画面の設定をご確認ください。
[MIC/TRIG] →[F3] Setting →Mic →Mic Out →Effect Thru 
[MIC/TRIG] →[F3] Setting →Kit →Inst →Inst →Inst Out →Effect 
Thru

上記画面でEffect Thruが「On」であれば、以下3点のオン/オフ状
態をご確認ください。
•	Main Out ([OUTPUT]端子から出力)
•	Phones Out (ヘッドホンへの出力)
•	USB Audio Out1/2 (接続しているコンピューターへの出力)

93
107

音が出ない、または
期待される音量にな
らない

本製品の音量が上がって
いない

パネル右下のスライダー位置をご確認ください。 7
パネル中央下にあるLEDフェーダーの点灯状態をご確認ください。 70

71
本製品の音量設定が正し
くない

以下画面において、各チャンネルの音量を確認し、必要に応じて調
節してください。
[MIC/TRIG] →[F1] Volume

85

入力時のゲイン不足 以下画面において、本製品への入力ゲイン値を確認し、必要に応じ
て調節してください。
[MIC/TRIG] →[F3] Setting →Mic→Mic In →Gain
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Gain

87
95

マイク音の場合、接続ケーブ
ルのコネクター形状による

本製品の[MIC/LINE]端子にはXLRケーブル、TRSケーブルのいず
れも接続可能ですが、TRSケーブルの場合はゲインが低くなりま
す。TRSケーブルをお使いでゲインが上がりきらない場合は、XLR
ケーブルの使用をおすすめします。

8

マイク音の場合、トーク設
定による

トーク設定をオンにしていると、該当の[MIC/LINE]端子への入力
ゲイン値が大きくなります。必要に応じてトーク設定をオフにして
ください。

61

本製品に接続している外
部機器

本製品に接続している外部機器の電源やボリュームを、スライダ
ーなどのハード面および画面設定などのソフト面の両方をご確認
ください。

ー

資料
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資料

現象 考えられる原因 対策 参照﻿
ページ

音が思ったとおりに鳴らない(Unexpected Sound)　つづき
ヘッドホンの音量が
小さい

本製品の音量が上がって
いない

パネル右下の[PHONES]スライダーの位置をご確認ください。 ー

使用しているヘッドホンの
性能

EADの音を聞き取りやすくするため、外部音を遮断できるインイ
ヤーモニター、または密閉型ヘッドホンの使用をおすすめします。
ヘッドホンの性能によっては、キックなどの低音が聞こえにくい場
合がありますので、ご注意ください。

ー

本製品の設定 以下画面にてゲイン設定を変えてみてください。
[MENU] →Output →Output Gain →Phones Out

160

[PHONES]端子を2つとも
使用している

本製品では、ヘッドホン接続用にステレオ標準フォーン端子とステ
レオミニ端子が1つずつ装備されています。これら2つの端子に同
時に2つのヘッドホンを接続すると、出力が小さくなることがあり
ます。

8

トリガー音が鳴らな
い、または音が出に
くい(トリガーセン
サーを装着した場合
や電子ドラムパッド
を増設した場合)

本製品でのゲイン設定 該当パッド(該当トリガー入力) につき、以下の設定項目が適切か
確認してください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig Pairing 
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad 
 →Gain, Rim Gain, Min Level, Max Level

94
95

本製品でのパッドタイプ
設定

以下画面にてパッドタイプが適切かご確認ください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Category, 
Type

95

MIDIの設定が適切では
ない

以下の設定項目をご確認ください。「Off」に設定されているとボイ
スは鳴りません。
[MENU] →Utility →MIDI Local Control

159

接続しているパッドからのト
リガー出力レベルが低い

パッドに装備されている場合は、トリガー出力のレベル調節ツマミ
をご確認ください。

ー

トリガー音でフラム
やロールがうまく検
出されない.
(トリガーセンサーを
装着した場合や電子
ドラムパッドを増設
した場合)

本製品での設定 以下画面の数値を調整してください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad 
 →Reject Time

96

位置検出機能付きの
パッドが正しく鳴ら
ない

本製品での設定 まず、パッドが位置検出機能に対応した[TRIGGER INPUT]端子
(3/8, 4/9, 5/10)に接続してあるか、ご確認ください。

次に、以下画面でパッドタイプの設定を確認してください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Category, 
Type

さらに、以下画面でパッドに割り当てられているボイスを確認し、位
置検出機能に対応しているかどうかを別冊データリストの「ボイス
リスト」でご確認ください。
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice →Category, 
Number

またシンバルパッドの場合は、向きが正しいかご確認ください。向
きが正しくないと、性能を十分引き出せないことがあります。

19
95
108
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資料

現象 考えられる原因 対策 参照﻿
ページ

音が思ったとおりに鳴らない(Unexpected Sound)　つづき
(XP120SDなどに装
備されている)パッ
ドコントロールが機
能しない

ー 本製品は、(一部の電子ドラムパッドに装備されている)パッドコント
ロール機能に対応していません。

ー

外部メモリー(USB
フラッシュメモリ
ー/SDカード) のオ
ーディオファイルの
試聴音が鳴らない/
音量が小さい。

[MIC/TRIG]スライダー
の位置

[MIC/TRIG]スライダーはオーディオファイル試聴の音量も調整
対象になっています。適切な位置に置いた上で試聴してください。
各スライダーの調整対象は、7ページをご参照ください。

ー

クリック音が聞こえ
ない/音量が小さい

[CLICK]スライダー、 
[MIC/TRIG]スライダー
の位置

まずは[CLICK]スライダーを確認し、続いて[MIC/TRIG]スライダ
ーをご確認ください。外部メモリーのオーディオファイルをクリック
として鳴らしている場合は、[MIC/TRIG]スライダーが音量を調整
します。適切な位置に置いた上でクリックを鳴らしてください。各ス
ライダーの調整対象は、7ページをご参照ください。

ー

ユーザーボイスの試
聴音が鳴らない/音
量が小さい。

[MIC/TRIG]スライダー
の位置

[MIC/TRIG]スライダーはユーザーボイス試聴の音量も調整対象
になっています。適切な位置に置いた上で試聴してください。各ス
ライダーの調整対象は、7ページをご参照ください。

ー

音量バランス
演奏音の打楽器間の
音量バランスが悪い
•	マイク音同士のバ
ランス

•	トリガー音同士のバ
ランス

•	マイク音とトリガー
音のバランス

*マイク音：
	- アコースティックドラ

ム音
*トリガー音：

	- トリガーセンサーを装
着したアコースティック
ドラム演奏音

	- 電子ドラムパッドの
演奏音

LEDロータリーフェーダー
の調整状態による

パネル中央下にあるLEDロータリーフェーダーにつき、以下状態
でのLEDの点灯状態を確認し、必要に応じて調節してください。
•	[MIC]ボタンおよび[MIXER]をオンにした状態(Gain, Volume)
•	[TRIG]ボタンおよび[MIXER]をオンにした状態(Volume)

70

本製品の音量設定 以下画面において、各チャンネルの音量を確認し、必要に応じて調
節してください。

[MIC/TRIG] →[F1] Volume

85

接続している外部機
器からの入力音と本
製品での演奏音の音
量バランスが悪い

本製品の音量設定 パネル右下にあるボリュームスライダーの[AUDIO](外部機器か
ら入力される音の音量)と [MIC/TRIG](本製品での演奏音)を調
節してください。

7

本製品に接続している外部
機器の音量設定

ご確認ください。 ー
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資料

現象 考えられる原因 対策 参照﻿
ページ

音量バランス　つづき
USBフラッシュメ
モリー/SDカードの
再生音.
(レコーダー機能に
よる再生音)と、本
製品での演奏音との
音量バランスが悪い

本製品の音量設定 パネル右下にあるボリュームスライダーの[AUDIO](USBフラッ
シュメモリー/SDカードの再生音)と[MIC/TRIG](本製品での演奏
音)を調節してください。

7

シンバルなど、特
定のドラムの音が
小さい

センサーユニットDSU50
やマイクの設置位置

センサーユニット含め、マイクから遠くにあるドラムの音は小さく
なることがあります。ドラムセットやマイクの位置を見直すか、追加
でマイクを設置することをご検討ください。

ー

バスドラムの音量
感/低音感がもの足
りない

センサーユニットDSU50
やマイクの設置状態

本製品でのバスドラム演奏については、音量感/低音感を出すた
め、付属のDSU50を活用しトリガー音を鳴らす方式としています。
したがって、DSU50が適切にバスドラムに設置できているかをご
確認ください。
トリガー音ではなく、アコースティックのバスドラム音を増強し
たい場合は、バスドラム専用のマイクを追加で設置してくださ
い。DSU50のマイクはドラムキット全体を捉えられるようチューニ
ングされており、バスドラム音に特化したマイクではないため、市
販のバスドラム専用マイクの活用をお勧めします。

DSU50 
取扱説明書

バスドラムのトリガ
ー音が鳴らない

センサーユニットDSU50
がバスドラムに正しく装着
されていない

センサーユニットDSU50がフープへ正しく固定されているか確認
してください。

ー

バスドラムの状態による バスドラムのヘッドの種類やテンションの影響を受ける場合もあり
ますので、調整してみてください。

ー

演奏中にクリックが
聞こえにくい

クリックの音量設定、他チャ
ンネルとの音量バランス

クリックが他の音に埋もれてしまう場合は、以下操作によりクリック
の音量を調節してください。
•	パネル右下のボリュームスライダーの位置([CLICK]とそれ以外

のバランス)
•	[CLICK] →Click →Volume

7
130

ユーザーボイスが鳴
らない

ユーザーボイスに割り当て
たウェーブデータが削除さ
れている

以下いずれかの画面にて、該当ボイスにウェーブが割り当てられて
いるかご確認ください。
[MIC/TRIG] →[F3] Setting →Kit →User Voice →Edit Velocity 
Limit L/H
[MIC/TRIG] →[F3] Setting →Kit →User Voice →Delete Wave

117
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資料

現象 考えられる原因 対策 参照﻿
ページ

ノイズ
全般的にノイズが気
になる

使用ケーブルによる 特に、外部機器に接続するケーブルが長い場合、[OUTPUT 
-UNBALANCED-]端子(TRSケーブル)だとノイズ混入の可能性
が高まるため、[OUTPUT -BALANCED-]端子(XLRケーブル)によ
る接続をお勧めします。

ー

ノイズがどこから
鳴っているかわか
らない

ー チャンネルを1つずつオン/オフしてノイズの出所を探してみてく
ださい。オンからオフに切り替えてノイズが消えれば、そのチャン
ネルがノイズ発生源となります。

70
71

マイク音(アコーステ
ィックドラムなど)に
対してノイズが発生
する

適切に設置できていない DSU50使用の場合は、その付近でケーブルが動かないように付
属のケーブルバンドなどで固定してください。

ー

DSU50使用の場合は、フープへ正しく固定されているか確認して
ください。

ー

DSU50使用の場合は、必ず付属のケーブルをご使用ください。同じよ
うな端子形状の照明制御用のケーブル(DMXケーブル)を使うと、ノイ
ズの原因になります。

34

マイク設置の場合は、マイク周辺の振動状況をご確認ください。 ー
ゲイン設定が適切でない 以下画面でゲイン値を調節してください。

[MIC/TRIG] →[F3] Setting →Mic →Mic In →Gain 
87

トリガー音に対して
ノイズが発生する.
(トリガーセンサー
を装着した場合や電
子ドラムパッドを増
設した場合)

適切に設置できていない トリガーセンサー設置の場合は、その周辺の振動状況をご確認く
ださい。
電子ドラムパッド接続の場合は、パッド周辺の振動状況をご確認く
ださい。

ー

ゲイン設定が適切でない 以下画面でゲイン値を調節してください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Gain 

95

電源オン直後にノイ
ズが発生する

ペアリング済みの
Bluetooth機器を本製品
が探している間、ノイズが
発生する場合があります

異常ではありません。
ペアリング済みのBluetooth機器と接続しない場合は、以下画面
にて本製品のBluetooth をオフにしてください。
[MENU] →Bluetooth →Bluetooth →On/Off本製品のBluetooth

オン直後にノイズが
発生する
スピーカーからハウ
リング音が出る

スピーカーとマイク位置の
距離が近い

特にモニタースピーカーをセッティングする場合には、その向きに
十分ご注意ください。マイクがモニタースピーカーの音を拾って
しまい、ハウリング(マイクとスピーカーの間で音がループし「キー
ン」という発振音が起こる現象)が発生します。また、「シーンリスト」
(79ページ)に「*1」が記されている「シーン」を選択した場合、ゲ
イン値が高めに設定してありハウリングが発生しやすいと想定さ
れるので、ご注意ください。
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資料

現象 考えられる原因 対策 参照﻿
ページ

想定外の音
スネアやキックを叩
いたたときのタム
の共振音が邪魔に
感じる

タムの裏ヘッドが共振し
ている

タムの裏ヘッドを外してみてください。 ー

1度叩いただけで、
トリガー音が2度鳴
り(ダブルトリガー)
を起こす

本製品に接続している電子
ドラムパッド/トリガーセン
サーからの出力が上がりす
ぎているため、トリガー信
号が2度認識されてしまう

接続している電子ドラムパッドやトリガーセンサーに、出力や感度
コントロールボリュームなどが装備されている場合は、(下げる方
向で)調整してください。

ー

本製品の以下設定値(ゲイン)が大きすぎないか確認してください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Gain

95

[TRIGGER INPUT]端子(3)～(5)に他社製パッドを接続している
場合は、以下設定を「On」に設定してみてください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Attenuator

97

バスドラムの場合、センサー
ユニットDSU50が、フープ
に正しく固定できていない

DSU50取扱説明書での説明どおりに固定できているか、ご確認く
ださい。

ー

バスドラムの場合、音の長
さが長いほど、ダブルトリガ
ーが起こりやすくなります

ミュート調整/ヘッドのチューニング/ヘッド交換を試すなど、バスド
ラムの音が短くなるように調整してください。

ー

叩いていないのに音
が出る
叩いたドラム以外の
音が鳴る

クロストーク(振動により意
図せず発生したトリガー信
号によりトリガー音が鳴っ
てしまう現象)が発生

以下画面の設定項目を適切な値に設定してください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Crosstalk 
→Reject Level

99

鳴っていると思われる電子ドラムパッドにレベル調節つまみがある
場合は、適切なレベルに調節してください。

ー

以下画面の設定項目を適切な値に設定してください。
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Min Level

96

スネアドラムを叩いたときにバスドラムの音が鳴ってしまうような
場合は、センサーユニットDSU50からスネアドラムを離して設置し
てください。離して設置すると改善される場合があります。

ー

音がひずむ ボリュームを上げすぎて
いる

パネル右下にあるボリュームスライダーを調節してください。 7

本製品でのゲイン設定 本製品の以下設定値(ゲイン)が大きすぎないか確認してください。
[MIC/TRIG] →[F3] Setting →Mic →Mic In→Gain
[MIC/TRIG] →[F3] Setting →Trigger →Trig In →Pad →Gain

87
95

外部オーディオ機器やマイ
クからの、本製品入力への
接続方法

まずは、外部オーディオ機器からの出力レベルが適切かご確認く
ださい。
次に、[MIC/LINE]端子では、XLRケーブル接続よりもTRSケーブル
接続の方がゲインが低くなります。XLRケーブル接続でゲイン値を
下げても音が歪む場合は、TRSケーブル接続をお勧めします。

8

本製品でのフィルター設定 音が歪んでいると思われるレイヤーにつき、以下画面の設定をご
確認ください。
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice →Resonance

108

本製品でのエフェクト設定 以下画面にて、ディストーションなどのエフェクト設定をご確認く
ださい。
[MIC/TRIG] →[F3] Setting →Effect

120



EAD50　ユーザーガイド 185

資料

現象 考えられる原因 対策 参照﻿
ページ

レコーダー関連(録音/ルーパー/サンプリング)
本製品に接続してい
る外部オーディオ機
器からの音が録音で
きない

本製品での設定 以下設定をご確認ください。
[RECORDER] →[F3] Setting →Recorder Rec 

→Rec Aux In, Rec USB Audio In 1/2, Rec USB Audio In 3/4, 
Rec USB Audio In 5/6, Rec USB Audio In 7/8, Rec Bluetooth

[RECORDER] →[F3] Setting →Looper Rec 
→Rec Aux In, Rec USB Audio In 1/2, Rec USB Audio In 3/4, 
Rec USB Audio In 5/6, Rec USBAudio In 7/8, Rec Bluetooth

[RECORDER] →[F3] Setting →Sampling Rec 
→Rec Aux In, Rec USB Audio In 1/2, Rec USB Audio In 3/4, 
Rec USB Audio In 5/6, Rec USBAudio In 7/8, Rec Bluetooth

140
147
148
153

クリックが録音で
きない

本製品での設定 以下設定をご確認ください。
[RECORDER] →[F3] Setting →Recorder Rec →Rec Click
[RECORDER] →[F3] Setting →Looper Rec →Rec Click
[RECORDER] →[F3] Setting →Sampling Rec →Rec Click

140
147
153

USBフラッシュメモリ
ー/SDカードに録音で
きない

画面が、ルーパーまたはサ
ンプリングになっている

本製品の録音機能には、レコーダー、ルーパー、サンプリングの3
種類があります。このうち、ルーパーとサンプリングについては、
録音自体は本製品の内部メモリーに対して行うので、外部メモリー
(USBフラッシュメモリー/SDカード) は関係ありません。

145
151

USBフラッシュメモリーと
SDカードが両方接続して
いるが、どちらに録音する
かを正しく設定できてい
ない

録音したいメディアを正しく選択してください。 136

USBフラッシュメモリー/
SDカードの空き容量が不
足している

以下画面にて、USBフラッシュメモリー/SDカードの空き容量を確
認してください。
[MENU] →File →ExtMem Info

177

USBフラッシュメモリー/
SDカードにプロテクトがか
かっている

USBフラッシュメモリー/SDカードのプロテクトを解除してください。 ー

USBフラッシュメモリー/
SDカードの仕様が本製品
に合っていない

186ページをご参照ください。 ー

USBフラッシュメモリ
ー/SDカード上のオー
ディオファイルを本製
品で再生するときの音
量が小さい

再生時の音量設定 パネル右下にあるボリュームスライダーの[AUDIO] を調節して
ください。

7

録音時の音量設定 本製品で録音する場合は、録音音量を適切なレベルに調節してく
ださい。
[RECORDER] →[F3] Setting → Recorder Rec → Rec Gain
[RECORDER] →[F3] Setting → Looper Rec → Rec Gain
[RECORDER] →[F3] Setting → Recorder Sampling Rec → Rec Gain

140
147
153

USBフラッシュメモリ
ー/SDカード内のファ
イルを本体で再生でき
ない、または再生が途
中で止まる

ファイルフォーマットが対
応していない

ファイルフォーマットやサンプリング周波数を確認してください。 191

USBフラッシュメモリー/
SDカードの性能が不足し
ている

4GB以上のUSBフラッシュメモリー/SDカードをおすすめします。
USBフラッシュメモリーについては、ヤマハウェブサイトにある

「USBデバイス動作確認済みリスト」(PDF)をご参照ください。

ー
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現象 考えられる原因 対策 参照﻿
ページ

レコーダー関連(録音/ルーパー/サンプリング)　つづき
録音データが消えて
しまった

本製品の内部メモリーに録
音したあと、USBフラッシュ
メモリー/SDカードに保存
せずに電源を切った

レコーダー、ルーパー、サンプリングいずれの場合も、最終的には
外部メモリー(USBフラッシュメモリー/SDカード)に録音データを
保存してください。

132
137
146

外部メモリー(USB
フラッシュメモリ
ー/SDカード)から
オーディオファイル
をユーザーボイスに
読み込めない

ユーザーボイスを格納して
いるウェーブメモリーの容
量が一杯になっているかも
しれません

以下画面にて、ウェーブメモリーの容量をご確認ください。
[MIC/TRIG] →[F3] Setting →Kit →User Voice →WaveMem Info

不要なウェーブがあったら、以下画面で削除してください。
[MIC/TRIG] →[F3] Setting →Kit →User Voice →Delete Wave

117

ファイル形式に対応して
いない

本製品で扱えるオーディオファイル形式については、仕様表をご確
認ください。

191

オーディオファイルが保存
されている外部メモリーの
ディレクトリーが適切でない

オーディオファイルは、外部メモリーのルートディレクトリーに置い
てください。

ー

録音したのに再生し
ても鳴らない/音量
が小さい

[OUTPUT]スライダーの
位置

[OUTPUT]スライダーは録音時の音量も調整対象になっていま
す。適切な位置に置いた上で録音を進めてください。各スライダー
の調整対象は、7ページをご参照ください。

7

電源関連
本製品の電源が勝手
に切れる

オートパワーオフによる ライブなどパフォーマンスの最中で電源が切れては困る場合は、
以下画面にてオートパワーオフを解除してください。
[MENU] →Utility →Auto Power Off

158

電源が入らない 電源アダプターが接続さ
れていない

電源アダプターが接続されているか確認してください。 ー

データ関連
変更した設定が消え
てしまった

ストアをしないで、シーンを
切り替えた

本製品では、設定項目の数値を変更しても、シーンを切り替えたら
それまでの設定は消去されます。オリジナルのシーンを作るつも
りで設定している場合は、シーンを切り替える前に[STORE]ボタン
で設定を保存してください。

78

電源ケーブルを抜くことで
電源を切った

レコーダーの録音データを除き、本製品での設定は電源を切って
も保持されます。ただし、ケーブルを抜くことで電源を切った場合
は、保持されないのでご注意ください。

ー

シーンを切り替えた
のに、思ったとおり
に設定が変わらな
い。または、意図
せず設定が切り替
わる。

シーン選択時に呼び出す
項目が適切に設定できて
いない

以下画面の設定をご確認ください。
[SCENE] →[F3] Setting →Scene Load

28
75

データを外部メモ
リー(USBフラッシ
ュメモリー/SDカー
ド)に保存(セーブ)で
きない

USBフラッシュメモリー/
SDカードの仕様が本製品
に合っていない

本製品で扱えるUSBフラッシュメモリーについては、ヤマハウェブ
サイトのサポートページでご確認ください。

ー

本製品に認識されない場合は、USBフラッシュメモリー/SDカード
を本製品でフォーマットしてください。
[MENU] →File →ExtMem Info

177

以下画面にて、USBフラッシュメモリー/SDカードの空き容量を確
認してください。
[MENU] →File →ExtMem Info

177

USBフラッシュメモリー/SDカードにライトプロテクトがかかってい
ないか確認してください。

ー
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現象 考えられる原因 対策 参照﻿
ページ

スマートデバイス/コンピューター関連
スマートデバイスと
の有線接続で通信が
できない

— 接続方法を確認してください。詳細については、スマートデバイス
接続マニュアル(PDF)をご参照ください。

ー

iOSのスマートデバイス
に、USBケーブル(USB-C - 
Lightning ケーブル)で接
続している

USBケーブル(USB-C - Lightning ケーブル)で接続すると、本製
品がホスト側になってしまいます。スマートデバイス側がホストに
なるよう、iOSスマートデバイスへの接続にはLightning-USB3カ
メラアダプターを使ってください。

ー

スマートデバイスな
どBluetooth機器と
の接続/通信ができ
ない。

— 接続方法を確認してください。詳細については、スマートデバイス
接続マニュアル(PDF)をご参照ください。

ー

本製品のBluetooth がオ
フになっている

以下画面にてBluetooth をオンにしてください。
[MENU] →Bluetooth →Bluetooth →On/Off

170

スマートデバイス側で
Bluetooth がオフになっ
ている

スマートデバイス側でBluetooth をオンにしてください。 ー

接続したいBluetooth機器
と本製品とが、ペアリング
できていない

スマートデバイス側でBluetooth をオンにした上で、本製品の
[MENU]ボタンを長押ししてください。ペアリングが開始されます。

170

電子レンジ、無線LAN機器
など電磁波を発生する機
器がそばにある

2.4GHz帯の電磁波を発する製品(電子レンジ、無線LAN機器など)
から離れた場所で、本製品を使ってください。

ー

コンピューター上
のDAWソフトウェ
アなどと通信がで
きない

コンピューターにドライバ
ーのインストールができて
いない

Windowsの場合は Yamaha Steinberg USB Driverをインスト
ールする必要があります。

40

DAWなどのアプリケーシ
ョンでの作業中に、本製品
がオートパワーオフなどで
勝手に電源が切れた

コンピューター(DAW)と接続中に本製品の電源がオフになった
場合、電源を入れ直しただけではコンピューター(DAW)との通信
が復活しない場合があります。このような場合は、いったんアプリ
ケーションを終了し、本製品を再度オンにしてから、コンピューター
上で再度アプリケーションを起動してください。また、コンピュータ
ーと接続時には、以下画面にてオートパワーオフの設定をオフにし
ておくことをお勧めします。
[MENU] →Utility →Auto Power Off

158

USBケーブルが正しく接続
されていない

USBケーブルが正しく接続されているか確認してください。 ー

コンピューターに出
力したオーディオ音
が聞こえない/音量
が小さい

[OUTPUT]スライダーの
位置

[OUTPUT]スライダーはUSBオーディオの出力音量も調整対象
になっています。適切な位置に置いてください。各スライダーの調
整対象は、7ページをご参照ください。

ー

MIDI関連
接続した外部の
MIDI音源が鳴ら
ない

接続先のMIDI仕様による 本製品の[USB TO HOST]端子と接続した場合、MIDI通信できる
のは、本製品と同じくUSBトリガーリンク機能を搭載したMIDI機器
だけです。同機能を搭載していないMIDI機器は、物理的に接続で
きたとしてもMIDI通信はできませんのでご注意ください。

112

MIDIチャンネルが一致し
ていない

以下画面のMIDI設定と外部機器のMIDI設定をご確認ください。
[SCENE] →[F3] Setting →Modifier →CC Channel, CC Port
[MIC/TRIG] →[F3] Setting →Kit →Voice →Voice MIDI →Note 
Ch, Note Port, CC Channel, CC Port

77
111
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メッセージ一覧

メッセージ 説明
Are you sure? 各操作を実行したときの、確認を求める表示です。
Auto power off is disabled. 
Energy consumption might increase.

[MENU]ボタンを押しながら電源を入れることでオートパワーオフ機能が解除され
たときに、表示されます。

Backup error. 電源オン時に表示されます。前回の電源オフ時に、本製品の内部メモリーへのデー
タ書き込み(保存)に失敗した場合に表示されます。このメッセージが表示されたあ
と、自動的にファクトリーリセットが実行されます。

Bluetooth pairing.... 他のBluetooth機器とのペアリングを待機している状態です。詳細は170ページ
をご参照ください。

Canceled. キャンセル処理が完了したときに表示されます。
Can't process. 処理に失敗しました。
Completed. シーンのストア、ファイルのロード/セーブ、ジョブなどの実行が完了したときに表示

されます。
Connecting USB device…
Connecting SD card…

[USB TO DEVICE]端子に接続したUSBフラッシュメモリー/スロットに挿入したSD
カードを認識しようとしています。

Energy consumption might increase 
depending on the setting.

オートパワーオフ設定を変更しようとしたときに表示されます。

Excessive demand for USB power. [USB TO DEVICE]端子に接続したUSBフラッシュメモリーの消費電力が規定値を
超えています。

External memory not ready. 外部メモリー(USBフラッシュメモリー/SDカード)が本体に正しくセットされていない
場合に表示されます。

External memory's transfer speed 
too slow.

外部メモリー(USBフラッシュメモリー/SDカード)への転送スピードが間に合わなか
った時に表示されます。
なお、当社にて動作確認を実施しました各種デバイスについては、ヤマハウェブサイ
ト上にある『動作確認済みデバイスリスト』をご覧ください。

Factory Reset initializing ... 起動時にファクトリーリセットを行った場合に表示されます。
File already exists. 同じ名前のファイルがすでに存在しています。
File not found. 選択したタイプのファイルがありません。
Illegal file. ロードのとき、目的のファイルが本製品でサポートしていないファイルの場合に表示

されます。
Incompatible USB device. 本製品では使用できないUSBデバイスが、USB TO DEVICE端子に接続されると

表示されます。
Invalid USB device
Invalid SD card

[USB TO DEVICE]端子に接続したUSBフラッシュメモリー/スロットに挿入したSD
カードが不良です。本製品でフォーマット(177ページ)を実行し、操作を再度実行し
てください。

No data. レコーダー、ウェーブに関する機能の実行時に、対象となるデータが存在しない場合
に表示されます。

No response from USB device. [USB TO DEVICE]端子に接続したUSBデバイスから応答がありません。
Now importing... ウェーブのインポート中に表示されます。
Now loading... ファイルロード中に表示されます。
Now processing... シーンのストアやその他の機能の実行中に表示されます。

ファイルのロード/ セーブ実行を中止したときの、後処理実行中に表示されます。
Now saving... ファイルセーブ中に表示されます。
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メッセージ 説明
Overwrite? 以下の場合に表示されます。

•	 ファイル保存(セーブ)の操作時に、USBフラッシュメモリー/SDカード内に同名の
ファイルがある場合

•	 ストアしたことのあるユーザーシーンに再度ストアを実行しようとした場合
Please keep power on. 内蔵メモリーにデータを書き込み中です。電源を切らないでください。
Please reboot to enable the new 
USB Audio Mode. 

USBオーディオモードの設定変更後に表示されます。電源を入れなおすことで設定
が有効になります。

Please stop recorder. レコーダーで録音中に、特定の操作をしたときに表示されます。レコーダーを停止し
てから操作してください。

Read only file. 読み取り専用のファイルを選択しファイル操作を実行すると表示されます。
Recording time limit exceeded. レコーダーで録音制限時間に到達した場合に表示されます。内蔵メモリ使用時は約

１分３０秒、USBフラッシュメモリー/SDカード使用時は90分です。また録音中にUSB
フラッシュメモリー/SDカードが一杯になった場合にも表示されます。

Sample is too long. サンプルが長すぎて読み込めません。
Sample is too short. サンプルが短すぎて読み込めません。
Shutdown 電源を切る処理中です。メッセージが消えるまで、電源アダプターを抜かないでくだ

さい。
USB device connection terminated. 
SD card connection terminated. 

外部メモリー(USBフラッシュメモリー/SDカード)に異常な電流が流れたので接続を
遮断しました。接続しているUSBフラッシュメモリー/SDカードを外した上で[OK]ボ
タンを押してください。

USB device full.
SD card full. 

外部メモリー(USBフラッシュメモリー/SDカード)の容量が一杯でファイルがセーブ
できないときに表示されます。
新しいUSBフラッシュメモリー/SDカードを用意するか、不要なファイルを消去してか
ら操作をやりなおしてください。

USB device list full.
SD card list full.

USBフラッシュメモリーやSDカードで扱えるファイル数が一杯で、新たに録音できな
ときに表示されます。新しいUSBフラッシュメモリーやSDカードを用意するか、不要
なファイルを消去してから操作をやりなおしてください。

USB device read/write error.
SD card read/write error.

外部メモリー(USBフラッシュメモリー/SDカード)へのリード/ ライト中にエラーが発
生しました。

USB device transmission error. USBデバイスとの通信中にエラーが発生しました。
USB device write protected. 
SD card write protected.

外部メモリー(USBフラッシュメモリー/SDカード)が書込み禁止状態になっている場
合に表示されます。

User Voice Bank full. ユーザーボイスのバンク数の合計が最大数を超える場合に表示されます。
User Voice full. ユーザーボイス数の合計が最大数を超える場合に表示されます。
Wave full. ウェーブ数の合計が最大数を超える場合に表示されます。
Wave memory error. Wave ROMへのデータ書き込みに失敗した場合に表示されます。

Waveデータを正しく保存できなかった場合、次回の電源オン時に表示されます。
エラーメッセージが表示されたあと、自動的に修復処理が実行されます。

Wave memory full. ウェーブ用のメモリーが一杯で、インポートやジョブ、ロードなどが実行できない場
合に表示されます。
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本製品に搭載のコンテンツ一覧
本製品には、以下のコンテンツが搭載されています。

コンテンツ 選択画面 リスト掲載
場所

シーン [SCENE] 79ページ

インスト [MIC/TRIG] →[F3] Setting →Kit →Inst →Inst →Category, Number データリスト

ボイス [MIC/TRIG] →[F3] Setting →Kit →Voice →Voice →Category, Number データリスト

エフェクトタイプ データリスト

リバーブタイプ [MIC/TRIG] →[F3] Setting →Effect →Reverb →Category, Type データリスト

FX1タイプ [MIC/TRIG] →[F3] Setting →Effect →FX1 →Category, Type データリスト

FX2タイプ [MIC/TRIG] →[F3] Setting →Effect →FX2 →Category, Type データリスト

Ins1 Mic [MIC/TRIG] →[F3] Setting →Effect →Ins1 Mic →Category, Type データリスト

Ins2 Mic [MIC/TRIG] →[F3] Setting →Effect →Ins2 Mic →Category, Type データリスト

Ins Trig [MIC/TRIG] →[F3] Setting →Effect →Ins Trig →Category, Type データリスト

Master FX [MIC/TRIG] →[F3] Setting →Effect →Master FX →Category, Type データリスト

Master Comp [MIC/TRIG] →[F3] Setting →Effect →Master Comp →Category, Type データリスト

Phones EQ [MENU] →Output →Phones EQ →Type データリスト

上記のうち、シーン以外は、別冊データリストに掲載されています。
データリストについては、以下のウェブサイトから入手してください。
	 ヤマハ ダウンロード　https://jp.yamaha.com/support/manuals/
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仕様一覧

メインユニット
シーン プリセット：70以上、ユーザー：200
音源部 マイク Mic EQ 14

Mic Transient Compressor 19
Mic Insertion Effect 1 252
Mic Insertion Effect 2 252

トリガー 音源方式 AWM2
最大同時発音数 256
パート 24
ボイス数 2317
インストEQ 13
インストトランジェント.
コンプレッサー

21

インストインサーション.
エフェクト

252

マイク/トリガー リバーブ 137
FX1 247
FX2 247
マスターFX 252
マスターコンプレッサー 33
マスターEQ 5バンド

その他 クリックEQ 1
オーディオEQ レコーダー、ルーパー、Aux In、USBオーディオ、 

Bluetooth
フォーンEQ 13 (4バンド)

ユーザーサンプル 読み込み可能ウェーブ数 500ユーザーボイス × 10バンク
サンプル読み込み可能時間 モノラル：約158分 (44.1 kHz、16ビット) 

ステレオ：約79分 (44.1 kHz、16ビット)
サンプルフォーマット WAV, AIFF

機能 インテグレイテッドトリガー入力、マイクトーク機能、 
ゲインオートセットアップ、クロストークオートセットアップ、
ボイス機能

クリック テンポ 30.0～300.0 BPM、タップテンポ機能
拍子 1/4～16/4、1/8～16/8、1/16～16/16
タイミング アクセント、4分音符、8分音符、16分音符、8分3連符
その他 音符ごとの設定 (ボイス、ウェーブファイル読み込み、

音量、パン、チューニング)、タイマー、レコーダー同期
レコーダー 録音時間 内部メモリー 約90秒

外部メモリー 約90分
ルーパー時間 内部メモリー 約30秒
サンプリング時間 内部メモリー 約30秒
フォーマット WAV (44.1 kHz、16ビット、ステレオ)
機能 レコーダー (playback x 2)、ルーパー、サンプリング

ライブセット ユーザー: 50 x ステップ: 50
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パネル ディスプレイ フルドットLCD (198x100 dot)
操作子 Modifierノブ 6 (40 割当可能機能) 

LEDロータリーフェーダー 5 (33 割当可能機能)
ボリューム操作子 スライダー (AUDIO、CLICK、MIC/TRIG、OUTPUT、 

PHONES)
その他 MUTE ALLボタン、チャンネルオン/オフボタン、チャン

ネルインジケーターなど
接続 トリガー入力 マルチピエゾ (L: ピエゾ、R: ピエゾ) TRIGGER INPUT qKICK/y, wSNARE/u (標準ス

テレオフォーン端子)
マルチピエゾ (L: ピエゾ、R: ピエゾ)、.
シングルピエゾ (L: ピエゾ、R: スイッチ)、.
with Attenuator

TRIGGER INPUT e/i, r/o, t/!0 (標準ステレオ
フォーン端子)

接続可能なパッド数 10 (Yケーブル使用時)
フットスイッチ FOOT SW 1, 2 (標準ステレオフォーン端子)

機能 HH Controller, Expression, On/Off, Inc/Dec
オーディオ入力 マイク/ライン入力 MIC/LINE INPUT 1, 2, 3, 4, 5 (XLR/TRSコンボジャ

ック、バランス) 
ファンタム電源(+48V)

Aux入力 AUX IN (ミニステレオフォーン端子)
オーディオ出力 メイン出力 OUTPUT L, R (XLR端子、バランス) 

OUTPUT L/MONO, R (標準TSフォーン端子、アンバ
ランス)

インディビデュアル出力 INDIVIDUAL OUTPUT 1, 2, 3, 4, 5, 6, 7, 8 (標準
TRSフォーン端子、バランス)

ヘッドホン PHONES (標準ステレオフォーン端子 × 1, ミニステレ
オフォーン端子 × 1)

MIDI MIDI OUT
USB TO HOST タイプ USB Type-C × 1

MIDI 2ポート
オーディオ 2 in 2 out, 24-bit, 44.1/48/96 kHz (同期) 

8 in 10 out, 24-bit, 44.1 kHz (非同期)
USB TO 
DEVICE

タイプ USB Standard-A × 1
MIDI USBトリガーリンク (USB MIDIホスト機能)

外部メモリー USBフラッシュメモリー 〇
SDカード 〇：SDHC (最大32 GB)、SD (最大2 GB)

Bluetooth オーディオ 対応プロファイル：A2DP、対応コーデック：SBC
MIDI Bluetooth Low Energy MIDI Specificationに準拠
Bluetoothバージョン 5.0
無線出力 Bluetooth Class 2
無線周波数(動作周波数) 2.4 GHz

電源 ACアダプター PA-300C (Output: DC16 V, 2.4 A)  
消費電力 22 W (PA-300C使用時)
スタンバイ時の消費電力 0.3 W
オートパワーオフ 〇

サイズ/質量 寸法 (幅 × 奥行き × 高さ) 394 (W) × 252 (D) × 106 (H) mm
質量 メインユニットのみ 3.5 kg
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センサーユニット
センサーユニット(モデル) DSU50

DSU50 取扱説明書をご参照ください。

その他
付属品 メインユニット EAD50 クイックガイド、セーフティーガイド、 Cubase 

AI ダウンロードインフォメーション、ACアダプター 
(PA-300Cまたはヤマハ推奨品)、 モジュールホルダー、
モジュールホルダー用蝶ボルト(×4)、 標準ステレオ 
フォーンケーブル(×1)、3ピンXLRケーブル(×2)、ケー
ブルバンド(×3)

センサーユニット DSU50取扱説明書、マイクロフォン用ステレオ5ピン 
XLRケーブル、クッション材シール(×2)

別売品 ウェブサイト (https://download.yamaha.com/jp/)
でご確認ください。

※ 本書は、発行時点での最新仕様で説明しています。最新版は、ヤマハウェブサイトからダウンロードできます。

オープンソースソフトウェアのご案内
本製品のファームウェアにはオープンソースソフトウェアが含まれています。
各オープンソースソフトウェアの著作権情報と使用条件は、下記ウェブサイトの「資料/データ」から確認できます。

サポート・お問い合わせ
https://jp.yamaha.com/support/
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